VERSION 1.1.183 RELEASED ON JANUARY 04, 2023
Product Enhancements:

New UI:



Users can now add shortcuts for their favorite settings by marking them as
“Favorites”.
We have made it easier for Foundation, Billing and Accounting subscription users
to access Purchase Order and Vendor Bill modules. These are now conveniently
located under Accounting->Payables menu.

Data Onboarding:



Employee records can now be bulk imported to CORE by uploading a .csv file.
Enhanced error handling for Prospect and Leads CSV import

Reporting improvements:


Reports > When drilling into the details of a Profit and Loss Cash Basis report, the
underlying report will now include the Project, Vendor and Payer details as well.

ePayments:



Updates to BQE ePayments- Automatic deposit recording w/ settled fees. (limited
release)
ePayment email notifications will now include Invoice, Project and Client
information.

Budget improvements:


Users can now turn on custom fields for Budgets list view.

Integrations:


Updates to QuickBooks Desktop Sync Utility

Performance Optimizations:


Back end improvements for faster processing

Application Stability:















A&F > We have fixed an issue that would prevent time entry hours that do not
any corresponding allocation from appearing under "Other Tasks".
Expense Entry > There was an issue with the total record count if expense entries
had more than one custom fields specified.
Integration > Many users had complained about their Google Calendar
appointments not appearing after setting up the integration. This was fixed.
Invoice Editor > There was an issue with Net Bill calculation not being updated
when modifying time entries. This was fixed.
Invoice Editor > Unsaved changes would be lost when including approved time
entries. This was fixed.
Invoices > Users were not able to update Invoice Numbers for finalized Invoices.
This was fixed.
Invoices > We have fixed an issue with email attachments for One Drive/DropBox
documents.
Leads > There was an issue with import sample CSV for leads. This was fixed.
New UI > There was an issue with custom fields list view when deleting existing
records. This was fixed.
New UI > There was an issue with the Class list view display. This was fixed.
New UI > We have enhanced the hover and active states for left nav. menu items.
Projects > All tabs in Project details section are misaligned if the Project name was
over a certain length. This was fixed.
Time Card > The Day view interface would not reveal the full contents of the
memo when clicking on the memo box. This was fixed
____________________________

VERSION 1.1.182 RELEASED ON DECEMBER 22, 2022

Product Enhancements:









Time and Expense entry Improvements:
o Within the Time Card week view, there is now a button that will allow you
to submit all time entries for the current period.
o When you submit your time card, CORE will now remember the previous
settings that you used.
o Time Card has been updated to show the time stamp of the last update to
the Time Card view.
o Time Entries page has been updated to sort by custom fields.
New UI
o User profiles now allow for adding a profile picture.
o We have added contextual help links for Global and User settings pages.
Subscription Management
o Premium Yearly Support Plan can be added as Company level subscription.
o We are rolling out updated pricing for Foundation package.
Reporting Improvements:
o When drilling into the details of a Balance Sheet Accrual Basis report, the
underlying report will now include the Project, Vendor and Payer details as
well.
o New filters have been added to the Personal Time Off Usage report,
including: Employee, Vendor, and Vendor Group.

Application Stability:










New UI > Fixed security access issue with Company> Documents tab.
New UI > The first record would get un-selected after all records were selected
and then the user clicked on the description field of any record in the T&E
reviewer
New UI > There was an issue with remembering filters for Time entries view. This
was fixed.
New UI > There was an issue with scrolling after the user responded to the
unsaved changes prompt. This was fixed.
New UI> Project Assignments would stop at 25 records. This was fixed.
OT Calculator > The system would keep reverting Regular and OT hour settings
entered by the user. This was fixed.
Time Card >Fixed a bug where the time card view switches from the week view to
the day view automatically.



Time Entries > When creating an Employee from the Add New button in the Time
Entry screen, the Auto Approve Time for Employees Global Setting is not
respected. This was fixed.

____________________________

VERSION 1.1.181 RELEASED ON DECEMBER 8, 2022
Product Enhancements:










Import CSV > We have optimized data validation and error/success messages
when importing Projects, Time and Expense entry and General Journals.
Invoices > We have added the ability to launch statements directly from the
Invoice record.
Projects > Users can now launch the Contract Analysis report for a project from
the Projects list screen by clicking on a project's Contract Amount.
Reports > When drilling into the numbers on the Profit and Loss Accrual Basis, the
underlying Transaction Details report will now display the Project, Vendor and
Payer details as well.
Reports Center > The reporting center search bar has been enhanced to display
suggestions across all report tabs.
Subscription Management > Added the ability to renew Foundation subscriptions.
Time Card > New users will have the approval status flags turned on by default.

Application Stability:







Import CSV > There was an issue with importing contacts for Client, Vendor and
Employees. This was fixed.
Import CSV > There was an issue with importing start and stop time for time
entries. This was fixed.
Invoices > Processing late fees in bulk would complete for the first 75 selected
Invoices only. This was fixed.
Invoices > Updating memo or description for entries tied to a draft Invoice would
reset the WUD factor. This was fixed.
New UI > Fixed an issue with select all checkboxes in Currency Manager.

















New UI > Invoice number under recent Invoices was not getting updated to
modified Invoice number. This was fixed.
New UI > Invoices that had been deleted would still hold a reference under the
"Recent Invoices". This was fixed.
New UI > There was an issue in Project Groups> Assign Project. This was fixed.
New UI > There was an issue with QBO Sync> Record mapping when loading
more records. This was fixed.
New UI > There was an issue with showing existing data for Notes categories,
classes and contact methods. This was fixed.
New UI > There was issue with saving Accounting settings from the Settings area.
This was fixed.
New UI > We have relocated "Auto Approve" settings under Project.
New UI > We have restored access for Project assignments by adding "View
Assignments" action under Project details>More.
New UI > We have restored access to OT Calculator from Time entries and Time
Card views.
OT Calculator > The system would not take the "Excluded Activities" setting into
consideration when processing over time for the selected employees and time
period. This was fixed.
OT Calculator> The Select All feature would select the visible rows only. This was
fixed and made consistent with other list views.
Projects > Emailing budgets directly from the Budgets tab would attach an empty
PDF. This was fixed.
Reports > In some cases, when the Employee Expenses report was exported as a
CSV, some row data was not exported correctly. This was fixed.
Time Entries > There was an issue with showing more than one custom field of the
same type. This was fixed.

____________________________

VERSION 1.1.180 RELEASED ON NOVEMBER 23, 2022
Product Enhancements:







App Navigation and UI Update (Open Beta): This update adds several
enhancements like Dark mode support and fixes numerous known issues.
Reports > Several new filter options were added to the Employee Time Card
Summary report including Project Status, Project Type and Project Contract Type.
Dashboard > Clicking into PTO records from the Workflow dashboard widget will
now re-direct users to the PTO screen.
Report Center > Search bar in the report center has been enhanced with
autocomplete suggestions to make finding your data faster and easier.
Security Optimizations > This update further improves the security posture of the
Application.

Application Stability:










Integrations > QBO sync would throw an error if the logged user was missing the
custom label security permission. This was fixed.
Integrations > There was an issue with selecting all Calendars created in Office
365. This was fixed.
Invoice Templates > Sample Invoice previews were not properly generating. This
was fixed.
Invoices > Draft Invoice Editor UI would show draft invoice number instead of
actual invoice number. This was fixed.
Projects > The Budget ID field would be left empty when custom budget was
being used for the project. This was fixed.
Reports > The Historic Billing report was not properly honoring Fiscal Year date
filters when the default fiscal year did not coincide with calendar year end. This
was fixed.
Time entries > When creating a time entry from a timer, the 'amount' field would
not show the correct amount unless updated from the Time entries view. This was
fixed.

____________________________

VERSION 1.1.179 RELEASED ON NOVEMBER 10, 2022
Product Enhancements:







App Navigation and UI Update (Beta): This update adds several enhancements
and UI fixes for many known issues.
Client records can now be bulk imported to CORE by uploading a .csv file.
BQE ePayments onboarding has been enhanced to allow users to turn on
ePayments links for all open and draft state invoices at the time of Merchant Sign
up.
Time and Expense Entries >We are now saving column width for the 'Best Fit'
option.

Application Stability:













Billing > There was an issue in the late fee calculation for specific month ending
scenarios. This was fixed.
Dashboards > The HR benefits calculations have been updated for the Paid Time
Off and Comp Hours widget and Benefits Usage report, so the values match.
Expense Entries > Users were not able to attach documents when creating new
entries if the auto approve Expense rule was turned on. This was fixed.
Projects > Handled crash error in Expense list of Budgets tab when 'Include
Phases' was turned on.
Reports > In certain scenarios, created vendor bills would create an imbalance on
the Balance Sheet Cash Basis report. This was fixed.
Reports > In certain scenarios, joint invoice payment breakdown were not
matching on the Payment Details report. This was fixed.
Reports > The Parent Project name was not being properly displayed when date
filters were being applied to the Time and Expenses by Parent Project report. This
was fixed.
Time and Expense Reviewer > Applying filters and sorting the reviewer list would
sometimes result in incorrect number of records to be exported to CSV format.
This was fixed.
Time Entry > It would require several tries to update the memo field for an
existing entry. This was fixed.

____________________________

VERSION 1.1.178 RELEASED ON OCTOBER 25, 2022

Product Enhancements:



App Navigation and UI Update (Beta): This release rolls out navigation and UI
changes to select beta customers.

Application Stability:






Dashboard > Employee filter in the 'HOURS' widget was not showing Vendors
even if the setting 'Include vendors in the employee drop-downs' was checked in
the User Preferences. This was fixed.
Dashboard > HOURS widgets was including weekend hours. This was fixed.
Invoice Templates > Manual Invoice templates were not using the correct rate
multiplier when previewing Invoices created for a Project with non-US currency.
This was fixed.

_______________

VERSION 1.1.177 RELEASED ON OCTOBER 12, 2022
Product Enhancements:






Invoices > Parent Retainer Available information has been added to Phased
Invoices Retainer Summaries.
Reports > The Employee Expenses report has been updated to improve
readability and it was optimized for better performance. The report can now be
grouped by Expense Item.
Reports > The Percentage Billed report can now be grouped by Project Manager.

Application Stability:






Budgets > Users with read only permission were not able to add new line items.
This fixed.
Budgets > We have fixed a UI issue that would distort the table if all columns were
made visible.
Integrations > There was an issue with Office 365 integration that would prevent
Outlook events Calendar to show up in full calendar view. This was fixed.
Payments > An isolated issue with payments screen would prevent loading of
more than 75 records. This was fixed.



Scheduled reports > Time verification scheduled reports were not being sent out
properly if their schedule was modified. This was fixed.

_________________

VERSION 1.1.176 RELEASED ON SEPTEMBER 28, 2022
Product Enhancements:












Projects can now be bulk imported to CORE by uploading a .csv file.
Pricing Update> This update rolls out new pricing for CORE subscriptions effective
immediately.
Reports > More filters, including Project Status and Principal, have been added to
the Cash Receipts report. The report has also been optimized for improved
performance and readability.
Reports > More filters, including Project Status and Principal, have been added to
the Employee Paid Time Off Hours report. The report has also been optimized for
improved performance and readability.
Reports > The Client Transactions report can now be grouped by Master Project.
Reports > The Time Details report can now be grouped by Project Manager.
Integrations> “Connect” buttons have been refreshed for new styling.
Security Optimizations > This update further improves the security posture of the
application.

Application Stability:





Batch Invoice > There was an issue with retainer amount calculated for the Invoice
when one or more entries were excluded from the Invoice. This was fixed.
Batch Invoice > Users had reported issues processing Invoices using Project Filter
Option in combination with Percentage based billing. This was fixed.
Expense Entry > Time and Expense subscription users were not able to use the
Credit Card field when creating a new Expense entry. This was fixed.







General Journals > An issue with the Import CSV was preventing users to import
entries from CSV source. This was fixed.
Subscription Management > Some users would not get subscription renewal
notifications while logging in during the grace period. This was fixed.
TE Reviewer > The system was not updating "Paid Date" when paid flag was
removed. This was fixed.
Vendor Bills > There was an issue with the Batch update feature when used in
conjunction with quick list view search. This was fixed.
Reports > The Project Time Entries was not properly honoring security bits for
subtotal amounts. This was fixed.

____________________

VERSION 1.1.175 RELEASED ON SEPTEMBER 14, 2022
Product Enhancements:






Time Card > Time Card interface has been enhanced to allow users to group their
time entries by Project.
BQE ePayments > Automatic bank deposits have been reworked to match the
real-world bank transfer events. This feature will be made available to selected
customers for testing before full roll out.
Invoice Editor > Labels in the Invoice Editor screen have been updated to properly
refer to Phase or Project sections.

Application Stability:






Expenses > Creating a copy of an expense entry was not retaining the correct
charge amount. This was fixed.
Integrations > An issue with AccountRight integration was preventing users from
syncing Projects/Invoices along with the sync settings page being not accessible
This was fixed.
Integrations > Dropbox storage users were unable to upload documents to
Projects or Vendor Bills. This was fixed.








Invoice Editor > The call-to-action buttons disappeared from the invoice editor
screen when we DELETE, SEND TO and PRINT actions were used from Action
menu. This was fixed.
Invoices > The View Transactions link in a finalized invoice details screen was
linking to a blank Payments list. This was fixed.
Reports > CORE Express Plus users were not able to see all financial reports. This
was fixed.
Reports > The Report Center was not properly displaying all reports under some
categories. This was fixed.
Scheduled Reports > Several users had complained about reports being emailed
even after their CORE subscription had expired. This was fixed.

VERSION 1.1.174 RELEASED ON AUGUST 31, 2022
Product Enhancements:










Invoice Editor > Newly approved time and expense records can now be added
to draft invoices using the Invoice Editor.
Time Card > The Time Card activity drop down has been optimized for better
performance.
Reports > The "Write Up Write Down" report has been optimized for better
performance.
Reports > The "Trial Balance Cash YTD" report has been optimized for better
performance.
Reports > The "Trial Balance Accrual YTD" report has been optimized for better
performance.
Reports > More filter options have been added to the "Employee Project
Utilization" report and its readability has been improved.
Reports > More filter options have been added to the "Account Reconciliation"
report and its readability has been improved.
Invoices > The user experience for re-directing to the Payments screen from
Invoices has been enhanced to avoid loading a blank screen if no payments
have been made.

Application Stability:



Batch Update > Batch updating projects from a filtered list would result in all
project records being incorrectly updated. This was fixed.













Dashboard > A security bug was not allowing the proper data to load in the
"Paid Time Off and Comp Hours" widget. This was fixed.
Global Search > The global search box was not properly displaying recent
searches. This was fixed.
Integrations > Certain users were unable to send Invoices to Xero. This was
fixed.
Invoice Editor > Edits made to an Expense’s Extra attribute were not being
properly saved. This was fixed.
Invoice Editor > Split Draft Invoices were not properly loading in the Invoice
Editor. This was fixed.
Invoice Templates > Users were incorrectly given permission to delete Custom
Invoice Templates from Global Settings. This was fixed.
Manual Invoices > Manual Invoices could not be created for Projects with
certain rules set. This was fixed.
Reports > On drill down, the "Account Reconciliation" report uncleared totals
did not match. This was fixed.
Reports > The "Time and Expense" report was incorrectly calculating the Grand
Total Billable Service / Expense by including non-billable amounts. This was
fixed.
Reports > The summary section of 'Monthly Financial Budget vs Actual' report
was not formatted correctly. This was fixed.

________________

VERSION 1.1.173 RELEASED ON AUGUST 17, 2022
Product Enhancements:




Reports > “General Ledger Cash Basis” report has been optimized for better
performance.
Reports > “Payment Details” report has been enhanced to improve readability
and new filter options have been added.

Application Stability:



Dashboard > The Paid Time Off dashboard widget was displaying the wrong
Used values. This was fixed.






















Global Settings > Changes to tax rates in global settings were not being
properly updated throughout the application. This was fixed.
Integrations > Invoiced were not properly syncing from CORE to MYOB. This
was fixed.
Integrations > When syncing invoices to QuickBooks, the Net Terms were
being incorrectly set at the Client level instead of the Project level. This was
fixed.
Invoices > Invoices were not sending to Client Contacts without viewing a
Preview of the Invoice. This was fixed.
Reports > “Profit and Loss by Class Cash Basis” report numbers were not
matching the drill down report when applying a Transaction date filter. This
was fixed.
Reports > “AR Aging 8 steps” report was failing to preview and email for large
data sets. This was fixed.
Reports > “Time Details and Contract Analysis” reports could not be opened
from email attachments when a scheduled report was run to deliver them. This
was fixed.
Reports > “Work In Progress Detail” report was duplicating entries if more than
one Project Group was assigned to a Project. This was fixed.
Security > Users that had a custom security profile assigned were able to run
assigned reports, but the reports would not display any data. This was fixed.
Time & Expense > The Time Entry, Expense Log and Reviewer screens were not
properly applying the un-approved filter. This was fixed.
Time Card > The Overtime splitting feature in the Time Card was not properly
splitting Overtime entries for billable work. This was fixed.
Time Entries > Billed Time Entries were not correctly enforcing restrictions that
prevented updates. This was fixed.
Vendor Bills > Time Entries on paid Vendor Bills could incorrectly be updated
which would result in incorrect cost amounts. This was fixed.
Vendor Bills > Updating units on a saved Vendor Bill was not properly
updating client hours in the Time Entry record. This was fixed.
Vendor Bills > When a Vendor Bill is created using existing Time Entry records
with custom memos, the custom memos are not properly imported. This was
fixed.
Time Card > Clicking tab after entering a time entry was not properly saving
the entry. This was fixed.

VERSION 1.1.172 RELEASED ON AUGUST 3, 2022
Product Enhancements:














Invoice Editor > The Invoice Editor experience has been enhanced by enabling
the editing of linked Expense Entries on a Draft Invoice.
Invoice Editor > The Invoice Editor user experience has been simplified.
Invoices > Phased Invoice templates have been updated to include a Retainer
Summary if the option is enabled.
Time Card > The Project dropdowns in the Time Card have been optimized for
better performance.
Bill Payments > Bill Payment details view has been updated to accommodate
longer Reference Number values.
Reports > The Budget Comparison report has been optimized for better
performance.
Reports > The Cost Analysis report has been optimized for better
performance.
Reports > The Monthly Billing Statement report has been optimized for better
performance.
Reports > The Project List report has been optimized for better performance.
Reports > The Project Performance report has been optimized for better
performance.
Reports > The Project Profitability report has been optimized for better
performance.
Reports > The Trial Balance Cash Basis report has been optimized for better
performance.

Application Stability:






Bill Payments > When creating a Bill Payment by Saving and Adding Another,
the Payee filter was not being honored and the list would display all Vendors.
This was fixed.
General > "This Bi-Weekly" date period was inconsistently referred to
throughout screens and reports. This was fixed.
Invoices > Hours on the cover page were incorrectly multiplied by the number
of payments received for the Invoice. This was fixed.





















Invoices > Late fees were incorrectly being considered part of the contract
amount when using percent complete billing. This was fixed.
Projects > When a Project filter was applied to the Projects list, then the list
was sorted by Project, some Projects were incorrectly listed as duplicates in the
list. This was fixed.
QuickBooks > In some instances, Invoice Class was not properly syncing to
QuickBooks. This was fixed.
QuickBooks > Invoices created from Billable expenses that were tied to
accounts in QBO were not transferred to CORE. This was fixed.
QuickBooks > Searching keywords against Unmapped Payments in
QuickBooks was not yielding the correct results. This was fixed.
Reports > Column headers were missing from Page 2 of the Employee
Profitability Report. This was fixed.
Reports > Deposits made through New Funds were not properly reflected on
any AR Aging reports when the General Journal option is turned on. This was
fixed.
Reports > The Vendor Bills Paid report was incorrectly including records for
Unpaid Vendor Bills. This was fixed.
Reports > When exporting the Expenses by Vendor report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Journal report as an Excel file, calculations
could not be run on certain number fields due to their format type. This was
fixed.
Reports > When exporting the Project List report as an Excel file, calculations
could not be run on certain number fields due to their format type. This was
fixed.
Reports > When exporting the Unpaid Vendor Bills report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Time Card > Clicking tab after entering a time entry was not properly saving
the entry. This was fixed.

VERSION 1.1.171 RELEASED ON JULY 20, 2022

Product Enhancements:







Invoice Editor > Expense Entry details can now be updated directly from the
Invoice Editor.
Invoices > Users can now filter the list by Invoice Created On date.
Reports > “General Ledger” and "General Ledger Extended" reports have been
optimized for better performance.
Dashboard > "Paid Time Off and Comp Hours" widget has been updated to
handle the advanced benefit rules.

Application Stability:

















Account Management > An issue with the reset password mechanism would
lock out few users after they had changed their password. This was fixed.
Checks > The screen would become unresponsive when associating existing
expenses for the selected Payee. This was fixed.
Dashboard > Vacation and Sick time were not reflecting in Paid Time Off and
Comp Hours widget. This was fixed.
ePayments > An issue with phone number formatting was preventing few
users from completing the Merchant Sign up in one go. This was fixed.
ePayments > ePayment status for Partial Payments would still refer to the
payment method used in the first transaction. This was fixed.
Integrations > Users would lose search results when matching records in the
record mappings for QBO. This was fixed.
Invoice Editor > Updates to custom fields linked to T&E items were not being
saved. This was fixed.
Reports > "Tax Registry" report would show incorrect tax amounts in case of
Joint Invoices. This was fixed.
Reports > An issue with the "Hide Phases" option would cause the report to
not calculate client hours and other fields correctly. This was fixed.
Reports > When exporting the Aged WIP with AR report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Check Details report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Employee Allocation Units report as an Excel
file calculation could not be run on certain number fields due to their format
type. This was fixed.







Reports > When exporting the Employee Half Monthly Time Card report as an
Excel file, calculations could not be run on certain number fields due to their
format type. This was fixed.
Reports > When exporting the Statement by Client (Accountant) report as an
Excel file, calculations could not be run on certain number fields due to their
format type. This was fixed.
Security > Several fixes were added to harden the security profile of the
application.

VERSION 1.1.170 RELEASED ON JULY 06, 2022
Product Enhancements:












BQE ePayments is now available for US companies that subscribe to our billing
module. Users can now sign up for this service using in-app Merchant
onboarding and start accepting payments immediately after getting approved.
Invoice Editor > Time Entry details can now be updated directly from the
Invoice Editor.
Invoice Templates > Retainer summaries have been added to Joint Invoice
Templates.
Reports > New filter options have been added to the Project Time Entries
report and it has been optimized for better performance.
Reports > The Time Details report has been optimized for better performance.
Reports > The Trial Balance Accrual report's UI has been updated to improve
readability and its performance has been optimized.
Time Card > The Description column was made to be an optional column that
is displayed by default.
Time Card > The Time Card has been optimized for better performance.
Time Entries > The memo for an entry displayed in the Time Entries screen was
updated to fill out the Memo column depending on how wide or narrow the
column gets expanded.

Application Stability:



ePayments > Partial ACH payments made on an invoice would restrict future
partial payments to be made only in ACH and not credit cards. This was fixed.


























ePayments > Phone number formatting was not properly reflected when
emailing ePayment invoice.
ePayments > Cash Receipt has been restored as default template for
attachments on ePayment emails.
Integrations > Taxes were not syncing to the proper accounts when
connecting to QuickBooks. This was fixed.
Invoice Editor > Custom field updates were not saving for Time Entry details
from the Invoice Editor. This was fixed.
Project Templates > The Start and End dates in Project Templates were not
properly following the defined pattern when creating a new Project. This was
fixed.
Reports > Penny issue discrepancy between P&L and General Ledger Accrual
reports has been fixed.
Reports > When exporting the Activity by Project report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Billable Work History report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Budget Comparison report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Employee Paid Time Off Comparison report as
an Excel file, calculations could not be run on certain number fields due to
their format type. This was fixed.
Reports > When exporting the Employee Performance report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the General Ledger Extended report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Invoice Register report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Top N Clients report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.
Reports > When exporting the Transaction Details report as an Excel file,
calculations could not be run on certain number fields due to their format
type. This was fixed.




Security > 2FA verifications were being sent to the wrong company emails.
This was fixed.
Time Entries > Rates by Classification were not properly honored when
entering time. This was fixed.

VERSION 1.1.169 RELEASED ON JUNE 22, 2022
Product Enhancements:







T&E Reviewer > Users can now instantly see subtotals for selected records in
the T&E Reviewer screen.
Batch Invoices > We have updated the way the invoice date is interpreted for
recurring type projects. The new approach will allow users to include approved
time and expenses, independent of the invoice date.
BQE ePayments beta: This update adds the ability to schedule invoice and
statement payments.
Reports > We have optimized the "Time Verification" report for faster load
times.

Application Stability:










Billing Schedule > Scheduled Amount was being reset to $0 when a project’s
Contract Type field was updated. This was fixed.
BQE ePayments beta: We have fixed an issue with ACH transfers that would
cause the Invoice to be flagged as ACH Success on payment capture.
BQE ePayments beta: We have fixed an issue with ePayment methods not
being automatically associated with new and draft invoices.
BQE ePayments beta: We have updated the message included in emails sent to
merchants during the onboarding process.
Dashboard > An issue in the "Staff Workload" widget was causing a mismatch
between this widget and the associated report. This was fixed.
Integrations > The Project Group filter was not working when sending over
invoices to QBO. This was fixed.
Invoice > Duplicate emails were being sent for the same invoice. This was
fixed.
Project Template > To-do dates were incorrect when project was created from
a template with existing To-dos. This was fixed.






Reports > The Account Reconciliation' report was not showing subtotals and
drill down for uncleared transactions. This was fixed.
Time Card > There was a UI issue when pre-filling more than 45
Project/Activity combinations. This was fixed.
Time Card > Time Card row suggestions were not showing when tasks were
allocated to an employee group. This was fixed.
Time Entries > The "Memo Flag" column was not showing the correct status
when a memo was present for an entry. This was fixed.

VERSION 1.1.168 RELEASED ON JUNE 8, 2022
Product Enhancements:











BQE ePayments > Enhancements have been added to the BQE ePayments beta
including a more integrated merchant sign-up experience and a few other
important fixes.
ePayments > The Stripe and AffiniPay on-boarding experiences have been
enhanced to match the newly updated flow.
Projects > When navigating to a different phase within a project's details, the
user is now dropped into the same tab they are already on instead of always
returning them to the Details tab.
Reports > The Invoice Register report has been optimized for better
performance and new filters have been added.
Reports > The Project Time and Expense report has been optimized for better
performance and new filters have been added.
Reports > The Time and Expenses by Parent Project report has been optimized
for better performance and new filters have been added.
Time Card > Suggested Time Card rows based on allocated projects/tasks
were not always displayed in the Time Card if the allocation dates only lasted
for a portion of a week. This was fixed.

Application Stability:



Cloud Feeds > Cloud Feeds was incorrectly noting that entries had already
been matched when trying to “Find Match” for multiple transactions. This was
fixed.























ePayments > The ePayments Details report was not accurately displaying
payment statuses for payments that were previously deleted then repaid. This
was fixed.
Integrations > Projects were incorrectly being created in CORE when syncing
payment data from QuickBooks Online. This was fixed.
Integrations > Trying to send invoices to QuickBooks in a batch was not
properly sending all invoices. This was fixed.
Projects > Users were incorrectly getting a permissions error when trying to
view Project details for certain records. This was fixed.
Reports > The ePayment Details report was incorrectly displaying Payment
type when paying with credit card. This was fixed.
Reports > When exporting the Balance Sheet Accrual report as an Excel file,
numbers were exported as text and not number format. This was fixed.
Reports > When exporting the Balance Sheet Cash report as an Excel file,
numbers were exported as text instead of number format. This was fixed.
Reports > When exporting the Billing Analysis report as an Excel file, numbers
were exported as text instead of number format. This was fixed.
Reports > When exporting the Billing Details report as an Excel file, numbers
were exported as text instead of number format. This was fixed.
Reports > When exporting the Employee Paid Time Off Hours report as an
Excel file, numbers were exported as text instead of number format. This was
fixed.
Reports > When exporting the Employee Utilization report as an Excel file,
numbers were exported as text instead of number format. This was fixed.
Reports > When exporting the General Ledger Cash report as an Excel file,
numbers were exported as text instead of number format. This was fixed.
Reports > When exporting the General Ledger report as an Excel file, numbers
were exported as text instead of number format. This was fixed.
Reports > When exporting the Personal Time Off Usage report as an Excel file,
numbers were exported as text instead of number format. This was fixed.
Reports > When exporting the Project Account Details report as an Excel file,
numbers were exported as text instead of number format. This was fixed.
Reports > When exporting the Project Performance report as an Excel file,
numbers were exported as text instead of number format. This was fixed.
Reports > When exporting the Work in Hand report as an Excel file, numbers
were exported as text instead of number format. This was fixed.
Reports > When exporting the Work in Progress report as an Excel file,
numbers were exported as text instead of number format. This was fixed.
Scheduled Reports > Scheduled reports that had a custom field filter applied
and were updated failed to send. This was fixed.

VERSION 1.1.167 RELEASED ON MAY 25, 2022
Product Enhancements:
















BQE ePayments: This update adds the beta version of our enhanced
ePayments processing capabilities. The current release will be available to
select few users.
UI improvements in ePayments Set up and Profile Management.
Dashboard > The Due Projects widget has been updated to sort by “Due
Date”.
Reports > The Employee Time Details report was optimized to load faster and
not freeze when applying filters.
Reports > The Monthly Profit and Loss Accrual Basis report Excel export has
been updated so numerical values export in number format instead of text
format.
Reports > The Trial Balance Accrual Basis report Excel export has been updated
so numerical values export in number format instead of text format.
Reports > The Account Transactions report Excel export has been updated so
numerical values export in number format instead of text format.
Reports > The Employee Time Detail report Excel export has been updated so
numerical values export in number format instead of text format.
Reports > The Time Card Week View report Excel export has been updated so
numerical values export in number format instead of text format.
Reports > The Time Card Week View report has been optimized for better
performance.
Reports > The Employee Time Card Summary report has been optimized for
better performance.
Reports > The AR Reconciliation report was optimized to include missing filters
options and load faster when applying filters.

Application Stability:



Batch Billing > During the batch billing process, the Time and Expenses report
was not properly generated to reflect unapproved entries. This was fixed.



Batch Billing > In some instances, there were duplicate invoices being created
when using the batch billing process. This was fixed.
Integrations > Projects were not properly syncing to MYOB. This was fixed.
Cloud Feeds > In certain scenarios, cloud feeds pulled from third party sources
were being duplicated. This was fixed.




VERSION 1.1.166 RELEASED ON MAY 11, 2022
Product Enhancements:






Invoices > The Invoices list screen can now be sorted using the Created-On
column.
Reports > The Contract Analysis report has been optimized for better
performance.
Reports > The Gross Margin Real Time report has been updated to include
additional information.
Reports > The Work in Hand report layout has been updated to improve
readability and the performance has been optimized.

Application Stability:







Batch Invoice > Available Project Retainers were not being displayed correctly
during the Create Batch Invoice process when there was no Project filter
specified. This was fixed.
Reports > The Time Details Report was not calculating amount/hours correctly
when filtering by multiple client groups. This was fixed.
Outlook integration > Some users were unable to sync all their Outlook events
to CORE. This was fixed.
Employees > Payroll related actions were incorrectly showing up in employee
screen action menus. This was fixed.

 ePayments > Previewing the "Statement" report from the Payment portal, the

system would not consider the filters that were associated with the Statement
report that shared with the Client. This was corrected.

VERSION 1.1.165 RELEASED ON APRIL 27, 2022
Product Enhancements:













ePayments > The Invoice totals on the Client Payment Portal have been
updated to reflect any discounts or retainers applied.
Cloud Feeds > Cloud Feeds have been enhanced to show check numbers for
transactions involving checks.
QuickBooks integration > Users now have the ability to exclude nonreimbursable expenses when sending expenses from CORE to QuickBooks.
Fee Schedules > Batch Update capabilities have been added to Fee Schedule
Services and Expenses.
Budgets > Batch Update capabilities have been added to Project Budget
Services and Expenses.
Activities > "Extra" attribute has been added to the Activities lists.
Activities > Description column has been added to all Activity filter drop
downs throughout CORE.
Batch Invoicing > Users can now update the percent complete of a Project
from the Batch Invoice screen without it affecting their Net Bill.
Reports > The Gross Margin report’s layout has been updated for easier
scanning and its performance has been optimized.
Reports > The Time and Expenses report’s layout has been updated for easier
scanning and its performance has been optimized.
Reports > The Expense Details report performance has been optimized.

Application Stability:



Batch Invoicing > Projects were not showing up when using the Project
Manager filter in the Create Batch Invoice screen. This was fixed.























Batch Invoicing > Time Entries were being excluded when Auto Apply Retainer
was selected on the Batch Invoice flow. This was fixed.
Dashboard > The Project Status widget was showing incorrect contract
amounts for Standard type parent projects. This was fixed.
ePayments > Invoice amounts on outgoing ePayment emails were not
accounting for discounts or retainers. This was fixed.
ePayments > One of the CORE help links on the Global Settings ePayments
screen was broken. This was fixed.
Invoice Templates > Project phases were shown out of order on joint invoices.
This was fixed.
Invoices > Creating a batch invoice using the setting to 'generate an invoice
amount based on % complete values' was not loading all the correct projects.
This was fixed.
Outlook integration > Some users were unable to sync all their Outlook events
to CORE. This was fixed.
Payments > There was an issue with displaying the client's projects in the
modal window after saving and adding another Payment for a different Client.
This was fixed.
Projects > Batch updating custom fields was incorrectly updating all records
when using search text to filter records. This was fixed.
QuickBooks integration > Syncing joint invoices to QuickBooks Online was
creating duplicates. This was fixed.
Reports > Running the Project List report using certain filters would cause
master projects to not display in the report. This was fixed.
Reports > The Employee Performance report can now be filtered by Project.
Reports > The Profit and Loss reports had issues when drilling into figures in
the report. This was fixed.
Reports > The Project Performance report was not properly displaying the
Earned Value %. This was fixed.
Reports > The Statements report has been updated to reset the page number
totals for each Client.
Reports > The Tax Registry report was showing incorrect grand totals. This was
fixed.
Time Card > When using a multi-week Time Card option, the user was not
brought to Week 1 when moving between different periods. This was fixed.
Time Entries > Exporting Time Entries to CSV was not honoring Cost and Bill
rate security settings. This was fixed.
Time Entries > Time Entry descriptions were incorrectly being reset if the
Project of the saved entry was edited. This was fixed.

VERSION 1.1.164 RELEASED ON APRIL 15, 2022
Product Enhancements:







ePayments > The ePayments portal has been enhanced to enable Clients to
choose which Invoices to pay on a Statement.
Invoice Templates > Invoice Template sections and appearance can now be batch
updated from the Global Settings page.
Projects > Users can now batch update Accounts from within the Projects list
screen.
Reports > Multiple group filters have been added to CRM reports.
Reports > The Client List report layout format has been updated to improve
readability.
CRM > Group filters have been added to the Leads, Prospects, Opportunities,
Quotes and Proposals list screens.

Application Stability:












Cloud Feeds > Projects were not loading in the Project Drop Down when adding a
new transaction of type "ITEM", if the project has Rule "Prevent Time Entry." This
was fixed.
Create Batch Invoice > Using the Project manager filter in combination with the
"Generate invoice based on % Complete" rule caused certain projects to not show
up. This was fixed.
CRM > Client Contacts were not getting copied over as Prospect Contacts. This
was fixed.
CRM Opportunities > When applying a group filter on the Opportunity list screen,
the top level KPIs would disappear. This was fixed.
General > Projects were not being displayed using the correct sorting order in
various screens like the Projects list screen and Create Batch Invoice for some
users. This was fixed.
General > Whenever the “All Dates” date filter was applied, the list screen would
reset to This Year on the next refresh. This was fixed.
Invoice Templates > The Hourly by Title invoice template was not displaying
correct bill rates. This was fixed.
Payables > The Vendor Bills and Purchase Order list screens had issues when
applying the All-Dates filter. This was fixed.












Projects > Recurring project types had issues with doubled amounts. This was
fixed.
Reconciliations > Duplicate transactions were unintentionally being created when
double clicking the Clear checkbox really fast, making it impossible to balance
properly. This was fixed.
Reports > The Proposal Documents report had the wrong report label. This was
fixed.
Reports > The Contract Analysis report was not correctly honoring new report
parameters. This was fixed.
Reports > The Contract Analysis report was not displaying all projects if contract
amount was not specified at the project level. This was fixed.
Reports > The Expense Details report was incorrectly displaying Vendor records
when Employee filters were applied. This was fixed.
Reports > The Proposal Documents report was incorrectly displaying all
Document records. This was fixed.
Reports > Running or memorizing a Time Details report grouped by project or
employee instead generates a report grouped by activity. This was fixed.
Scheduled reports > Scheduled reports were not processed for instances with
more than 13 email recipients. This was fixed.

Performance Fixes:







Several areas of the application including API requests, list and detail views,
reports and widgets have been optimized for better performance.
Reports > The Billing Analysis report has been optimized for better performance.
Reports > The General Ledger Cash report has been optimized for better
performance.
Reports > The Check Details report has been optimized for better performance.
Reports > The Vendor Bills report format has been updated and the performance
has been optimized.
Reports > The Groups Assignment report was optimized for performance.

VERSION 1.1.163 RELEASED ON FEBRUARY 10, 2022

Enhancements:








Allocation-Event Sync: When created from an allocation, any changes made to a
calendar event will now auto update the corresponding allocation also.
eSignature support for CRM Proposals: Proposals can now be emailed for digital
signatures using DocuSign.
Contract Amount and Taxes: Global Settings to select different contract tax
configuration have been updated to help users distinguish between the three
varied tax options Core supports.
QBO Sync: A Linked column has been added to list views that support QuickBooks
integration to help denote if a record has been synced or not.
Pricing Update: CORE's role-based and Express package pricing has been updated.

Performance Fixes:








The General Ledger Extended report has been optimized for better performance.
The performance of the Time Entries, Expense Entries, and T&E Reviewer screens
has been improved by limiting the use of the ‘All Dates’ period filter. ‘This Year’
will now be used as the default period for these screens and ‘All Dates’ can no
longer be persisted as a saved option.
The performance of the Employee Allocation, Task Allocation, Project Allocation
and Staff Workload widgets has been improved by limiting the use of the ‘As of’,
‘As of Today’, and ‘Custom’ period filters and removing totals.
User notifications polling has been optimized for performance.
Project, Client and Invoice summaries have been optimized for better
performance.

Application Stability:


Updating the hours of an allocation line item did not properly save. This was fixed.



The Follow-Ups dashboard widget would incorrectly continue to display followups that were marked complete. This was fixed.
Payees were experiencing issues in the payment portal when processing a
payment was attempted and the required fields were not filled correctly. This was
fixed.
Setting a negative rate for an activity/expense line item was incorrectly saving as
$0 instead of keeping the negative rate. This was fixed.
Any custom label set for the Net Bill value in Global Settings was not being used
in the Project Performance tab. This was fixed.




























When Google Drive was set as the default storage destination in Global Settings,
previewing a file attached to an expense entry did not successfully display the file.
This was fixed.
Updating the Start and End Dates for a task allocation line item would not
properly work. This was fixed.
Payments that were recorded against a Client in QuickBooks were not properly
syncing to CORE. This was fixed.
The Vendor Performance report displayed an incorrect vendor credit balance
when multiple bills were paid using vendor credits. This was fixed.
If a Vendor did not have a first and last name, the Time Details report would
display a blank space when grouping the report by Employee. This was fixed.
Switching between two companies in one CORE account would cause issues when
applying filters in Dashboard widgets. This was fixed.
The Work in Progress Details report showed the incorrect discount amount in
some instances. This was fixed.
The Allocation vs. Earned Revenue with Forecast report was incorrectly calculating
the total using the employee's bill rate instead of the rate taken from the assigned
fee schedule. This was fixed.
The Staff Workload widget did not include hours for allocations that did not have
an end date causing an inconsistency with the hours displayed in the Employee
Allocation Units report. This was fixed.
When a Vendor's Tax ID Number was saved and the setting to track payments for
1099 was turned on, the TAX ID number displayed an error in all 1099 reports. This
was fixed.
Exporting the line items when batch invoicing creates a blank file. This was fixed.
When viewing the Project Status widget by Budgeted Amount, the Open A/R
column displayed the incorrect amount for phases. This was fixed.
When matching CORE transactions, the auto-filled memos were incorrectly
deleted after selecting the corresponding Project and Item. This was fixed
Payments transferred to CORE as retainer are not successfully being used to pay
an invoice. This was fixed.
CORE expense sync to QuickBooks was creating multiple bills instead of a single
bill. This was fixed.
Joint invoices linked to one Project did not have the correct mappings even
though the invoices were successfully syncing with QuickBooks Online. This was
fixed.

Payroll Beta Updates:





Users can now save historical employee payroll information to help with accurate
YTD reporting.
Entries that were approved in a previous period are now successfully maintaining
the updated approval status.
UI updates in Payroll Reviewer and Payroll Taxes report
General Fixes

VERSION 1.1.162 RELEASED ON JANUARY 6, 2022

Application Stability:













The Projects list view was not displaying any projects if the ‘Date’ type custom
field was configured to display in the list view for one user. This was fixed.
When filtering for an individual project or a range of all projects in the Forecasting
Manual View tab, the results listed are duplicated. This was fixed.
Error messages in Core have been updated to provide a better description of the
error that occurred.
Time Entries created using a device set to Central Time (US & Canada) were
displaying tomorrow’s date for the Created on and Last Updated fields instead of
today’s date. This was fixed.
Only leads with a 'Pending' status were displayed in the Leads list view by default,
but the default display should have also included leads with a 'New' or 'Contacted'
status. This was fixed.
Vendor bills that had time and expense synced to QBO were not syncing. This was
corrected.
Updating Start and End dates of dependent tasks in Gantt Chart would not update
the underlying record for these date fields. This was fixed.
When filtering the Allocated Hours report by a client group, data for the wrong
client group is displayed in the report. This was fixed.
CRM Proposal preview would not work if primary contact of a Prospect was added
as one of the recipients. This was fixed.
When pasting text from a Word document into the Proposal Builder editor, all
indentations are lost. This was fixed.

Performance Fixes:


The Time Details report was optimized for better performance

General Fixes:



Descriptions were updated for each package in the Manage Subscriptions screen.
The Managed By field on a standard Hourly invoice included an extra space
between the first and last name. This was fixed.

Payroll beta user feedback:




'Net Pay x Percentage' was added as a calculation option for employee
withholdings and company matching.
A row for totals was added for each employee or vendor in the Employee Pay
Items report.
Bug fixes

VERSION 1.1.161 RELEASED ON DECEMBER 16, 2021
Performance Fixes:






Default date filters have been updated throughout Core to improve performance.
List views that displayed KPIs at the top were improved to improve page load
times.
Batch Update operations in Cloud feed have been optimized for improved
performance.
Project update involving Phase hierarchy was optimized for performance.
General Ledger and Time Details report performance optimizations

General Fixes:





Decimals were added back to the Billed, Paid, and Balance metrics displayed at the
top of the Invoices list.
Cumulative Project Custom budgets experience was optimized to allow users to
add line items for phases w/o turning on custom budget flags for each phase.
Monthly P&L report was updated to handle large numeric data w/o introducing
overflow.
Project list report had an issue with rolling up Contract amounts when the “hide
phases” option was used. This was fixed.

Payroll beta user feedback:





Added the ability to save historical employee payroll information
Default filters applied to the Payroll Reviewer for faster access to relevant data
Bug fixes

VERSION 1.1.160 RELEASED ON NOVEMBER 29, 2021

Subscription Pricing Update:


BQE is introducing a new pricing structure to better package the most popular
modules: Time & Expense, Project Management, and Billing. The new pricing
model offers Accounting, CRM and HRM as add-on packages at the Company
level. The new pricing changes will only apply to new CORE customers and will not
affect existing users until a later date.

Application Stability:





Users who had custom security profiles assigned were not able to load reports in
the report center. This was fixed.
The Vendor Bill report was crashing when the Vendor Bill Status filter was applied.
This was fixed.
Exporting a large number of records from the Create Batch Invoice screen would
result in faulty exported files. This was fixed.
Entering a memo in the Project details would cause Core to be unresponsive in
the Chrome browser. This was fixed.

Performance Fixes:



Follow up list view was optimized for performance.
The General Ledger report was optimized for performance.

Payroll beta user feedback:



Improved review and approval experience in the Reviewer
Bug fixes

General Fixes:



Updates to task start and end dates were not syncing within the Allocation &
Forecasting screens. This was fixed.
The Retainer Reconciliation report was not applying the date filter correctly. This
was fixed.







Time details Report shows project manager instead of employee/activity at the
top when group by employee or activity.
Payment type updates were not properly syncing throughout Core. This was fixed.
When updating the description of a Time Entry, the memo would be deleted. This
was fixed.
Payment Receipts were being sent even with Global Setting turned off. This was
fixed.
The Client Transactions report has been updated to improve readability. New filter
parameters have been added as well.

VERSION 1.1.159 RELEASED ON NOVEMBER 10, 2021
Application Stability:





Fixed an issue that was preventing some two-factor authentication users from
logging in.
Fixed an issue that was not properly enforcing cost amount access on the Budget
screen.
Fixed an issue with date filters in the Time Card view for New Zealand users.
Added several security related fixes.

Performance Fixes:




Budget creation from existing budgets that had a large number of items was
optimized for faster performance.
List view KPI metrics were optimized for performance improvements when
reporting for companies with large data.
Performance optimizations were implemented for several reports that either failed
to preview or would take a long time to preview.

General Fixes:




The Time Details report has been improved for readability and now offers more
filters.
QuickBooks credit payments are now transferred as Client retainers instead of
Project retainers.
Added support for less popular international currencies for cloud feeds.

Payroll beta user feedback:




Improved Employee Payroll Defaults UI.
Updated several reports with default filters.
Updated labels and captions.



Bug fixing.

VERSION 1.1.158 RELEASED ON OCTOBER 25, 2021
General Application Stability
Several issues affecting existing features have been fixed throughout the application.













ePayments > When returning to the ePayments portal to edit an existing payment, the
incorrect deposit account details were being displayed. This was fixed.
Projects > The Project list screen was not properly displaying search results when two or
more Custom Field filters were applied. This was fixed.
Bill Payments > ABA Files that were generated from the Bill Payments screen were
incorrectly rounding amounts. This was fixed.
Cloud Feeds > When matching transactions in Cloud Feeds, the Payee drop down menu
was not displaying all records. This was fixed.
Invoice Collections > Invoice Collection notes that were added to past or future dates
were reverting to an incorrect date. This was fixed.
Payments > The Invoices list in the Add Payment screen was not sorting dates correctly.
This was fixed.
Integrations > The eSign option was appearing for proposals after connecting a
DocuSign account, but that feature is not yet available. This was fixed.
Payments > The credit and debit amounts were not displaying the same amount when
creating an ABA file from the Payments screen. This was fixed.
Deposits > Users with Deposit records that were migrated to Core were experiencing
issues when saving Text Custom Fields. This was fixed.
ePayments > The branding update from DesignPay to ClientPay was not applied in some
parts of Core. This was fixed.
Updated help and other documentation.
Other minor level fixes.

VERSION 1.1.156 RELEASED ON OCTOBER 9, 2021
What’s new in this version?

Two-Factor Authentication app support
CORE has further enhanced its two-factor authentication security by now offering the ability to
connect with popular authenticator apps. The implementation will support popular
authenticator applications like Google Authenticator, Microsoft Authenticator, Twilio Authy
among others.

Draft Invoice Editing
A highly requested feature enhancement to CORE’s popular Billing module is finally here. Draft
Invoices can now be edited directly in the Invoices screen. Relevant Invoice details ranging from
Contact Information to discount and retainers can be updated from one clean interface.

Extend eSignature support to more modules
The ability to send documents out for collecting eSignatures directly from CORE has been
expanded to other modules. Document eSignatures have been expanded to include Invoices,
Purchase Orders, and Vendor Bills. When a document is sent for eSignatures, the eSignature
status will be tracked and automatically updated in the respective Documents tab of the
specified record.

CORE Payroll – Beta
Significant progress has been made on the upcoming CORE Payroll feature being introduced to
round out CORE's overall offering including the ability to configure company and employee
payroll defaults, approve entries to include in payroll, and process payroll for employees and
agencies that follow multiple differing payroll frequencies. This module is currently in closed
beta.
Cloud Feed Enhancements
Several enhancements have been made to the Cloud Feed module to improve the overall user
experience. These include search and filter function, column resizing among other
improvements.

Integrations Enhancements
Improvements have been made to strengthen the data synchronization with third party
accounting software solutions.

Other Improvements:



























Assignments > A new option has been added to the Assignments tab of a Project’s detail
page so users can update phase assignments when changes are made at the Parent
level.
Batch Invoicing > Pre-Tax Net Bill has been added as a column to the Create Batch
Invoice list screen.
Benefits > Managers can set a benefit to have a maximum carry over amount calculated
based on a multiplier of the previous year's remaining balance.
Cloud Feeds > A filter panel and Search box has been added to all three transaction list
views in Cloud Feeds.
Cloud Feeds > Cloud Feeds rules can now be reviewed and edited from within the
Transactions lists accessible from the More drop-down menu.
Cloud Feeds > Column resizing has been added throughout the Cloud Feeds module.
Cloud Feeds > Payee and Account have been added Core transactions details in the
Pending list in Cloud Feed.
Cloud Feeds > The Cloud Feeds matching experience has been updated to avoid list
refreshes after an entry is matched.
Dashboard > The dates on the x-axis for the newly-added Project Schedule widgets have
been moved to the top of the chart.
Dashboard > The Retainer Balances widget has been updated to exclude Clients with a
zero-retainer balance.
ePayments > CORE has been updated to work smoothly with DesignPay’s brand name
transition to ClientPay.
General > When merging entities, the confirmation dialog now displays the exact names
of the entities being merged to make the process more transparent.
Global Search > Users now search for Cost Amount along with other currency fields like
Cost and Bill rates.
HR Reviews> Questions on Employee Reviews can now be assigned specifically to the
Reviewee, Reviewer or Both.
Integrations > A column for Invoice number has been added to the QuickBooks
Unmapped records screen on the Core side.
Integrations > Credit Payments can now be synced from QuickBooks to Core as Retainer
Payments.
Invoice Templates > Invoice Templates can now be configured to allow eSignatures.
Invoices > A project rule has been added to include retainer summaries on invoices.
Leads and Prospects > Added City and State as filter options in their respective list view
screens.
Performance > CORE data queries have been optimized to improve widget and report
performance.
Project Templates > In the To-dos tab of a Project Template, the Duration column label
was changed to "Duration (Days)" to better describe the information displayed in the
column.
Reports > A Resource filter option has been added to the Time Card Cross Tab report.
Reports > An Employee Group filter has been added to the Employee Utilization report.

























Reports > An option to show Start and Stop times has been to the Time Verification and
Time Detail reports.
Reports > Options have been added to the AP Aging with Credits report to Show/Hide
details and to Show orphaned General Journal entries.
Reports > Resource and Vendor filter options have been added to the Time Verification
report.
Reports > The Class filter has been added to the following reports: AR Aging, AR Aging 5
Steps, AR Aging 8 Steps, AR Aging with Retainage.
Reports > The Expense Details report has been updated for improved readability.
Reports > The Notes column in the Employee Notes by Category report has been
expanded to take full advantage of the page width.
Reports > The Payment Refunds report has been updated for improved readability.
Reports > The Time and Expense by Parent Project report has been updated for
improved readability.
Reports > The Time and Expense report has been updated to improve its readability and
offer more filter parameters.
Reports > The Time Card Cross Tab report has been updated to improve its readability
and offer more filter parameters.
Reports > Several reports had issues with the drill down feature and this update
remedies that.
Retainers > An option to modify the memo text for ePayments-enabled Retainer Invoices
has been added to the ePayments Settings section.
Split Bills > We have enhanced this function to allow users to configure 0% billing splits.
Subscriptions > We have bumped up free storage allowance from 2 GB to 5 GB limit per
Company.
Time & Expense > If a Project has the “Auto-approve Time/Expense” rule checked, CORE
will allow its entries to be updated irrespective of the "Allow Edit of Approved Entry"
security permission.
Time & Expense Reviewer > When opening the Time & Expense Reviewer screen, the
search box of the list was updated to be the initial focus upon page load.
User Preferences > Users now have the option to turn off the recent suggestions feature
on CORE drop-down lists.
Vendor Bills > Duplicate Vendor Bill restrictions have been enhanced to allow the use of
the same bill number for different Vendors.
Vendor Bills > eSignature capabilities have been added to Vendor Bills.
Vendor Bills > Time and Expense entry attachments will be automatically added to a
corresponding Vendor Bill and all attachments cannot be accessed in the Documents tab
of the Vendor Bill details.
Vendor Bills > Workflow options have been added to the Actions menu in the Vendor
Bill details.

Other Fixes:
 Accounting > The General Ledger Extended report was not showing memos entered at
the expenses item level on invoices. This was fixed.


























Bill Payments > The Amount field on the Bill Payment list screen was incorrectly
including the Vendor Credits applied. This was fixed.
Bill Payments > The NACHA file generated from the Bill Payments screen for Australian
companies was causing errors when uploaded to Commonwealth Bank to initiate a batch
payment. This was fixed.
Calendar > The Sync Date on the CORE Calendar was not reflecting the correct local
time. This was fixed.
Create Batch Invoice > When batch updating a list of Project billings, the system would
allow the user to specify a discount amount and then apply it as is without checking the
net bill amount for that Project. This was fixed.
Dashboard > On the Due Projects widget, filtering the list for projects with a ‘Canceled’
Project Status was not working. This was fixed.
Dashboard > The Cash Flow widget was not properly displaying Invoice payments made
via one Payment. This was fixed.
Dashboard > The Payment Date filter in the Retainer Balances widget was not properly
transferring retainers. This was fixed.
Documents > In the Documents list screen, clicking on a disabled eSign action would
open the detail view of that document record. This was fixed.
ePayments > A third party scenario was causing the ACH Transaction Status to not
update to Completed. This was fixed.
Estimates > The Documents tab of an Estimate's detail page displayed the row actions
menu outside of the table when the eSign Status column was not turned on. This was
fixed.
Expense Entry> An update to the billable flag would reset the charge amount if the user
had not entered a Cost rate. This was fixed.
HR > Users that had the Core Express and Core Express HR subscription added to a
company file were unable to preview any of the on-screen Reports for the HR modules.
This was fixed.
Integrations > Payments were not syncing over to Xero from Core if the Bank account
under sync setting was set to the Bank account created in the Xero. This was fixed.
Lists > The height of the error message displayed in CRM lists when deleting an item
that is in use was cutting off the message. This was fixed.
Opportunities > New contacts could not be created from an existing CRM Opportunity.
This was fixed.
Project Budgets > For Budgets with many budgeted items, the Unbudgeted Items row
would duplicate itself at the end of the list. This was fixed.
Project Templates > In the To-dos tab of a Project Template, the "Create Time Entry"
action for a to-do item does not open the modal to create a time entry and causes an
error. This was fixed.
Project Templates > The ability to add an attachment when creating a time entry from a
project template's to-do item was not working. This was fixed.
Projects > Few users had reported that the Percent Complete value was not rolling up to
the Parent Project in the Structure tab interface. This was fixed.

























Projects > Rearranging the phases in a project's Structure tab was not properly saving
the correct order. This was fixed.
Projects > The Projects list view column sort was not correctly sorting for several
columns. This was fixed.
Projects > The relocated dropdown for all the phases in a project's detail view was
missing the ability to scroll through a longer list of phases. This was fixed.
Projects > When adding a Team Member under the Assignments tab in Project details,
sorting the list of Team Members in the dialog would cause the entire list to vanish. This
was fixed.
Projects > When navigating to a different phase from the Project details, the tab location
was not persisted. This was fixed.
Projects > When searching for team members to assign in a project detail's Assignment
tab, the modal's search box was only searching for entries that were initially loaded and
displayed instead of searching the whole list. This was fixed.
Projects > When using the Expand Sub-phases action in the Projects list screen, some
projects were being duplicated and an incorrect view count was being displayed. This
was fixed.
Proposal Builder > When trying to preview a Proposal that had a Quote in the Compose
Email module, the preview window had overflowing tables. This was fixed.
Reports > New Zealand based customers could not preview the WIP Reconciliation
Report. This was fixed.
Reports > Profitability percentage was being calculated incorrectly when the Invoice
amount was $0. This was fixed.
Reports > Purchase Order History report had an issue when grouped by Vendor. This
was fixed.
Reports > Several users had complained that they would get a blank page inserted at the
end of the report when previewing or printing the report. This was corrected.
Reports > Several users had complained that a few of the standard reports had stopped
working if the logged user had a custom defined security profile. This was fixed.
Reports > Some Equity accounts were not being displayed in Viewer format for the
Balance Sheet Cash Basis report. This was fixed.
Reports > Some Financial Reports were producing an extra blank page at the end of the
report. This was fixed.
Reports > The Activity by Project report was not properly supporting the drill down
feature. This was fixed.
Reports > The Balance Sheet by Class Accrual Basis report threw a system error when
drilling down into the number details. This was fixed.
Reports > The Documents report was not displaying the payroll labels properly. This was
fixed.
Reports > The Employee Daily Time Card and Time Verification on-screen reports were
not reflecting the same date range as the Time Card screen. This was fixed.
Reports > The Employee Expense report total numbers were not trying out. This was
fixed.
















Reports > The Missing Classification category was not being displayed in certain
scenarios across the AR Aging reports. This was fixed.
Reports > The Paid filter was not being correctly applied when running on-screen reports
from the Payments screen. This was fixed.
Reports > The Project Time Entries report was not respecting the cost security when a
scheduled report was delivered. This was fixed.
Reports > The Top N Expenses report was not properly supporting the drill down
feature. This was fixed.
Reports > The Workflow Details report could not be filtered by Vendors. This was fixed.
Scheduled Reports > Reports could not be scheduled for more than 15 emails. This was
fixed.
To-dos > The list of To-do items would disappear whenever creating a new To-do for an
Opportunity in the main To-dos list screen. This was fixed.
To-dos > To-do reports were not available to generate from the To-dos list screen for
Invoices and Project templates. This was fixed.
To-dos > When creating a Time Entry from a To-do, attachments couldn't be added from
the Resource Library option. This was fixed.
Vendor Bills > When creating a new vendor bill, time entries that have already been
marked as paid using batch update in the Time Entries screen were incorrectly being
listed in the time entries CORE suggests to include in the vendor bill. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.155 RELEASED ON AUGUST 21, 2021
What’s new in this version?

Project Schedule Dashboard Widgets
Two new dashboard widgets have been added to CORE to help users better visualize their
project schedules and allocations. The “Project Schedule by Due Date” widget displays projects
in a Gantt chart using each project’s start and due dates. The “Project Schedule by Allocation”
widget also displays projects in a Gantt chart, but is driven by Project allocation dates.

Enhanced Project Templates
Project Templates have been further enhanced to streamline the project creation process and
eliminate manual data entry. Additional phases can now be added to existing project templates.

When setting up a project template, project managers can also elect to designate a standard set
of To-dos to that template that can be cloned when setting up a new project.

Allocate from Events
CORE Calendar Events have been enhanced to further integrate with the Allocations module.
New and existing events can now be used to create Allocations. Event details will be used to
pre-fill the Allocation information and reduce the need for duplicating data entry.

Other Improvements:
 Activity Items > The "Purchase Tax" column label has been updated to match the label
used in Expense Items.
 Calendar > Calendar events that have been used to create a Time Entry will now be
marked with an icon to signify that a Time Entry record exists.
 Checks, Deposits > An anchored totals row has been added to the Checks and Deposits
list screens.
 CRM Email Templates > Custom fields can now be used as Smart Fields when setting up
a CRM Email Template.
 Dashboard > The Priority column was added to the To-dos widget.
 Dashboard > The Project Status Widget was missing the Marketing option for the Project
Contract Type filter. This was added.
 ePayments > ePayment invoice emails have been updated to accommodate multiple
invoices being sent out at once.
 eSignatures > A new status column has been added to the Documents list view that will
display the Document's eSignature status.
 Employees > The Employee Account number field has been expanded to accept up to 16
digits.
 Expenses > The cost amounts for approved expense entries have been added to the
automated email notifications.
 Follow-Ups > Users can now issue a quick search for matching follow-ups based on
Assigned to and Follow-up type values.
 Integrations > CORE Joint invoices that are synced to QuickBooks will now remain as one
invoice rather than being split into multiple Invoices in QuickBooks. Users can also retain
to use the old option.
 Integrations > The date time stamps in the Sync history have been updated to reflect the
logged in user's time zone.
 Invoice Templates > The Joint Invoice Templates have been updated to improve
readability.
 Invoices > Manual invoices can now be created from an existing Custom Budget.
 Projects > Project detail hierarchy navigation has been expanded to include all tabs in a
Project's details.


















Projects > The tooltip for the Spent column in a Project detail page's Structure tab was
updated to more accurately describe that column's information.
Reports > The Time Entry Delay report has been added to the Report Center.
Reports > All Financial Budget reports will now include Income and Expense accounts
even if they have not been assigned a budget but have a balance in the specific period.
Reports > The Billable Work History report has been re-designed to improve readability.
Reports > The Cash Flow vs Revenue report has been re-designed to improve readability
and offer new filter options.
Reports > The Project Group filter has been added to the WIP Reconciliation and
Employee Utilization reports.
Reports > The Retainage Summary by Client report has been re-designed to improve
readability.
Reports > The Taxes report has been re-designed to improve readability.
Reports > The Top Ten in Revenue report has been re-designed to improve readability
and offer new filter options.
Reports > The Void Invoices report has been re-designed to improve readability and
offer new filter options.
Retainers > Project Retainers can now be transferred between different clients.
Security > A new security option has been added to control the "Update Rates" feature
in Time Entry.
Security > A new security option has been added to show or hide bill rates on reports.
Submit Workflow > The messaging for notifications and workflow emails have been
updated for submissions that are forwarded to another manager for approval.
Time & Expense Reviewer > Taxes (including Purchase Tax) can now be added to the
Time & Expense Reviewer list view as optional columns.
Vendor Bills > Users can now enter Purchase Tax as an amount by prefixing the number
with a "$" symbol.

Other Fixes:
 Bill Payments > Bill Payments could not be saved for users that switched their country to
UAE in the company profile. This was fixed.
 Budgets > Selecting all records on the Budgets list view and then scrolling to expose
more records in the list would cause Batch Updates to affect an incorrect number of
records. This was fixed.
 Create Batch Invoice > In certain scenarios involving a large number of Phases per
Project, the Percent Complete option would not display all the phases that were due for
billing. This was fixed.
 Credit Cards > An issue in code was preventing updates to the class associated with a
line item. This was corrected.
 CRM > Custom fields were incorrectly overlapping between filters for all CRM modules
(Leads, Prospects, Opportunities). This was fixed.

























Dashboard > The Submittal and RFI widgets would disappear from an existing
dashboard and could not be added back when a new subscription was assigned to a
logged in user. This was fixed.
Estimates > When downloading an Estimate from the Estimates list view, the PDF would
contain extra pages. This was fixed.
Forecasting > The forecasting algorithm was not able to distribute a 1-unit allocation.
This was fixed.
General > Drop down items displayed under the recent section were not appearing in
their usual position in the broader list. This was fixed.
General > Filtering a list view by a text box type of custom field and then editing that
field for a record would cause the entire list of records to disappear. This was fixed.
General > Logos were not being uploaded with the correct dimensions in Company
Profile. This was fixed.
Integrations > Project costs were not being tracked appropriately using the QuickBooks
sync. This was fixed.
Integrations > Invoice sync was not working if the CORE project for the invoice had the
automatic email on processing turned on. This was fixed.
Invoices > The "Last Emailed On" column was not correctly adjusting the date time field
to the user's time zone. This was fixed.
Invoices > The Project Manager filter would cause some of the paid invoices to show up
as Open. This was fixed.
Leads, Prospects > The autocomplete feature was not working properly for the Tag filter
on the Leads and Prospects list views. This was fixed.
Manual Invoices > When creating a manual invoice, the date format was not following
the local settings set for Australian users. This was fixed.
Messages > Opening an attachment from the Message details screen would cause a
screen error. This was fixed.
Projects > Quick search would limit the list view to 25 records if the user had chosen to
display a custom field in the list view. This was fixed.
Proposals > The placeholder text in the search box of the Add Quote modal was
incorrectly labeled. This was fixed.
Prospects > The file name of the selected file when uploading a document in the note
details of a Prospect's contact was not displaying in the modal. This was fixed.
Prospects > When importing contacts via csv files into a Prospect record, saved
mappings were not showing up on subsequent imports. This was fixed.
Reports > An issue with the Open Purchase Orders report was preventing open Purchase
Orders from showing up if they had a line item with a negative number of units. This was
fixed.
Reports > The Project Groups report was un-necessarily including the "All' group. This
was fixed.
Reports > The "Project Time and Expenses" report was not including the extra billed
expenses in the Account Summary. This was fixed.
Reports > The Budget Comparison by Employee report was not displaying the correct
sums under the Spent Amount column in some cases. This was fixed.


















Reports > The Employee Missing Time Week View report was not showing Employees
who had missing time, if a Vendor with the same name existed. This was fixed.
Reports > The Notes report was not displaying all relevant records when applying a date
filter. This was fixed.
Reports > The Project List report had issues when applying certain logical filters. This was
fixed.
Reports > The WIP Reconciliation report has been optimized for performance.
Time & Expense Reviewer > When the Select All checkbox was used for Workflow Status
filter, the list view would not display all records as it should have. This was fixed.
Time Card > The Bi-week period used on employee time cards and the Employee Biweekly Time Card report were not referencing the same period. This was fixed.
Time Card > When a time entry was submitted to My Manager as Payroll type only, the
submit status icon would not show up on the Time Card. This was fixed.
Time Entries > The newly added import CSV feature was not including the Class column
when imported from a CSV file. This was fixed.
To-dos > To-dos that were batch updated to an inactive status were still showing up on
the list view. This was fixed.
To-dos > To-dos were not properly sorted by their priority. This was fixed.
Vendor Bills > non-reimbursable expense entries were being marked as reimbursable
when their associated Vendor Bill was paid via Credit Card or Checks. This was fixed.
Vendor Credits > In the Vendor Credits Create New and Details screens, the Accounts
Payable field did not have a red asterisk to indicate that it is a required field. This was
fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.154 RELEASED ON JULY 3, 2021
What’s new in this version?

CORE eSignatures with DocuSign
This update adds the hugely requested feature of electronic signing for CORE reports and
documents. We have added this feature by partnering with DocuSign, the world leader in digital
signing allowing CORE users to send documents and reports for eSignature to any external or
internal contact. The fully embedded eSignature experience has also been added as an option in

Budgets, Estimates, Time Card, Time Entry and Expense entry screens and allows users to send
reports for electronic signing with or without preview.

Time & Expense Import
Time and Expense Entries can now be bulk imported to CORE by uploading a .csv file. The
import wizard can be accessed from the More option of the list views. CORE also has the ability
to memorize the column mapping from your designated file to streamline future imports.
BAS Statement
Australia-based companies can now generate a Business Activity Statement from CORE using
their existing company data. The Business Activity Statement module will allow users to review
and make edits to the required input fields. Each BAS can be saved for future reference and a
neat report can be shared with internal or external parties.
ABA File Export
Australian and New Zealand users can export their Bill Payments to an .aba file format file. ABA
is a preferred file format for all the major banks in the Australia and NZ to automate Bill
Payments.
Pre-fill Time Card from Allocated Tasks
Time Card suggestions have been enhanced to now suggest time card rows based on allocated
tasks. Each user will now have the option to have their Time Card suggestions based on recent
time entries, allocated tasks for a given period, or a combination of both.

Other Improvements:
 Accounting > Multiple Accounts Receivable and Accounts Payable accounts can now be
used when creating a Journal entry.
 Activities > Purchase Tax Rate has been added as a Batch Update option in the Activities
list view screen.
 Batch Invoices > When launching the Billing Details report from the Create Batch Invoice
list screen, it will now include the Billing Through dates.
 Billing > Upon billing 100%, Projects will now be marked complete based on the Global
Setting rule, regardless of Project Contract type.
 Budgets > Cumulative Budget list view scrolling has been improved.
 Budgets > The Project Budgets UI has been updated for improved readability. A new
subtotal row has also been added to report the unbudgeted units that have been
incurred on that specific project or phase.
 Clients > The Clients list screen now supports searching by Address.
 Clients > The Company column was made to be an optional column in the Clients list
view.


























Clients, Employees, Vendors, and Projects > State and City were added as optional
columns for the Clients, Employees, Vendors, and Project’s list screens.
Custom Fields > Custom fields can now be batch updated from all existing modules that
support them.
Dashboard > Additional filters have been added to Dashboard widgets for Principal and
Originator.
Dashboard > The Last Week period filter option has been added to the Time
Performance widget.
Dashboard > The number format on Dashboard widgets have been updated to include
commas.
Employees > Employee Groups can now be batch updated and assigned from the
Employee list screen.
ePayments > ePayments users can now set default ePayment profiles for each payment
type (ACH and Credit Cards) at the global level. Previously, users could only set one
default profile, regardless of type.
Forecasting > The Activity grouping for Other Tasks can now be expanded from the
Forecasting list screen.
General > Additional optional columns have been added to the following list screens:
Employees, Clients, Vendors, Projects, Invoices, Payments, Time Entries and Expense
Entries.
General Journal > A totals row has been added to the review step while importing
entries via CSV to the General Journal.
Global Settings > Administrators can now set up a separate default Account for Late Fees
in Global Settings.
Invoice Collections > A Notes count has been added to the Invoice Collections screen.
Invoices > Draft Invoices can now be Approved and Finalized from the Invoices list view
screen.
Invoices > Time and Expense entries on Draft Invoices will now be included in Work in
Progress calculations for reports and widgets.
Leads and Prospects > A Job Title attribute has been added to CRM Leads and Prospects.
Lists > Default Note Categories can now be edited or deleted from the Note Categories
list.
Notes > The ability to add notes for secondary level contacts was added in the Contacts
tab of a Client, Employee, and Vendor.
Opportunities > A Created-On column has been added to the CRM Opportunities list
screen.
Opportunities > Custom fields have been added to CRM Opportunity records.
Opportunities > New CRM Opportunities can now be created for existing Contacts
(Clients, Vendors, Employees) using a row action from the corresponding list screens.
Opportunities > Notifications will now be sent to a user when they are assigned to an
Opportunity.
Opportunities > Sales Commissions were not being processed if the Quote Amount or
Proposal Amount were chosen as the final amount when marking an Opportunity as
Won. This was fixed.
























Overtime Calculator > The Overtime Calculator has been enhanced to support Employee
Weekly Standard Hours. Also, Overtime rules can now be set on a weekly or daily basis.
Project Templates > Custom Fields have been added to Project Templates.
Projects > The Originator field for a Project will be automatically set as the user creating
the Project.
Projects > When cloning an existing Project, Custom Fields can now be included as part
of this process.
Reports > An option to Include Write ups and Write Downs has been added to the
Billing Details report.
Reports > The Custom Retainer Invoice report now supports the ePayments Pay Now
button.
Reports > New filter options have been added to the Monthly Billing Statement report
and the report layout has been updated to improve readability.
Reports > New filter options have been added to the Percentage Billed report and the
report layout has been updated to improve readability.
Reports > New filter options have been added to the Tax Tracking report and the report
layout has been updated to improve readability.
Reports > The Cloud Feeds report can now be filtered to show All, Pending, Ignored or
Included in Core records.
Reports > The Originator and Principal filters have been added to the following Aging
reports: AR Aging, AR Aging 5 Steps, AR Aging 8 Steps, AR Aging with Credit Payments,
and AR Aging with Retainage.
Reports > The Originator and Principal filters have been added to the following financial
reports: Balance Sheet Accrual by Project and Profit and Loss Accrual by Project.
Reports > The Originator, Principal and Project Manager filters have been added to the
following Analysis reports: Actual and Billing Comparison, Cost Analysis, Earned Value
and Employee Realization Rate.
Reports > The Originator, Principal, and Project Manager filters have been added to the
following accounting reports: Vendor Bills by Project, Open Purchase Orders, Purchase
Order History, Purchase Order Invoice, Purchase Order Received Item, Purchase Order
Time & Expense, and Purchase Orders.
Reports > The Originator, Principal, and Project Manager filters have been added to the
following Activity/Expense reports: Activity by Project, Top N Activities, and Top AND
Expenses.
Reports > The Originator, Principal, and Project Manager filters have been added to the
following Billing reports: Account Transactions, AR Reconciliation, Billed Time and
Expenses, Billable Work History, Cash Flow vs. Revenue, Invoice Register, Payment
Refunds, Retainage Summary by Client, Statement, Taxes, Statement by Client
(Accountant), Top Ten in Revenue, Void Invoices, Work In Progress, and Write Up Write
Down.
Reports > The Originator, Principal, and Project Manager filters have been added to the
following Client reports: Client Retainer Summary, Client Transactions, Tax Registry, and
Top N Clients.
























Reports > The Originator, Principal, and Project Manager filters have been added to the
following Company reports: Collection Calls, Conditional Lien Release, Contacts,
Employee Profitability, Employee Project Utilization, Firm Reconciliation, Group
Assignments, Mailing Labels, Monthly Revenue by Project, Notes, Payroll, To-do Tasks,
WIP Reconciliation.
Reports > The Originator, Principal, and Project Manager filters have been added to the
following Employee reports: Employee Allocation Units, Employee Control, Employee
Daily Time Card, Employee Expenses, Employee Half Monthly Time Card, Employee Paid
Time Off Comparison, Employee Time Card Summary, Employee Time Detail, Personal
Time Off Usage, and Staff Workload.
Reports > The Originator, Principal, and Project Manager filters have been added to the
following Payment reports: Cash Flow Monthly Statement, Cash Receipt YTD
Comparison, Cash Receipts, Cash Receipts Journal, Collections, Credit Memo Receipt,
Credit Memos, Credit Payment Receipt, ePayment Details, Paid Time and Expense
Disbursements, Paid Time and Expenses, Payment Details, Payment Receipt, Payments
Synced with QuickBooks, Refund Retainer Receipt, Retainer Details by Project, Retainer
Invoice, and Void Payments.
Reports > The Originator, Principal, and Project Manager filters have been added to the
following Project reports: Submittals, Drawings, and Allocated vs. Earned Revenue with
Forecast.
Reports > The Originator, Principal, and Project Manager filters have been added to the
following Time and Expense reports: Expense Details, Allocated Hours, Time Verification,
Time Card Crosstab, Time Card Week View, Time and Expenses, and Time Details.
Reports > The preview option label was changed to "Preview Format" to better describe
the associated action.
Reports > Principal and Originator filters have been added to the following accounting
reports: Vendor Bills, Vendor Bill Status, Trust Fund Account Activity.
Reports > The Project Profitability report now has the option to calculate Profit with or
without Work in Progress.
Reports > The Sales Forecast Distributed and Sales Forecast Summarized reports can
now be drilled down on for more granular details.
Reports > The Sales Forecast Summarized report can now be filtered by Category.
Reports > The Time Verification report now has the option to group by week.
Reports > Newly added reports and custom reports are now made available to users
with full reports access only.
Reports > The Accounts Receivable report’s calculation performance has been optimized
to handle large amounts of data.
Sales Forecasting > Additional security has been added to the Sales Forecasting module
in CRM to limit access to certain users.
Subscriptions > Core has added Express subscriptions for CRM and HR Packages.
Task Allocations > Memos can now be batch updated from the Task Allocations list
screen.
Time and Expense Reviewer > The Reviewer list screen can now be filtered for
Reimbursable entries.





Time Entries > The Purchase Tax Rate field has been added to the detail view of Time
Entries and Activities.
Time Entries > The Time Entry description field has been expanded to accept up to 200
characters.
To-Dos > Batch Update functionality has been added to the To-Dos list view screen.

Other fixes:
 Activities > Batch Updating the description field from the Activities list screen to use
more than 200 characters would result in a system error. This was fixed.
 Calendar > Some synced calendars from Office 365 were displaying the wrong name in
the Core Calendar view. This was fixed.
 Credit Cards > A system issue would prevent updating the class field of a charge. This
was fixed.
 Custom Fields > Custom fields used for either Leads, Prospects or Opportunities that
exceeded the character limit were showing up as saved when there was no record found.
This was fixed.
 Dashboard > The YTD date filter was not working properly for the PTO widget. This was
fixed.
 Dashboard > The Project Status Widget would remove existing filters if the View By
option was changed from Budget to Contract Amount. This was fixed.
 Dashboard > The Staff Utilization widget would ignore Contract Employee type vendors.
This was fixed.
 General > The 'Accounting' main navigation link was not highlighted while on the
Reconciliations page. This was fixed.
 Global Search > In some instances, the "Recent Activities" results were displaying
duplicates. This was fixed.
 Manage Users > Core allowed the deletion of employees with entries submitted to them.
This was fixed.
 Opportunities > Creating a Project from an Opportunity using a Project Template would
result in a system error. This was fixed.
 Overtime Calculator > Overtime entries created by the OT Calculator did not inherit the
memo of the original entry. This was fixed.
 Projects > Project Name and Contract Amount columns were not properly being
exported in CSV files from the Projects list view. This was fixed.
 Projects > The Projects list view row count was not properly updating when phased
projects were expanded and then collapsed. This was fixed.
 Proposals > When deleting a Proposal that had a Note with an attachment, the
associated Note was getting deleted but the attachment was not. This was fixed.
 Proposals, Opportunities > The ability to quickly add a new opportunity from the Create
Proposal screen was not successfully creating the new Opportunity. This was fixed.
 Prospects > The tooltip was not working properly on the mapping step of importing
Prospects via CSV. This was fixed.















Prospects > When adding or editing a note for a Prospect's contact, the Created By
column was incorrectly allowing users to specify the note's creator from a wrong list of
options. This was fixed.
PTO > Updating an existing paid time off request would incorrectly update the
"Requested on" date to the current date. This was fixed.
Purchase Orders > Purchase Orders created from Budgets would use the Bill rate of
service items and not the Cost rate. This was fixed.
Recurring Bills, Invoices > The system was not able to create new bills and Invoices if one
or more of the recurring schedules were assigned to a Project or used line items of a
Project that had been marked as Completed. This was fixed.
Reports > The Employee Realization Rate report drill down feature would crash when
any filter was applied. This was fixed.
Reports > The "Contract Analysis" report would not show the Project ID and not follow
the Project Display As global setting. This was fixed.
Reports > The Employee Performance report was not reflecting the entries that are
marked directly as billed in the realization rate column. This was fixed.
Vendor Bills > Custom fields that are configured to show up in the Bills list view were not
showing up. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes

VERSION 1.1.153 RELEASED ON MAY 1, 2021
What’s new in this version?
Google Calendar Integration
CORE is proud to announce an integration with Google Calendar. Users will be able to pick and
choose which Google Calendars to sync with Core’s calendar module. Users will be able to add,
edit and delete Google Calendar events directly from the Calendar interface. Additionally, users
can create Time Entries from Google Calendar events directly from the Calendar view.

Enhanced Global Search
CORE’s Global Search feature has been enhanced to improve the overall performance and result
quality. Users now have the option to also search for keywords in Notes, Memos and also
include Custom Fields in the search. The search engine has been improved to also list the recent
activities performed within Core.
Sales Forecasting
CORE has added a new Sales Forecasting module as part of the CRM subscription. Users will
now be able to track their forecasted sales in a monthly, quarterly or yearly view. Forecasted
sales figures can be grouped by either Resource or Prospect and can be pivoted to show a
distributed or summarized list.
Advanced CSV Import
This update adds the CSV Import feature to General Journals. We have also made powerful
additions to the import experience like allowing users to save field mappings and to upload
Contacts during Lead or Prospect imports. Additionally, users will have the option to upload
Contact records directly from the Prospect Contacts tab.

Purchase Tax for Services
This update adds the Purchase Tax attribute to Vendor Bill service line items to ensure proper
accounting for all Purchase taxes paid for vendor services.

Other Improvements:
 Allocation & Forecasting > The Manual View in the Forecasting module has been
optimized for improved performance.
 Benefits > Benefit label was changed to "Benefit Period Units" to better describe the
purpose of the field.
 Bill Payments > When creating a new Bill Payment, users now have the option to select
an individual Payee or a range of Payees.
 CRM > The list of the navigation items under Sales Tools have been reordered.
 Dashboard > The Project Manager filter was added for the Employee Allocation, Project
Allocation, Project Allocation by Activity, and Task Allocation widgets.
 Dashboard > The Principal and Originator filters have been added to Project Widgets.
 ePayments > The labels in the Statement Payment page have been updated to better
suit the purpose of the link.
 Projects > A tooltip was added to the Use Custom Budget checkbox in the Project details
screen to better explain what this setting is and how this setting works.
 Projects > Project Name was added as a separate optional column in the Projects list
view.




























Projects > Projects can now be created from an existing Budget. This creation can be
initiated from the Budgets list view row actions menu or from the Budget details Actions
menu.
Projects > The Expand/Collapse Sub-Projects action has been enhanced to work with
filters also.
Projects > When exploring the details of a Phase, users can now navigate to any phase in
the Project Hierarchy using the drop-down navigation.
Projects > When working on a percent complete contract type, users will now be
prompted if they change the contract amount used to create their Billing Schedule to
confirm the changes throughout.
Projects > Core has added the ability to batch update Projects for default Invoice
templates.
Prospects > The "Assigned To" smart field has been added to the Prospect email screen.
Reconciliation > Core is now hard coding the Check NO/REF No for Check as
“*SVCCHRG*” that is created against Bank service charges during Account Reconciliation.
Reconciliations > The 'Cancel' button label in the Reconciliation screen was changed to a
'Continue Later' to better clarify that those changes will be saved and users can resume
where they left off.
Reports > A new CRM report has been added to track Distributed Sales Forecast.
Reports > A new CRM report has been added to track Summarized Sales Forecast.
Reports > More filter options have been added to the Billing Analysis report.
Additionally, the report layout has been updated to improve readability.
Reports > More filter options have been added to the Billing Forecast report.
Additionally, the report layout has been updated to improve readability.
Reports > More filter options have been added to the Billing Schedules report.
Additionally, the report layout has been updated to improve readability.
Reports > More filter options have been added to the Historical Billing report.
Additionally, the report layout has been updated to improve readability.
Reports > More filter options have been added to the Invoice Reconciliation report.
Additionally, the report layout has been updated to improve readability.
Reports > More filter options have been added to the Overdue Invoices report.
Additionally, the report layout has been updated to improve readability.
Reports > More filter options have been added to the Retainer Reconciliation report.
Additionally, the report layout has been updated to improve readability.
Reports > More filter options have been added to the WIP with AR report. Additionally,
the report layout has been updated to improve readability.
Reports > More filter options have been added to the Work in Progress Details report.
Additionally, the report layout has been updated to improve readability.
Reports > More filter options have been added to the Yearly Billing Cross Tab report.
Additionally, the report layout has been updated to improve readability.
Reports > The ability to filter by class was added to four balance sheet reports: Balance
Sheet Accrual Basis, Balance Sheet by Class Accrual Basis, Balance Sheet by Class Cash
Basis, and Balance Sheet Cash Basis.
Reports > The Aged WIP with AR report layout has been updated to improve readability.












Reports > The Class filter has been added to most of the Profit and Loss reports.
Reports > Payee and Transaction Type columns have been added to the Cloud Feeds
report.
Reports > The Principal and Originator filters have been added to Project Reports.
Reports > The Project List report can now be grouped by Project Group.
Reports > The Project Manager filter has been added to the Time Details report.
Reviewer > A new security setting has been added that will allow admin users to control
user access to filters in Reviewer.
Time and Expense > The batch update process in the Time Entries, Expense Entries, and
Time & Expense Reviewer screens has been optimized to allow updating up to 5000
records in seconds. Workflow status updates will be processed in background.
User Preferences > An option to be notified when a proposal has been submitted for
approval has been added.
Vendor Bills > Core will now automatically update the time and expense entries to match
an updated Vendor Bill date if they were assigned the same date earlier.

Other fixes:
 Batch Invoices > In some scenarios, when batch updating custom fields from the Batch
Invoicing workflow, Core would incorrectly reset other custom field values. This was
fixed.
 Bill Payments > When clicking "Save & Add Another" after editing a Bill Payment, the
Payee dropdown in the modal should not allow you to quick add. This was fixed.
 Billing Schedule > Schedules that were configured as negative service amount would
cause the Expense portion of the Invoices to be processed as negative. This was fixed.
 Budgets > When filtering the Budgets list for amounts that were equal to a specified
Budgeted Profit Amount, the filter did not work if a budget only had a miscellaneous
amount entered or no service amounts entered. This was fixed.
 Checks > Users were allowed to enter a negative value for Purchase Tax. This was fixed.
 Client > Performance tab charts would take a long time to render in certain situations.
This was fixed.
 Client > The Profitability widget in the Performance tab was not including Time and
Expense entries that had been manually marked as billed. This was corrected.
 CRM > Emails that were synced from the Outlook integration were not displaying
correctly when dark mode was turned on. This was fixed.
 Custom Fields > In some scenarios, when existing Custom Fields were deleted from a
module, Core would hide all records from the affected module's list view screen. This was
fixed.
 Dashboard> The Gross Margin widget was not including data from Projects whose
managers were set as inactive. This was corrected.
 Dashboard > The Gross Margin widget was not including Time and Expense entries that
had been manually marked as billed. This was corrected.



ePayments > Some DesignPay payment platform users had duplicate payment records
show up in CORE when they received a Credit Card payment. This was fixed.



























ePayments > Terminated or inactive users received emails and notifications for online
payments for any invoices they created when they were active. This was fixed.
ePayments > When composing an ePayments Statement email, the credit card and ACH
icons were both displayed instead of conditionally being displayed based on the type of
ePayments account set up. This was fixed.
ePayments > An issue with one of BQE’s payment partners was causing the payment
status to show up as ejected even after the ePayment was processed successfully. This
was fixed.
ePayments > When sending receipt emails for a successful email to the Client, Core
would show the other recipients of the emails as well. This was corrected.
General > The currency symbol was changed from KSH to S when refreshing the pages
for Kenya regional settings. This was fixed.
General > The incorrect date format was being displayed for Australian regional settings.
This was fixed.
General > When doing a text search in the filter panel, using the Select All checkbox
option would select all options instead of just selecting the shortened list based on the
text search. This was fixed.
Integrations > Office 365 emails are now automatically synced once every hour during
active use of the CRM Leads and Prospect screens.
Invoice Collections > The note date for an invoice when updated in an Invoice’s detail
view would not show up correctly in the Collection view. This was fixed.
Invoices > When downloading an invoice as a PDF from the row actions menu, the Hours
column was missing. This was fixed.
Payments > Core would incorrectly display the "Create Payment" option for Invoices that
had ePayments scheduled. This was corrected.
Payments > When creating a new payment for a client then clicking 'Save & Add
Another', the Add Payment modal allowed you to choose projects that weren’t
associated with the selected client. This was fixed.
Project > Updating ePayment profiles would not update correctly if the batch size was
more than 300 records. This was fixed.
Projects > If a project is assigned to 2 groups and the Projects list filter was set to include
both of these groups, the project record would display twice in the list. This was fixed.
Projects > In the Assignments tab of Project details, users were unable to clear the
search text box in the Add New dialog when trying to add a new contact or team
member. This was fixed.
Projects > When cloning a project, the character limit for the Project ID was not enforced
in the Clone Project modal. This was fixed.
Projects > When selecting a parent project in the Projects list view, not all phases would
get selected all the time. This was fixed.
Projects > When deselecting the 'Use Custom Budget' checkbox in a parent project, any
regular budget selected for one of that project's phases was being erased. This was fixed.
Reconciliations > We have streamlined the Resume Reconciliation user experience.
Reports > For security purposes, the ePayments report has been removed from the Time
& Expense and HR administrator subscription packages.















Reports > The Billing Details report has been updated to reflect proper calculations.
Services WIP, Expenses WIP, Proposed Net Bill are now updated to only factor in the
values of billable entries. Cost, Bill Amount, Services WIP, Expenses WIP, Proposed Net
Bill are now updated to round each entry to 2 decimals
Reports > The Profit and Loss YTD Comparison Accrual Basis report was displaying the
wrong currency symbol in the Gross Profit and Net Ordinary Income rows. This was fixed.
Reports > Exporting the Gross Margin Real Time report to CSV would produce
duplication of records. This was fixed.
Reports > Memorized reports would bypass security restrictions if shared with other
users. This was fixed.
Review Templates > Deleting a question type from the Question Types list screen and a
review template from the Review Templates list screen would cause the search box at the
top of each list screen to disappear until the tab was opened again. This was fixed.
Reviewer > Sorting by "Last Action By" would cause unexpected results to show up in the
Time & Expense Reviewer screen. This was fixed.
Security > The column widths of the Security Profile Reports tab table were not properly
distributed. This was fixed.
Time Card > Sorting by the L-Code column in the Time Card would cause all the time
entries already entered to disappear. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes

VERSION 1.1.152 RELEASED ON MARCH 6, 2021
What’s new in this version?
This update addressed several issues and added many highly requested features. Most notable:
Statement Payments | ePayments
Core now allows users to set up electronic payments for Client Statements.
Office 365 Email Integration | CRM
Core is extending its Office 365 integration to CRM emails. Users will now be able to sync email
communications with their CRM contacts directly to Core and also use their Office 365 account
to send out emails.

Project Budgets Enhancements | Project Management
Project Budgets have been improved to allow direct access from Project’s detail view. Users can
now manage Project and phase budgets in one unified interface and also have the ability to
create custom budgets for Projects or their phases.
HR Benefits with roll over rules | HR
HR administrators now have more control around how employees can earn benefits. These
newly added attributes will allow HR administrators to specify a benefit's maximum accrual
amount, maximum carry amount, reset date, and earning rules.
In-App Referral Program | Subscriptions
Core is proud to introduce a Referral Program for our existing users. Referring colleagues can
earn them a free demo of Core so that our team can explain how Core can be the best solution
for their business’s needs. Existing users can access their referral link from within the web and
mobile applications.

Other Improvements:











Assignments > An option was added in the Assignments screen so that users can now
easily copy assignments from a project's associated budget.
Assignments > The experience for copying assignments from parent projects to any subphase was simplified.
Checks > A new template has been added to allow checks to print in the VoucherCheck- Voucher format.
Client Contacts > The Quick Search feature was added to filter a client’s contact list
based on a search keyword.
CRM > Time Entries can now be created directly from CRM To-Dos and Follow-Ups.
CRM Email Templates> Browser right click was being prevented. This was fixed.
CRM > Added the "Cost Rate" column to the Quote Templates list view screen.
Dashboard > The Privacy Options field was renamed as Sharing Options to better reflect
the changes this setting can make to a dashboard.
Emails > The email notifying employees about an upcoming employee review date was
reformatted.
ePayments > A new Global Setting has been added to let administrators control if the
biller, project manager or administrator should get ePayment notifications.



























Expense Entries > Expense Entry charge amounts can now be calculated directly within
the entry cell. In-cell calculations support basic math operations including addition,
subtraction, multiplication and division.
Expense Entries > Paid Date was added as an optional column in the Expense Entries
screen.
Follow-Ups > The CRM Follow-Ups list view screen can now be exported as a CSV file.
General > More optional columns have been added to list view screens throughout Core.
Global Settings > A User Interface option has been added to hide the Copyright on
standard Invoices and Reports.
Groups > The Quick Search feature was added to the list within the Groups detail page.
Invoice Templates > Invoice Templates can now be Batch Updated from the Projects list
view screen.
Invoices > Purchase Order Number was added as an optional column in the Invoices list
view screen.
Invoices > The Email Recipients column was added to the Invoice list screen.
Leads, Prospects > Name and Company have been added as optional columns to the
CRM Leads and Prospects list view screens.
Leads > In the Emails tab of a Lead's detail page, the email statuses are displayed using
descriptive icons instead of text.
Manual Invoices > Batch action "Delete" was renamed to "Exclude" when the Invoice was
based on Approved Time and Expense.
Opportunities > Project Budgets created from Opportunities marked as Won will now
add the same Fee Schedule that was attached to the Quote.
Project Templates > When creating a new Project using a Project Template, users now
have the option to copy the Project Groups from the template.
Projects > Budget and Contract analysis reports can now be launched from the Structure
tab of a Project's details.
QuickBooks integration > QuickBooks sync logs can now be downloaded as a CSV file.
Report Center > The Report name column has been expanded to fit all report names
without truncating.
Reports > A Select All option has been added to the filter drop downs in the Report
Center.
Reports > An option has been added to the Unpaid Vendor Bills report to show only
those records linked to an Invoice.
Reports > The Billed Time and Expenses report has been updated to make it easier to
read and understand.
Reports > The Budget Comparison by Phase report has been updated to make it easier
to read and understand.
Reports > The Cash Receipts Journal report has been updated to make it easier to read
and understand.
Reports > The Paid Time and Expenses report has been updated to make it easier to
read and understand.
Reports > The Statement by Client (Accountant) report PDF document map has been
updated to separate out each Client.








Reports > The subtotals on the AR Aging with Retainage report have been updated to
include more column subtotals.
Reports > The Privacy Options field was renamed as Sharing Options to better reflect the
changes this setting can make to a memorized report.
Retainers > When creating a Retainer, Legal users will now be able to denote if the
Retainer is for a Trust Fund.
Time Entry, Expense Entry, Reviewer > Batch Update function updated to process
Business logic rules and can support batch size of 5,000 entries
Time Card > Users can now expand the text box field when adding a memo to a time
entry from the Time Card.
To-dos > When a Project related To-Do is marked complete, users will now have the
option to disable the dialog that asks if they would like to create a Time Entry for that
To-Do. This option can be reset from User Preferences.

Other fixes:
















Budgets, Estimates > The default width of the ID column was very narrow and needed to
be increased. This was fixed.
Clients > The Append Memo to Top or Bottom options were not working in the Client
list view Batch Actions. This was fixed.
Cloud Feeds > Some Cloud Feed transaction records were not downloaded if they had
long description fields. This was fixed.
CRM > The CRM Follow-Up badge count on all CRM list views was incorrectly including
Inactive, Hold and Complete records. The badge count was fixed to only include Active
or Incomplete Follow-ups.
CRM > When creating a time entry from a to-do item that's marked 100% complete, the
Employee field is not pre-filled with the Assigned To value in the prompt. This was fixed.
CRM > No Sales Goal assigned notification was received if a Goal was assigned to an
Employee Group. This was fixed.
Dashboard > The Hours widget was not including data for Vendors. This was fixed.
Dashboard > PTO widget had an issue related to "All Dates" filter. This was fixed.
Employee Control > Selecting the checkbox next to an employee's name in the Copy
Assignments pop up of the Employee Control screen would not check the box associated
with the correct employee. This was fixed.
ePayments > When creating a new Core ePayments profile for a service provider that
was already connected, users were still being asked to create a new account. This was
fixed.
Forms > The actions menu when viewing a form was hidden behind the file preview. This
was fixed.
Fund Transfers > When a user applied the Account filter to the Fund Transfers list view
and then launched the Fund Transfers report from this screen, the report did not honor
the applied filter. This was fixed.

























General > In some instances throughout Core, duplicate filters were incorrectly being
applied to list view screens. This was fixed.
General > Some color enhancements have been made to the Dark Mode theme to make
it easier to view.
Forms > HR Forms could not be uploaded to Core from the Resource Library. This was
fixed.
Integrations > Core would apply Project MST/MET on Invoices that were imported from
QBO even when they had a Tax line with this amount already present. This was fixed.
Integrations > Bills created in QBO; Ireland region were fetching amounts that included
VAT. This was fixed.
Integrations > Office 365/Outlook Calendar sync would not show for the Time Expense
subscription users. This was fixed.
Payments > UI glitch would sometimes cause users to enter the same payment twice.
This was fixed.
Projects > The Class range filter was not working in the Projects list view. This was fixed.
Projects > When merging Project records from the Projects list view, the confirmation
dialog was displaying the incorrect number of records to be merged. This was fixed.
Projects > Quick search would not work for dropdown type custom fields. This was fixed.
Purchase Orders > When emailing a Purchase order, the Project smart field was not
getting filled. This was fixed.
Quote Templates > Resizing the newly added Cost Rate column would cause an error
that prevented users from sorting the list by this column. This was fixed.
Recurring Transactions > Core would incorrectly stop processing recurring transactions
after the 24th instance. This was fixed.
Reports > The Bill Status filter was incorrectly added to the Billing Details report. This was
fixed.
Reports > When users included the main taxes in their Project contract amounts, Core
wasn't storing values to calculate the contract balance properly. This was fixed.
Reports > Trial Balance Cash Basis report would show NSF Payments as positive
amounts. This was fixed.
Reports > The Client List report was not showing the country in the Address column if
the attribute existed for each record. This was fixed.
Time Entries > The Start Time and Stop Time fields on the Time Entry detailed view did
not show proper time values in their respective drop-down menus. This was fixed.
Time Entries> When updating a batch of entries for Project, the relevant Class was not
being inherited. This was fixed.
To-Dos > To-Dos associated with deleted Projects were not also being deleted. This was
updated.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes

VERSION 1.1.151 RELEASED ON JANUARY 2, 2021
What’s new in this version?
This update addressed several issues and added many highly requested features. Most notable:

Dark Mode Theme
The Dark mode theme is now available from User Preferences. The meticulously designed lighton-dark color scheme adds a new refreshing new look to CORE and also helps reduce eye strain.

Shared Dashboards
Dashboards have been enhanced to allow sharing them with groups, individual users or both.
Users can now also designate an owner for Dashboards.

Shared Memorized Reports
Memorized Reports have been enhanced to allow sharing them with groups, individual users or
both. Users can now also designate an owner for each Memorized Report.

Enhanced Project and Account Display options
We have redesigned the Project and Account display options in Global Settings. The new
changes include more options for combining individual components and a live preview to find
the best combination that works for you.

CORE Touch 2 Talk
The Call Support feature was enhanced with a numeric keypad to allow users to provide
interactive responses during the call. Other enhancements include enabling users to continue
using CORE without disconnecting the call and a new button to call BQE Sales.

Administrator Controls for 2-Factor Authentication
Admin users can now apply a uniform 2FA authentication policy for CORE users at their
company. Options include enforcing a mandatory opt-in for 2-FA for all or selected users as well
as staying informed about its compliance.

Project Structure Tab Enhancements
The Project Structure tab has been improved to display more information about a parent project
and its phases. Projects can now be seen in comparison with a project's associated budget or
contract amounts. Additionally, the columns of the project table have been categorized into 3
sections to better understand all the information being displayed.

Other Improvements:




















Allocation & Forecasting > Users with a Time and Expense subscription can now update
the % Complete value for their allocations.
Batch Invoices > Users can now turn on custom field columns when reviewing Project
time and expense entries.
Batch Invoices > Users can now turn on Project and Client Retainer Available columns on
the batch billing screen.
Bill Payments> CORE now remembers the last Bank/Credit Card Account used for Bill
Payments for both of the supported payment methods.
Calendar > Hovering over an event in the calendar now gives users a preview of the
event's description.
Calendar > If you have connected your Office 365 account, you can now create new
calendar events in CORE and have them instantly sync to your Outlook Calendar.
Calendar > CORE now maintains a link between events and time entries created from
these events to prevent duplicates.
Client > Users can now enter longer company names for their clients.
Cloud Feeds > The “Included in Core” list has been updated to include cloud feed details,
date of matching and important attributes of the matched transaction.
Cloud Feeds > Users will now have an option to disconnect an account and not lose
existing matched transaction mappings if they choose to connect the account again.
CRM Emails > Users will now be able to track if an email has been read by the
recipient(s).
CRM Leads, Prospects > The Referred By attribute has been updated to display a prefilled list of existing contacts.
CRM Quotes > Cost Rate has been added as an optional column in the Services tab of a
Quote’s detail page.
CRM Quotes > Quote rates have been updated to reflect the rates from Fee Schedules.
CRM Quotes > Service and Expense line items can now be copied from an existing
Budget or Estimate.
Dashboard > Project and Resource filters have been added to all Allocation widgets.
Dashboard > The Project Profitability report is now accessible directly from the ‘Gross
Margin by Project’ Dashboard widget.
Emails > CORE email layouts have been updated to provide more useful information.
Emails > The workflow approval emails sent from CORE have been updated to allow
more room for Project names.




























ePayments > Company Owner and Administrator accounts will now be notified via email
when third party ePayment integrations are enabled.
Follow-Ups > The Follow-up list edit experience has been updated to make it consistent
with the rest of the application.
General > A Select/Un-Select All option has been added to all multi-select dropdown
menus in CORE.
General > New optional columns have been added to important screens like Project,
Client, Timers, Time entry, Expense entry, Expense Items, Project Templates, Budgets,
Estimates, Bill Payments and Reviewer based on top user requests.
Integrations > Specific Project rules have been bypassed while getting transaction data
like Time and Expense entries and Bills from Xero, QBO and MYOB to CORE.
Notes > The Notes list screen can now be filtered by Status. Additionally, the Status
column has been added to the Notes associated to other CORE records.
Notifications > Users now have the option to be notified when a Project has been
assigned to them.
Projects > A ‘Completed On’ field has been added to Project details. This field will only
become available when a Project has been marked Complete.
Projects > Project Assignments have been made easier with the added ability to add
assignments to or delete assignments from a parent project and its phases at the same
time.
Reports > Added ‘Unpaid Vendor Bills’: List of unpaid Vendor bills that have received AR
Payments. New Report
Reports > We have added a brand new 1099-NEC report that matches the latest
guidelines from IRS. 1099 MISC and 1096 MISC have also been updated with new
changes. New Report
Reports > ‘Financial Budgets Comparison by Class’ report has been added to the Report
Center. New Report
Reports > ‘Comp Time’ column has been added to the Employee Utilization report.
Reports > ‘Notes Category’ filter has been added to the Notes report.
Reports > ‘Reminder Date’ filter has been added to the Billing Schedules report.
Reports > ‘Tax Line number’ column has been added to the Chart of Accounts report.
Reports > An option has been added to the WIP Reconciliation report to view Time and
Expense separately or combined.
Reports > Balance Sheet reports now offer a summarized option for a condensed view
for Assets, Liabilities and Equity.
Reports > Labels have been appended to Retainer Invoice numbers on the ePayments
report to differentiate between normal and Retainer Invoices.
Reports > Memorized reports have been enhanced to include its unique name in the
footer of the report.
Reports > Profit and Loss reports now show a section for 'Net Ordinary Income'.
Reports > The Monthly Profit and Loss reports can now be filtered by Class.
Reports > The on-screen Reconciliation report has been updated to only show
transactions that are part of the current reconciliation.










Reports > The WIP Reconciliation report has been updated to exclude Projects that had
zeros across all column values.
Reports > Trust Fund has been added as an option for the Transaction Type filter on all
financial reports.
Reports > Users can now limit the 'Employee Missing Time' report to various Employee
and Vendor types.
Security > Administrator users can now set up separate security settings for Company
and Individual level integrations.
Subscriptions > Users can now send requests for subscription to admin accounts from
any screen that is not included in their CORE subscription.
User Preferences > Users now have an option to get reminded daily or weekly about
missing or incomplete time cards.
User Preferences > Users now have the option to turn off the Allocation summary
feature in the Time Card and Time Entries screen.
Vendors > The Vendor Transactions tab can now be filtered by Date period.

Other fixes:














Calendar > Time entries created from Calendar events were missing the Start and Stop
times. This was fixed.
Calendar > When creating a time entry from a calendar event, the time entry project field
was not being pre-filled using the event's project value. This was fixed.
Checks > The total record count was displaying 0 records when the Payee Name filter
was applied even if there were records in the list. This was fixed.
Checks > When editing the details of a Bill Payment Check, the “Back to Checks” link was
incorrectly being changed to “Back to Bill Payments” after clicking the Save & Done
button. This was fixed.
Checks > When trying to void a check used to pay a vendor bill whose bill number
exceeded 49 characters an error will occur. This was fixed.
Credit Cards > The Credit Cards exported file name was incorrectly downloading as
Credit Card Transactions. This was fixed.
CRM > The search bar in the Add & Modify dialog for Follow-Ups was not searching
against the Follow-up Type and Assigned To attributes of Follow-up records. This has
been fixed.
CRM Leads > If converting a Lead to a Prospect was delayed, the loading message was
not displaying. This was fixed.
CRM Lists > The Leads and Prospects SCORE values were not displayed in the order that
was configured in the Lists module. This was fixed.
CRM Opportunities > Adding a new Quote from the Quotes tab of an Opportunity
defaulted the quote date value to be blank instead of today's date. This was fixed.
CRM Opportunities > Recurring type Projects could not be created from the Create
Project dialog of the Opportunity screen. This was fixed.

























CRM Opportunities > When creating a new Project as an Opportunity is marked as Won,
the contract type field should default to be Hourly. This was fixed.
CRM Opportunities > When marking an Opportunity as Won, the Forecast amount
option in the modal only included the dollar amounts and excluded cent values. This was
fixed.
CRM Proposal Builder > After inserting a Quote and saving a Proposal, the ‘Remove’
action on the Quote was not working. This has been fixed.
CRM Proposal Builder > Right clicking to paste text into the Proposal Builder was not
working. This has been fixed.
CRM Prospects > When searching for a Prospect using the list view quick search and
opening the detail screen of a resulting record, returning to the list view by pressing
"Cancel" should retain the search keyword and results when coming back to the list view.
This was fixed.
CRM Quotes > Filtering the Quotes list view by a specific date included Quotes with no
quote date value in the resulting list. This was fixed.
CRM Resource Library > After a CRM user uploaded a document then modified the
description on the same file, they were incorrectly blocked from performing this action
stating the user did not have the right permissions. This was fixed.
Dashboard > The To-dos widget in the dashboard was missing the Assigned By filter.
This was fixed.
Dashboard > The To-dos widget was always displaying behavior that should have only
been shown on hover. This was fixed.
Deposits > The total records count was missing on the list view when applying filters.
This was fixed.
Emails > In some instances when users typed alphanumeric values in the To field of the
Compose Email module, the text was being cleared. This was fixed.
Emails > The Address Book in the Compose Email module had some text overflow UI
problems. These were fixed.
Follow-Ups > A red asterisk was missing for two required fields in the Add Follow-Up
modal. This was fixed.
Global Settings > Smart Fields were not being correctly populated in the Default
Message field within Email Settings. This was fixed.
Global Settings > Users were allowed to enter values into greyed out fields that should
have been disabled. These were fixed.
HR Reviews > When a user created a new Review and clicked save, the modal did not
immediately close which gave the impression the record was not created and often led
to creating duplicate entries. This was fixed.
Integrations > Invoice Amounts would not transfer correctly to QBO if the invoice was
generated using the Net Bill feature of Batch Invoice screen. This was fixed.
Invoices > Hourly Invoices for Phased Projects weren't handling the Retainer Summary
correctly. This has been fixed.
Invoices > Recurring Retainer Invoices were not inheriting the Online ePayment account
attribute when creating from an existing Retainer Invoice. This was fixed.
























Invoices > The 'Last Emailed On' field would not refresh by itself when an Invoice was
emailed. This was fixed.
Invoices > Workflow notes were being truncated when viewed from the Workflow
History section of an Invoice’s detail page. This was fixed.
Opportunities > Batch Update actions performed on Opportunities were creating
duplicate entries in the record history. This was fixed.
Opportunities > Projects that are linked to an existing Opportunity could be deleted. This
was fixed.
Project > Cloning a Project would not copy the allocation dependencies in the source
Project's allocations. This was fixed.
Projects > The Assign Groups modal in a Project's detail page was not properly sorting
the list of groups that can be selected. This was fixed.
Projects > The Assign Groups modal when editing a project's details was not sized
properly. This was fixed.
Projects > When deleting a rule assignment, the wrong text was displaying in the fading
confirmation message. This was fixed.
Prospects > In a Prospect's detail page, the tooltip message was not displaying the
message for the Display As field. This was fixed.
Prospects > In the notes tab of a Prospect's detail page, changing the category in the
"Show" dropdown would change the time stamp for existing notes. This was fixed.
Reports > A few important filters were missing from the ePayment Details report. This
was fixed.
Reports > Custom field filters were not working for CRM reports. This was fixed.
Reports > In some cases, Payment Amount was shown in the Processing Charges
Recovered column on the ePayments report. This was fixed.
Reports > New credit card payments were showing a status of none in the ePayments
report. This was fixed.
Reports > The Billing Details report was producing an unnecessary page with no
information as the last page. This was fixed.
Reports > The column headers were only appearing on the first page of the AR Aging
with Credit Payments report. This has been updated.
Reports > The Employee Details report would not show the 2nd address line. This was
fixed.
Reports > The Employee Performance report date was not following regional settings.
This was fixed.
Reports > The Notes report was displaying all dates in the US format instead of honoring
regional settings. This was fixed.
Reports > The Notes report was not properly fetching the date values for system
generated Notes associated with a Follow-up. This was fixed.
Reports > The Percentage Billed report was displaying a $ sign next to the percentage
values in the % Billed column. This was fixed.
Reports > The report column headers were not repeating across all pages for the Project
Time Entries report. This was fixed.














Reports > The Workflow Details report was not labeling the groups of items by the type
of module. This was fixed.
Reports > Various Time Reports were showing duplicate time entries if the Project was
assigned to multiple Groups. This was fixed.
Retainers > IOLTA accounts were not showing up as an option when performing a Batch
Update on Project Retainer Invoice. This was fixed.
Retainers > Some column header alignment issues were fixed on the Retainers screen.
Review Templates > When adding a question based on an existing question, the
Question Text column was too narrow to get a good sense of which question was being
selected. This was fixed.
Time & Expense Reviewer > The system filters were not being persisted on the Time &
Expense Reviewer screen if a user clicked into the details and clicked Back into the list
view. This was fixed.
Vendor Credits > Sorting by the AP Account column in the Vendor Credits list view was
not working properly. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes

VERSION 1.1.150 RELEASED ON NOVEMBER 15, 2020
What’s new in this version?
This update addressed several issues and added many highly requested features. Most notable:

AffiniPay ePayment Integration
Core now integrates with AffiniPay and its affiliate payment platforms to offer online payments
for Invoices and Retainers. The industry specific appeal of LawPay, DesignPay and CPA Charge
make these a natural fit for Core’s users. Our LawPay integration is designed to handle Trust
Fund accounting while keeping it compliant with ABA and IOLTA guidelines. Our integration will
support both Credit Cards and ACH payment methods and also allow users to set up scheduled
and partial payment as options for their Clients.

Office 365 Calendar Integration

Core users can now integrate their existing Office 365 calendars to Core's calendar module. Our
integration will support any Microsoft Cloud account that connects with the Office 365 Calendar.
Users get to choose which of their Outlook Calendars will show in Core’s Calendar. Outlook
events can be assigned Projects and event attendees in Core and can also be converted to a
Time Entry. Core will always maintain a real time sync to avoid any conflicts.

Multi-Period Time Card
Core's popular Time Card screen has been enhanced to handle multiple time periods including
Bi-Weekly, Semi-Monthly and Monthly intervals. Time Entry users can now view, edit, and submit
multiple weeks’ worth of entries directly from the Time Card. Similarly, Managers can now
approve multiple weeks’ worth of entries. Users will also be allowed to use the “Copy To” and
“Copy From” feature in the Weekly and Bi-Weekly periods.

Automatic Refresh for Core Cloud Feed Transactions
Core Cloud Feeds have been automated to ensure you are up-to-date with all available
transactions from your connected bank or credit card accounts. Syncing your existing bank and
credit card transactions to Core has never been easier!
Call Support Button
BQE's customer support department can now be contacted directly from Core. Core has
introduced a new “Call Support” button in the top navigation that works as a direct connection
to our support department - making it easier than ever to contact us whenever you need help
navigating through Core!

Other Improvements:









Budgets > Project details have been added to the Budget details General tab to make it
easier to track the associated project.
Budgets & Estimates > Budgets and Estimates can now be downloaded as a PDF directly
from their respective list view screens. This option has been added as a row action for
each record.
Budgets & Estimates > The Review/Approve/Reject buttons in Manager workflow emails
have been expanded to include Budgets and Estimates.
Cloud Feeds > Core Cloud Feed CSV import has been updated to automate the CSV
column mapping process. Core will automatically map the required fields with the CSV
columns in the file based on the columns that had previously been mapped.
Cloud Feeds > Core Cloud Feeds have been enhanced to handle Batch Add for up to 100
records at a time. Previously, users were constrained to a 25-record limit for Batch Add.
Cloud Feeds > Core Cloud Feeds have been updated to automatically fill the transaction
memo line when matching records.


























Credit Memos > Credit Memos can now be emailed directly from their list view. This has
been added as a row action option for each record.
CRM > A column chooser was added to the Follow-Ups modal so that Priority and Status
can be used as optional columns.
Dashboard > A new widget has been added to allow users to track and update the status
of RFIs directly from their Dashboard.
Dashboard > A new widget has been added to allow users to track and update the status
of Submittals directly from their Dashboard.
ePayment > We now allow partial payments for ACH methods.
ePayments> Payment portal page has been updated to show payment history of
previous online payments.
ePayments > Core's existing Stripe ACH integration flows have been updated to make
the sign-up flow more intuitive.
ePayments > The project manager and biller will now receive email notifications when a
Client's ACH payment has been successfully processed.
ePayments > The project manager and biller will now receive email notifications when a
Client's credit card payment has been successfully initiated.
General > All Core list view screens have been enhanced to show the total number of
records in the header section.
General > Core drop downs have been updated to automatically select all text to make it
easier to delete the entire text in case you want to make a different selection.
General > Custom fields can now be added to Core list view screens as optional columns.
Users can elect to add up to three existing custom fields in all the major screens
including Time and Expense entry screens.
General > Progressive scrolling improvements have been implemented in all Core list
view screens.
HR > Print preview has been added as a row action for Employee Reviews.
Invoices, Payments, Retainers, Credit Memos, Invoice Collections, Purchase Orders,
Vendor Bills > These entities can now be downloaded as a PDF directly from their
respective list view screens. This option has been added as a row action for each record.
Leads > A Documents tab has been added to Leads details that will allow uploading files
to a Lead record.
Leads > The Referred By field can now be populated using your existing list of Clients,
Contacts Employees and Vendors.
Leads > When converting a Lead into a Prospect, users will now have the option to also
include any Documents attached to that Lead record.
Opportunities > Priority was added as an optional column to the Opportunities list view
screen.
Opportunities > Projects can now be created for Opportunities that have not been
marked as Won yet. This will allow users to track Time and Expense against the
Opportunity-linked Project.
Projects > Parent Project Assignments can now be copied to sub-phases from the
Assignments tab in Project details.




























Projects > When adding a phase to a Project, the Principal field of the phase is now
automatically populated using the Principal from the parent project.
Proposals > The list of accessible Core Smart Fields in the Proposal Builder has been
expanded to include the following: Current Date, Current Time, Current Date Time, and
Quote ID.
Prospects > Prospects and Contacts can now be imported via CSV upload from the
Prospects list view screen.
Prospects & Leads > An Attachments indicator column has been added in the Emails tab.
Prospects > Users can now search Prospects by their Contacts’ names.
Quotes > When creating a Quote, users can now use Activity or Expense Groups rather
than just individual line items.
Reports > A Cleared status filter has been added to the Check Details report.
Reports > A Project Manager filter has been added for the Project Allocation Earned
Revenue Distributed Forecast report.
Reports > An ePayments Details report has been added. This report will help outline
transaction details for companies accepting ePayments.
Reports > The Annual, Quarterly and Monthly Financial Budget vs Actual reports can now
be accessed from the Report Center.
Reports > The AR Reconciliation report can now be grouped by Client, Project, Master
Project, Project Manager, Principal and Contract Type.
Reports > The Benefit Assignment report has been updated to include a Value column
for Fixed type benefits.
Reports > The Cash Receipt YTD Comparison report has been updated to allow grouping
by Client, Project, Master Project, Project Manager, Principal or Contract Type.
Additionally, this report now has the ability to hide phases.
Reports > The Employee Profitability report has been updated to include an option to
hide Expenses.
Reports > The following Budget reports have been re-designed to improve their
readability: Budget Comparison by Employee, Budget Comparison by Phase, Budget
Comparison Summary, Budget Comparison and Budget Details.
Reports > The following reports have been re-designed to improve their readability:
Account Transactions, AR Reconciliation, Contract Analysis, Employee Expense, Gross
Margin, Time Verification, WIP Reconciliation and Work in Hand.
Reports > The Invoice Reconciliation report can now be grouped by Master Project or
Project.
Reports > The Percentage Billed report now has the option to hide phases when
grouping it by Master Project.
Reports > The Project Profitability report has been updated to make it easier to read and
understand.
Reports > The Proposals, Quotes, Contacts and Opportunities reports can now be
filtered using Tags.
Reports > The Work In Hand report has been updated to make it easier to read and
understand.
Reports > The Work in Progress report has been updated to increase its readability.












Reports> We have extended the address book feature to Report Viewer emails.
RFIs, Submittals, Drawings > The ability to batch update records has been added for RFIs,
Submittals, and Drawings list view screens.
Scheduled Reports > Scheduled reports can now be sent in either PDF, CSV, Excel or
Word format.
Settings > An extra time entry security setting was added so that administrators can
decide which employees are allowed to update actual hours for other employees.
Time & Expense Reviewer > Overtime was added as an optional column to let users
know which time entries were marked as overtime.
Time & Expense Reviewer > As part of the Batch Mark Billed process, we have updated
the information listed in the drop-down menu to include Billing Period.
Time Entries & Expense Entries> Users can now select up to 3 custom fields to be
included in these rapid entry screens.
Vendors > The Transactions tab under Vendor details can now be filtered by Credit Card
transactions.
Workflow > Users can perform workflow actions for all selected records by using "Select
All" in Time entry, Expense Entry and Reviewer.
Workflow > Core will now present users with a summarized view of the entries before
confirming batch approvals or rejections.



Other Fixes:











Allocation & Forecasting > Hours were lost in the Forecasting screen Smart View when
two or more Allocations were made against the same Resource for the same time frame
as the weekly Forecasting view. This was fixed.
Budgets, Estimates > The memo added when a Budget or Estimate is approved was not
properly displayed in the Workflow History section of the respective details screen. This
was fixed.
Cloud Feeds > After scrolling to the bottom of all Ignored Transactions under a Cloud
Feed account, clicking on the Select All checkbox would not select records at the top of
the list. This has been fixed.
CRM > When viewing the details of notes accessed from CRM list views, there was an
alignment issue for the Add Documents link. This was fixed.
CRM Lists > Exporting the list of Scores as a CSV file excluded the Active column. This
was fixed.
Documents > Viewing the associated entry for a chart of accounts document from the
Documents list view resulted in an error. This was fixed.
Follow-Ups > The CRM Type dropdown at the top of the Follow-Ups screen did not have
a label. This was fixed.


























General > Filter chips on list views were not applying any custom labels defined from
global settings. This was fixed
General Journal > When a new general journal entry was made using an existing entry
number, the confirmation prompt asking users if they would like to continue with this
duplicate entry number redirected them to the list view screen instead of keeping them
on the create screen. This was fixed.
HR > The Question Types list view and Add modal displayed alignment issues. This was
fixed.
HR Reviews > The review PDF would not open on its own and needed to be re-named
since it lacked an appropriate file extension. This was fixed.
HR Reviews > Core was incorrectly changing the status of the performance review to In
Progress when it was saved. This has been fixed.
Invoices > After searching for an Invoice using the list view text search, users could not
apply a Late Fee filter. This was fixed.
Messages > When composing a message, the column headers of the recipient field
dropdown lacked proper spacing. This was fixed.
Notifications > Previously, when clicking on Notifications that alerted of a scheduled
ACH payment, Core would redirect a user to the Payments screen although the payment
had not yet been settled. This was fixed.
Opportunities > Marking an Opportunity as Won from the Opportunities list view didn’t
update the Closed Date until the page was refreshed. This was fixed.
Opportunities > Mobile and contact hyperlinked numbers were incorrectly launching a
mail service wizard from within the Opportunities details. This has been fixed.
Opportunities > The Quotes tab of an opportunity's detail page was missing the ability
to delete a Quote from the list. This was fixed.
Opportunities > When batch updating records from the Opportunities list view, any
applied filters disappeared after the update was saved. This was fixed.
Payments > Creating a Payment for an Invoice that had Online Payments enabled and
was linked to a Vendor Bill would auto-fill the wrong date when a user was redirected to
the Create Bill Payments page. This was fixed.
Payments > When applying a new Payment in the Payments screen, Core was allowing
users to double click the Save & Done buttons and it was incorrectly creating duplicate
payments. This has been fixed.
Project Templates > When assigning Groups to either Team Members, Activity or
Expense Items, the pop-up modal would only load a maximum list of 25 Groups for each
category. This was fixed.
Projects > Adding a phase whose name includes parentheses caused a capitalization
error. This was fixed.
Proposals > After previewing a Proposal from the Proposals list screen, previewing any
other Proposal in the same screen would always show that first Proposal preview until
the page was refreshed. This was fixed.
Proposals > The Create from Scratch option only took users to the Create page if they
clicked on the words directly and did not include the rest of the button space. This was
fixed.



























Proposals > When adding a Smart Field in the Proposal Builder, the smart field
dropdown was incorrectly labeled. This was fixed.
Prospects > When sorting the Prospects list view by Prospect Score, an ellipse icon was
displayed instead of a caret. This was fixed.
Quotes > When using the quick search to find a record in the Quotes list view, the search
was not saved when returning to the list view from a Quote detail page. This was fixed.
Recurring Transactions > We have added several checks to pre-empt scenarios which
could lead to issues like duplicate processing of transactions etc. for recurring
transactions.
Reports > Group by Principal / Originator was not working on all AR Aging reports. This
was fixed.
Reports > The Ship To address was not properly formatted in the Purchase Order Invoice
report. This was fixed.
Reports > The Time and Expense report was not correctly filtering specific dates for users
outside of the U.S. This was fixed.
Reports > The Totals line for a project was not properly aligned in the Project Time
Entries report. This was fixed.
Resource Library > When uploading multiple items to the Resource Library, users were
not getting a Successful Update prompt when the operation was a success. This has
been fixed.
Sales Goals, Dashboard > Sales Goals were incorrectly allowed to have negative goal
amounts which would display inaccurate graphs on the Sales Goals Performance widget.
This was fixed.
Scheduled Reports > Few users had complained that they were not able to re-use group
names of Scheduled Reports they had previously deleted. This was fixed.
Scheduled Reports > When scheduling a Report using the Choose from Existing Group
option, the Subject line was not visible. This has been fixed.
Scheduled Reports > When updating an existing Scheduled Report, an error alert would
flash before the success message. This has been fixed.
Security > Previously, Time Expense security users could view other users' records using
the on-screen reports under the More drop-down. This has been fixed.
Time Card > When copying a week's worth of Time Card entries to a new week using the
custom date picker, the date picker would pick the incorrect start and end dates for the
week of the day that was selected. This was fixed.
Vendor Bills > Units were not properly updating when importing a Purchase Order into a
Vendor Bill. This has been fixed.
Vendor Bills > When setting up a daily recurring Vendor Bill with a fixed end date,
duplicate Vendor Bills were being created for dates outside of the end date. This was
fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes

VERSION 1.1.149 RELEASED ON SEPTEMBER 27, 2020
What’s new in this version?
This update addressed several issues and added many highly requested features. Most notable:

Stripe ACH Transfers
The power of ACH Transfers comes to Core. Stripe ACH Transfer option will allow you to
confidently share ACH payment enabled Invoices with your clients. Stripe ACH is backed with
instant bank verification from Plaid.com to ensure a smooth, hassle free money transfer. All of
this comes to Core customers at an incredibly low processing fee from Stripe. Getting paid on
time has never been easier in Core!
Cloud Feed CSV
Core Cloud Feeds have been enhanced to allow importing accounts and records via CSV files.
Users now have the ability to add new Accounts to Core without having to link their financial
institution. Additionally, Bank and Credit Card Transactions can now be imported for any
account. Our intuitive step-by-step wizard walks you through the import process so you can be
sure you import the appropriate records to Core.
Workflow Notification Emails
Workflow emails sent to Managers for review have been redesigned to increase their usability
and help streamline daily tasks. This enhancement will help automate how you manage your
employees’ submitted Time and Expenses, Invoices, Purchase Orders and Vendor Bills. Managers
can now initiate the approval or rejection of the submitted items from the email and be
redirected to the appropriate Core screen for confirmation. Managers can also review the details
of these entries before deciding to approve or reject them. Managing your Company’s various
workflows has never been easier in Core.
Transfer Retainers
Client and Project Retainers can now be easily transferred between Clients and Projects directly
from the Retainers screen. All the related adjustment entries will be automatically made in the

background and show up on retainer reports and screens. Managing your Client and Project
Retainers is now easier in Core.
Benefits Summary
We have introduced helpful controls and settings to allow your employees to better understand
their benefit summary. Employees can now choose to get a YTD summary of their assigned
benefits and also switch from Hours to Days view. HR admins can also set up a rounding option
for benefit calculations.
Custom Fields and Document Uploads for More Modules
The ability to create and use custom fields have been added for more modules in Core including
Purchase Orders, Vendor Bills, Payments, Credit Cards, Credit Memos, and Vendor Credits.
Create custom fields to track any value that Core does not already cover and is important to
keep track of for your business. Additionally, the ability to upload documents has been
expanded to more modules including Vendor Credits, Credit Memos, and the Company Profile.
Organize and keep track of all the relevant documents for a specific record in one place.
Report Center enhancements
Core's Report Center continues to be enhanced in this release. Reports filters can now be
toggled on and off to easily run a report with no filters without losing your saved configuration.
Additionally, Scheduled Reports can now be sent in either PDF or Excel format.

Other Improvements:











Benefits > A Global Settings option to configure how Human Resources Benefits data is
displayed has been added. The number of digits after the decimal point can now be set
for display whenever Benefits data is shown throughout Core.
Campaigns > An Email column was added for adding individuals in the Add Recipients
window of a campaign.
Cloud Feeds > Quick Refresh has been added as a Batch Action to the Cloud Feeds list
view.
CRM > Files stored in the Resource Library can now be emailed directly from the
Resource Library screen. Files can be sent individually via row action or as a group via
batch action.
CRM > Follow-Ups have been updated on the CRM master lists to allow review and
editing of all existing Follow-ups for a particular record.
CRM > Leads and Prospects details screens have been enhanced to show a history of all
changes made to a record. The log has important details like date and time of change,
who made the change and the value that was changed.
CRM > Users who have the right permissions, will now be allowed to delete Email history
from the CRM module.



























Dashboard > The Time Performance widget now displays the percentage of the selected
part of the doughnut chart.
Emails > Core has been enhanced to notify when an outgoing email bounced back. The
system notifications will alert you with the relevant details of the unsuccessful email.
ePayments > Users can now quickly access the Payment Portal link that is sent to your
Clients when ePayments are enabled. This can be accessed from within the Invoice
details screen. The link to the Payment Portal can also be easily copied from the details
screen.
ePayments> We are now sending email notifications to more internal users, like Project
Manager and Biller when an ePayment is processed successfully.
Expense Entries, Time Entries, Leads > Custom field values can now be displayed as
optional columns in the list view screens for Expenses, Time Entries, and Leads.
Follow-Ups > The Follow-Ups screen can now be quickly filtered to show All Follow-Ups
or just Follow-Ups for My Leads, My Prospects or My Opportunities.
Forecasting > All Forecasting screens now have a Project Status filter.
Forecasting > Filter options have been expanded in the various tabs to include Projects,
Item Status and Billable Status.
Forecasting> We are now persisting the headers when scrolling the list of Allocations.
General > Drop-downs with multiple columns are now resizable.
Integrations > A default tax code for Vendor Bills in QuickBooks online sync settings has
been added.
Integrations > Core Expenses can now be synced as Bills to Xero.
Integrations > Integrations with third party accounting software have been updated to
restrict syncing zero ($0) value phased Invoices from Core.
Leads > Lead Score was added as an optional column in the list view.
Leads > Leads can now be assigned to a Campaign and the list view screen can now be
filtered by Lead Source.
Opportunities > Users can now specify the Project Template they want to use at the
Opportunity level.
Opportunities > When converting an Opportunity to a Project, Core gives you the option
to bring over the project template phase structure as well as service and expense line
items used in the primary Quote.
Projects > Quick search now includes Project name and Phase description when
returning search results.
Proposals > The Proposal templates screen has been simplified to only show Name,
Description, and Status of each record.
Prospects > An Assigned To column was added to the Prospects list view screen so users
can sort and filter the list by this value.
Prospects > Emails sent to a Prospect can now be reviewed from within the Prospect
details Emails tab. Email attachments can also be reviewed.
Prospects > Prospects can now be assigned to Outside Consultants and Contract
Employees.
Prospects > The Lead Source Filter has been added to the Prospects list view.


























Prospects > When converting a Prospect into a Client, Contacts can now be included in
the conversion.
Reports > A Created By column has been added to the Quotes report.
Reports > All Profit and Loss reports have been enhanced to make them easier to read.
Reports > All Trial Balance reports have been enhanced to make them easier to read.
Reports > All Balance Sheet reports have been enhanced with an enhanced design to
improve layout and readability.
Reports > AR reports can now optionally display and filter by a project's Principal.
Reports > Leads, Prospects and other reports that show Leads and Prospects can now be
filtered by “Tags."
Reports > Saved filters on Reports can now be toggled on and off to easily run a report
with no filters without having to delete each one at a time.
Reports > The Billing Details report has been updated to simplify the header names.
Reports > The Budget Comparison report has been re-designed to include Services and
Expenses Grand Totals.
Reports > The Project Account Details report has been added to the Billing package.
Reports > The search feature in the Scheduled and Memorized reports tabs has been
expanded to now include matching results in Group Names.
Reports > The Transaction Details report can now be grouped by Payee.
Scheduled Reports > Scheduled reports can now be sent in either PDF or Excel format.
Statements > The Statements list view can now be filtered by Master Project.
Subscription> “Paid” watermark has been added to system receipts for Core subscription
purchases.
Time Entries > For Legal industry users, L-codes can now be batch updated from the
Time Entries screen.
Time Entries > For Legal industry users, L-codes is now included in the exported .csv file
of time entries.
Trust Fund Accounting > Core has been updated to restrict showing Trust Fund
transactions for Matters that have Trust Funds assigned to them.
Two-Factor Authentication > Answers to the security question were previously case
sensitive. Case sensitivity has been removed.
Two-Factor Authentication > This feature has been restricted to paid users only.
Two-Factor Authentication > Two-factor authentication users now have the ability to
disable their settings without completely clearing them. A separate option to clear all
settings has been added as well.
User Preferences > Users can now customize the number of hours used to consider
whether a Time Card is incomplete or not. This will trigger a reminder to fill it out.

Other Fixes:


Account Reconciliations > When switching between Accounts, the wrong Account was
being displayed in Account Drop Down. This has been fixed.
























Allocation & Forecasting > Gantt Chart chips moved in the opposite direction when
using the Project or Employee Task Bars for the first time. This has been fixed.
Chart of Accounts > The count of selected Accounts in the disclaimer of the batch delete
window does not include sub-accounts. This was fixed.
Chart of Accounts > The KPIs on the list view screen do not change based on any applied
filters. This was fixed.
Cloud Feeds> A specific scenario would cause feeds to duplicate on scrolling. This was
fixed.
Custom Fields > Custom fields added for Projects from the Custom Fields list screen are
not displayed in a Project's detail view in the order they were added. This was fixed.
Dashboard > Some icons in the Add Dashboard Widget modal of the dashboard were
not showing. This was fixed.
Dashboard > The default filter applied for the Hours widget was 12 weeks, but the graph
only displayed the last 4 months. This was fixed.
Dashboard > The Project Allocation widget incorrectly displayed a Project with phases
when any filter was applied. This was fixed.
Dashboard > The Project Status widget was not properly displaying projects with a due
date in the next month when applying a Due Date filter for next month. This was fixed.
Documents > The filter panel in the Documents list view did not correctly display the
applied "Created By" filter value. This was fixed.
Email > If an email address was manually typed into the address line and didn’t match
one of the existing autocomplete options, the email typed was erased. This was fixed.
Emails > After manually typing out an email address, clicking in the line to focus caused
the email address to disappear. This was fixed.
Emails > The Message label of an email's detail view was not placed in the right location.
This was fixed.
Emails > Using the backspace key to remove an email from the address key did not
successfully remove the email. This was fixed.
Emails > When emailing Statements, the compose email screen was not populating preset TO, CC or BCC values depending on what action was taken to launch this screen. This
has been fixed.
Financial Budgets > The page tab title did not match the page screen title. This was
fixed.
General > Custom labeling for projects of some industries did not persist in dropdowns.
This was fixed.
General> Users would no longer see the menu items if they clicked on an item they were
not subscribed to. This was corrected.
Global Settings > Custom labeling for vendors was not properly applied in the Edit
Vendor Credit page tab title. This was fixed.
Integrations > Core Integrations were not syncing correctly for a Standard user with any
Custom security profile other than the Full Access security profile. This was fixed.
Integrations > In some cases when manually entering a date into a date field of the Sync
Settings tab, the date picker functionality would be disabled. This was fixed.




Invoice Collections > The Email column in the list view screen was not displaying when
selected in the optional columns. This was fixed.
Invoice Collections > The Invoice Collections list view had issues sorting records by the
Terms column. This was fixed.
Leads > Previewing the attached file when viewing the details of an email sent to lead
was not working. This was fixed.
Leads, Prospects > When changing any field value that was not the Assigned To field, the
Assigned-On field value was erased. This was fixed.
Projects > Changing the default group assigned to a Project did not successfully save.
This was fixed.
Projects > When adding a phase to a multi-phased Project, the percentage complete
field was being incorrectly auto-filled in some cases. This was fixed.
PTO > The “Requested For” label was incorrectly duplicated in the add/edit PTO request
screen. This was fixed.
Reports > The Trust Fund Account Activity report was not displaying all purchase order
numbers when applying a purchase order number filter. This was fixed.
Reports > When a company's currency was set to “Euros”, the Time and Expenses by
Parent Project report incorrectly displayed amounts using US dollar signs. This was fixed.
Sales Goals > The page title and tab title did not match. This was fixed.
Time & Expense Reviewer > Sorting by the Type column did not sort the list correctly.
This was fixed.
Two-Factor Authentication > Some users were getting an error while sending the
verification code for two-factor authentication set up. This was fixed.
Updated report templates.
Updated help and other documentation.



Numerous other medium and minor level fixes














VERSION 1.1.148 RELEASED ON JULY 25, 2020
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:

2-Factor Authentication
We have added an extra layer of security that goes beyond a username and password. Users
now have an option to turn on 2 FA on their accounts and choose from text, voice call or email
as authentication options.
Toggle Filters
Filters on list view screens can now be toggled on and off. In case you want to review an
unfiltered list, you can simply disable your applied filters and turn them back on when needed.
This way, you spend less time constantly clearing then reapplying filters when trying to view a
list with varying parameters.
Improved Account Reconciliations
We have added a "Reconciliations" screen that is accessible from the main navigation to simplify
the path for reconciling accounts. Other improvements include easy to print summarized and
detailed reports and an option to print them immediately after finalizing a reconciliation.
Contact look up in Email
Emailing your clients, vendors or employees from Core has been made easier with automatic
contact lookup or select multiple recipients from an address book pop up. Users can now look
up any specific contact, including groups, using either a name or email. Email composition
retains the ability to add unlimited email recipients by entering an email address directly.

Create Time entries from Events
Users now have the added ability to create time entries directly from a calendar event. The
associated project and hourly duration are prefilled to simplify this time entry creation process.
Core Express Subscription Bundle
Core is proud to announce a new discounted pricing bundle for companies with up to 5 users.
Other improvements:



Account Reconciliation > Users will now have an option to generate a summarized or
detailed report after finalizing an account reconciliation.
Account Reconciliations > The account reconciliation experience has been improved to
better track large checks and deposits that correspond to multiple projects or vendor
payments.



























Account Reconciliations > Users can now run Reconciliation reports directly from the
Reconciliation screen.
Allocation & Forecasting > The Allocation & Forecasting view and widgets can now be
filtered by Principal and Originator.
Bill Payments > A column has been added for expense entry date to the details pop up
of employee reimbursables.
Chart of Accounts, Fund Transfers > Users can now upload documents for fund transfers
and individual accounts in the Chart of Accounts.
Chart of Accounts > Parent Account balance amounts now include balances for all of its
sub-accounts when the accounts are being displayed in a hierarchical manner.
Chart of Accounts > The Account type drop down in "Create New Account" now
conforms to an accountant friendly display order.
Checks > Checks can now be batch updated on the Checks list view screen.
Checks > The Bill Payment column has been added to the Checks list view to denote
checks used to pay bills.
Clients, Employees, Vendors, Prospects > Individual contacts listed in the Contacts tab
now have their own active status.
Cloud Feeds > We added a "Quick Refresh" action that allows users to refresh their
account without invoking the refresh UI.
* This action is available once every 24 hours and cannot be performed for accounts that
need MFA code or Captcha to perform a refresh.
Contacts > Contact Status has been added to the Contacts detail views throughout Core.
CRM > Attachments can now be added to Prospects, Opportunities and Quotes from
their respective list views.
CRM > Elaborate tooltips have been added throughout the CRM module.
CRM > Grand totals have been added to the Opportunity list view for Closed Amounts
CRM > Newly added CRM screens were missing record counts on list views. These
counts have been added.
Dashboard > The Staff Utilization widget was updated to display the total utilization
percentage for all employees.
Dashboard > The Staff Work Load widget will now roll up all allocation data to the
resource level.
Dashboard > The To-Do widget can now be filtered by Status.
Emails > Users can now specify recipients in the compose email screen using quick
search or address book pop up.
Emails > The file size allowed for email attachments has been increased to 10 MB.
Emails > Files can now be dragged and dropped anywhere on the compose Email screen
to attach the document.
Emails > Users will now be prompted when a subject line is not set for any outgoing
Email.
Employee Control > A column has been added to the Employee Control details to
differentiate Projects from Project Groups.
General > Custom fields are now supported for more modules like General Journal,
Checks, Chart of Accounts, Deposits, and Fund Transfers.

























General > The link to reorder the menu items of the side navigation was relocated to the
bottom of the navigation menu.
General > The logo by industry feature was further enhanced to provide separate logos
for Architectural and Engineering industries.
General > To improve the column resizing experience in the Time Entry and T&E
Reviewer screens, a suggested best fit option is provided.
Global Settings > 'Invoice Due Date' was added as a smart field option to insert in global
email settings.
Global Settings > Administrators can now configure the custom labels for CRM modules
including Leads, Prospects, Quotes, Proposals, Campaigns and Promotions.
Integrations > QuickBooks users can now send multiple Core employee expenses to the
same vendor bill in QuickBooks.
Integrations > Users can now include purchase tax amount when sending Vendor Bills to
AccountRight.
Invoices > A filter to display invoices with or without a discount has been added to the
Invoices screen.
Invoices > The invoice list view screen can now be filtered by Client Group and Project
Group.
Leads > When converting a lead into a prospect, users are given the option to transfer
any notes, to-dos, emails, and campaigns during the conversion.
Leads > The "Import from CSV" feature now allows users to specify mapping for more
fields.
Legal > "Expenses" will now be custom labeled "Costs" by default when a Core account is
created for a Legal industry client.
Notifications > Users will now be presented with more context like the name of the client
etc. when notifying them about successful processing of recurring transactions.
Opportunities > When creating an opportunity, the Forecast value now automatically
defaults to any amount already entered for the Opportunity Value.
Opportunities > The Quotes tab in an Opportunities detail view now has a field to
denote if a Quote Template is being used.
Projects > The ability to search the list view by Client, Manager, City, State, and custom
field values has been added.
Projects, Clients > Users can now specify the date range to filter transactions in the
Transactions tab of the detail view.
Projects > When creating a Project from a Project template, the Fee Schedule will also
get cloned to the new Project.
Projects > When creating an Invoice from a Project's opening balance, users will now be
presented with the details on successfully adding the transaction.
Proposals > Proposal Builder has been updated to limit inserting new quotes based on
existing Templates only.
Prospects > The email field is displayed by default when adding a new Prospect.
Purchase Orders > Users can now send multiple purchase orders as separate
attachments in one email.
Quotes > A Created By filter was added to the Quotes list view screen.


























Quotes > A "Created By" column was added to the Quotes list view screen.
Registers > The register account has been moved to the top of the screen for a better
user experience and overall consistency.
Reports > Project Start Date and Project Due Date filters were added to all Allocation &
Forecasting reports.
Reports > Users can now filter the Workflow Details report by specific employees.
Reports > A column with contact number has been added to the Follow-Ups report.
Reports > Next Week and Next Month have been added as date options for Allocation
Start and End Dates.
Reports > Security reports were missing the option to choose the output format. This
was added.
Reports > The Retainer Details by Project report now has the option to show or hide
Zero Balances.
Reports > The Sales Goal Performance and Sales Goal by Employee reports were
updated to handle employee groups.
Reports > The Work in Hand report now has the option to include or exclude Work in
Progress amounts in the contract balances.
Retainer Invoices > The retainer invoice message can now be edited or turned off in
global settings.
Scheduled Reports > Users now have the ability to control the subject line in scheduled
report emails.
Search > Global search has been updated to include CRM module results.
Security > As added security, users who use the Forgot Password to reset their password
will receive an email letting them know that the password has been updated.
Statements > Billing users can narrow down statement generation by using newly added
filters like Project groups and Client Groups.
Subscriptions > When an owner account logs into Core and the company has expired or
has subscriptions in grace days, they will be directed to the Manage Subscriptions
screen.
Time and Expense > Time, Expense and Reviewer list views can now be filtered by Invoice
Number.
Time Card > For legal industry users, the L-code column was added as an optional
column instead of always displaying it.
Time Card > Managers now have the ability to approve Time Entries directly from the
Time Card screen.
Time Card > We have enhanced the "Copy From" and "Copy To" functions and added
the total of logged hours in the destination or source week.
Time Entries > If a user had no privilege to approve entries, then these options have
been removed from the Time and Expense user.
User Preferences > Users can now set a reminder to check their incomplete time cards
from the previous week.
User Preferences > Users can now set CRM modules as the default screen when logging
into Core.






User Preferences > Users can now set HR modules as the default screen when logging
into Core.
Vendor Bills > The ability to batch update the date, reference number, term, due date,
and memo of selected vendor bills in batch was added.
Vendor Bills > Users can now see and edit the bill rate for each line item when creating
or editing a vendor bill.
Vendor Bills > The Project or Phase on a Vendor Bill can now be changed after it has
been paid.

Other fixes:


















Campaigns, Leads, Prospects > The date of a note is not consistent in the list view and
the detail view of a campaign, lead, or prospect. This was fixed.
Follow Ups > The batch update feature in the Follow Ups screen does not successfully
update the follow-up status from Inactive to Active. This was fixed.
Follow Ups > When clicking an email address in the hover dialog, the default mail
application was not opened to send an email. This was fixed.
Follow Ups > When moving the cursor to the View Lead Details link of the hover state
dialog, it disappears before you can click it. This was fixed.
Incidents > When creating a new incident, descriptions are cut off if they exceed a 255character count instead of saving the entire note. This was fixed.
Integrations > When syncing Bills and Purchase Orders from Core to Xero, the tax code
specified at the Account level was fetched instead of the one at the item level for each
transaction. This was fixed.
Invoices > Formatted memos on Invoices would display HTML when saved. This was
fixed.
Leads > Any notes, to-dos, or campaigns associated with a lead is not carried over when
it is cloned. This was fixed.
Leads > Batch updating leads from the list view did not successfully update the lead cost,
country, or memo fields. This was fixed.
Leads > When converting a lead into a prospect, the default probability value in the
modal was not consistently at 25% when converting from the list view and the details
view. This was fixed.
Leads > Notes, to-dos, and tags were not carried over when a Lead is converted into a
Prospect. This was fixed.
Legal > The Project column on the Invoice Collection screen was incorrectly displaying
the name of the Client instead of the Project when a Split Bill Invoice was used. This was
fixed.
Lists > Attaching files from the Resource Library to certain Expense Item in the Lists
module would result in an error. This was fixed.
Notes > Notes were not automatically created when emailing Proposals and Campaigns.
This has been updated.























Opportunities > Totals were not displaying a correct sum in the list view. This was fixed.
Opportunities > Not specifying a Closed-on Date when marking an Opportunity as Won
from the list view screen would result in a system error. This was fixed.
Proposals > The template and format of a Quote inserted into a Proposal does not
match what is displayed in the email sent. This was fixed.
Proposals > Too many columns were displayed in the Proposals list view by default and a
Created by Date, Opportunity, Proposal, Prospect, and description were not included in
the optional column list. This was fixed.
Prospects > In the Opportunities tab of a prospect's detail view, the Forecast field of the
Add New Opportunity dialog does not pre-fill to display any amount already entered in
the Opportunity Value field on focus. This was fixed.
Prospects > In the Opportunities tab of a Prospect's detail view, the Total Opportunity
Value KPI on top of the opportunity list was displaying an incorrect summed value. This
was corrected.
Prospects > When creating a new prospect based on an existing record, the list of client
options disappears when sorting by the Contact column. This was fixed.
Prospects > Prospect filter panel was only displaying Active Prospects. This has been
updated to also show Inactive Prospects.
Prospects > The Opportunities tab in Prospect details was missing totals for value and
closed amount. These have been added.
Reports > Applying the "Last Semi Monthly" date filter on reports would result in system
errors. This was fixed
Reports > Leads reports were only accounting for Leads with a Pending status. This was
fixed.
Scheduled Reports > Some scheduled reports with the ‘Last Week’ date filter applied
were sending incorrect data. This was fixed.
Time Card, Reports > The Employee Time Card (Weekly View) report does not
differentiate time entries by unique description values. This was fixed.
Vendor Bills > The vendor bill batch email option has been restricted to 25 records at a
time.
Vendors > Country currency labels change when selecting an option in the Currency
dropdown of a vendor's detail page. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes

VERSION 1.1.147 RELEASED ON JUNE 6, 2020
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:

Introducing Core CRM (Beta)











Fully Integrated Client relationship management system.
Designed for the Professional services industry.
All-in-one CRM solution that compliments existing CORE platform.
Centralized system to track your Leads and their progress through your sales pipeline.
Help manage your Sales/Business development team’s daily tasks and assignments using
our comprehensive Follow-Up screen.
New set of reports specific to CRM metrics such as Campaign Performance, Promotion
Code Usage and much more.
Build, customize and email Quotes and Proposals directly in Core CRM.
Generate Promotions and Campaigns within CORE and track their performance to
optimize return on investment.
Powerful, real-time dashboard widgets to track Sales Goal Performance, Sales Velocity
and much more.
No fees, zero obligation CRM subscription until September 30, 2020.

Copy Time Card
This much awaited feature will allow users to copy existing Time Cards to any selected week. We
have added two powerful copy options: “Copy From” and “Copy To” to give our users total
control over their Time Cards and will allow them to submit in a matter of seconds.
Customizable Navigation
Core users can now control the order of menu items and keep it unique to their preferences. An
edit icon placed on the navigation menu leads users to an elaborate UI that allows easy menu
item re-ordering.
Update your To-Dos
All Core users can now report progress on assigned To-Dos directly from the Dashboard. The
newly designed To-Do widget allows easy update of percent complete and adds more context
to the assigned To-dos.
Documents for Check & Credit Cards
The ability to attach documents to checks and credit cards has been added so that necessary
documents can be uploaded for these types of transactions.

Other improvements:























Bill Payments> Check numbers will now be automatically added into the memo when
making a Bill Payment with a check or credit card.
Cloud Feeds> The search function has been added to Cloud Feeds in the Find Match
flow.
Dashboard> Dashboard Accounting widgets are now reflecting Accrual or Cash basis as
defined in Global Settings. Users also have the option to choose the accounting option
in the widget itself.
Dashboard> Enhancements have been made to the Project Allocation by Task widget to
enable filtering by Employee, widening the Project column, and adding Resource as a
group.
Dashboard> The Project Allocation widget was missing a total row. This has been added.
General> Batch update operations have been limited to 5000 records per batch.
Integrations> Split Billing type Invoices are now getting properly synced to XERO and
AccountRight.
Payments> "Type" column was added to the payment disbursement window to
differentiate services and expenses.
Payments> The Payment Disbursement screen can now be sorted by any column.
Project Templates> Assignments have been added to Project Templates.
Projects> The Project Templates option in the More menu has been separated from
other options to make it easier to find.
Project Templates> Users can now assign Fee Schedules, Budgets, and Estimates to
Project Templates.
Reports> A new report was added to list all Scheduled Report details.
Reports> An individual Employee filter was added to the Employee Time Card Summary
report.
Reports> An option to hide phases when running a Project List report has been added.
Time and Expense> Users can now choose from various write down / mark down options
when assigning time and expense entries to an invoice directly from the Time Entries,
Expense Entries and Reviewer screens
Time Card> An additional column has been added to Legal industry Time Cards to
denote L-Code for your activities.
Trust Fund Accounting> Trust Fund summaries are now supported on all Core Invoice
Templates.
Vendor Bills> Payments Status filter has been updated to allow multiple options to be
applied at once.

Other fixes:

























Accounting> There were incorrect restrictions for DCAA compliance that were
preventing a user from entering Vendor Bills that included Time and Expenses. This was
fixed.
Clients> Search capability was not working properly in the City field dropdown. This was
fixed.
Clients> The “All Projects” option disappears in the Performance tab Project dropdown
after selecting a different project. This was fixed.
Credit Cards> Changes to Expense Entries linked with a Credit Card were not syncing
correctly between both modules. This was fixed.
Credit Memos> The class field value was not able to be removed after saving. This was
fixed.
Credit Memos> When saving /updating credit memo without class field, class would get
displayed as required. This was fixed.
Currency Manager> The Currency Manager screen did not allow an assigned multiplier
value to exceed 7 digits. This was fixed.
Currency Manager> The Cayman Islands currency was incorrectly displaying the pound
symbol instead of the dollar sign. This was fixed.
Currency Manager> The search bar on this screen was not successfully returning results.
This was fixed.
Custom labels > Activity and Expense custom labels were not reflecting correctly
throughout Assignments. This was fixed.
Dashboard & Invoices> Time entries recorded against sub-phases were not counted in
the Totals row. This was fixed.
Dashboard. If any Invoices had been created for Inactive or On Hold Projects, the Project
Gross Margin widget would unnecessarily display 0 values. This was fixed.
Dashboard> When filtering the Expense Performance widget to display Invoices for all
dates, an error would occur when scrolling to the bottom. This was fixed.
Dashboard> The PTO widget did not account for negative benefit usage values like other
HR modules do. This was fixed.
Dashboard> The utilization percentage displayed in the Staff Utilization widget did not
match the same percentage displayed in the Employee Performance screen. This was
fixed.
Documents> Sorting the list of an Invoice’s existing documents would throw an
exception. This was fixed.
ePayments> Due date or Custom date payment options should not have appeared once
the Payment was overdue. This was fixed.
ePayments> Retainer invoices that had ePayments enabled were throwing API Errors.
This was fixed.
Financial Budgets> Allowing users to edit a Financial Budget's time period caused an
error. This was fixed.
Financial Budgets> Budgeted amounts for each interval were not dividing correctly when
switching between annual, quarterly, and monthly views. This was fixed.
Financial Budgets> The “Hide Blank Rows” action would hide account category rows
when it should have only hidden individual account rows. This was fixed.


























Gantt Chart> Incorrect start and end dates were being displayed when exporting a
phased parent project Gantt view as a PDF. This was fixed.
General Journal> Clicking either "Save & Done" or "Save & Add Another" when creating
a General Journal entry redirected the user to the Dashboard instead of the correct
General Journal screen. This was fixed.
Global Settings> Users who enabled DCAA and used a hash "#" in their password were
unable to disable it afterwards. This was fixed.
Groups> When changes were made to security settings and reverted back, access was
not fully granted back. This was fixed.
Integrations> When successfully syncing expenses from QBO to Core, Core would use
the same alert that was used to depict a sync failure. This has been updated to reflect a
successful sync.
Integrations> DCAA compliance settings were causing issues with Xero, QBO and
AccountRight. This was fixed.
Invoice Collections> Invoice Collections screen was reflecting incorrect Retainer Available
numbers. This was fixed.
Invoice Collections> The Client column was incorrectly labeled as an Invoice column
when exporting the list as a .CSV. This was fixed.
Invoices>When trying to void a manual invoice that had been manually paid, an API
error was thrown. This was fixed.
Invoices> Invoice records on the list view screen would disappear when sorting by Class.
This was fixed.
Invoices> When 2 draft Invoices were finalized at the same time for a Project that used
custom Invoice numbers, only 1 finalized Invoice reflected the custom Invoice number
while the other did not. This was fixed.
Invoices> When filtering by a Project Manager in the Invoices list view, the selected
Project Manager name was displayed incorrectly in the filter details section. This was
fixed.
Messages> When searching for a name in the TO field of the Message Composition
screen, the search did not return proper results. This was fixed.

Payments> General Journal entries were not being created for credit or write-off
payment types. This was fixed.
Payments> Payments screen allowed multiple clicks on the Pay button which would lead
to duplicate payments being created. This was fixed.
Projects> Column resizing in the list view were not being persisted and applied anymore
after reloading the page. This was fixed.
Projects> Phase order was lost when cloning a project. This was fixed.
Projects> Showing duplicate records for vendors when assigning as a team member in
project details. This was fixed.




























Projects> Using fractional percentages on split billed projects would round up
percentage values and could cause totals to go over 100%. This was corrected.
PTO> Request Approval email notifications were displaying the date the request was
made instead of the date requested off. This was fixed.
Reports > Document reports were not showing the correct file size Grand Totals. This has
been corrected.
Reports> Incorrect applied filter details were being displayed on the Percentage Billed
report. This was fixed.
Reports> The Balance Sheet Accrual by Project and P&L Accrual by Project reports were
not applying custom labels correctly. This was fixed.
Reports> The Statement report was generating extra blank pages. This was fixed.
Reports> Time Details report displayed an incorrect stop time for time entries. This was
fixed.
Search> When applying discrete filters and searching together in a list view, and then
clearing the applied filters, the value in the search box was also cleared. This has been
fixed.
Time & Expense Reviewer> Changes made to an entry's description field from the list
view were not being successfully saved after clicking Done even though a success
message was shown. This was fixed.
Time & Expense Reviewer> When specifying a custom date range, the placeholder text
for the From and To fields was not reflecting the correct date format. This was corrected.
Time & Expense> When a time entry was entered on behalf of another employee and
then rejected by a manager, the rejection notice was incorrectly sent to the employee
who made the time entry instead of the employee whose time was rejected. This was
fixed.
Time & Expense> In the Time and Expense Entry details screens, the Created On Date
has been moved next to the Entry Date in the General tab.
Time Card> The "Remove Blank Rows" action should have removed all blank rows in the
time card; however, if this action was used with a few rows selected, then only the
selected blank rows should have been removed. This was fixed.
Time Entries> Users could not update the billable status from the Edit Time Entry screen
for fixed Projects. This was fixed.
To-Dos> Some To-Dos that had attachments were not reflecting this information
correctly from the list view. This was fixed.
Vendor Bills> When creating a new Vendor Bill,
searching by a Vendor's last name would not display any results. This was fixed.
Vendors> An error was thrown when converting a vendor with saved notes into an
employee. This was fixed.
Vendors> When a vendor already has a saved memo, the details tab continued to show
"Add Memo" instead of "Show memo". This was corrected.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes

VERSION 1.1.146 RELEASED ON APRIL 18, 2020
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:

Trust Fund Account Management
We are proud to announce that we have added Trust/IOLTA account management, a very
popular feature in the Legal industry. This powerful enhancement will allow users to manage
and report on a client’s funds separately from their firm’s operative bank accounts and comes
packed with reports and widgets that allow tracking Trust funds by matter and 3-way account
reconciliation that can be run for each statement period.

Guaranteed payments with Scheduled ePayments
Never miss another ePayment from your Client because the Invoice was not due yet. We have
enhanced our ePayments feature to allow your Clients to schedule payments on any date of
their choice. As long as the scheduled payment date falls on or before the Invoice due date, your
Clients can choose when to pay and also be able to make any changes right from the ePayment
page for the specific invoice.

Rates by Classification
This powerful feature that is turned on by a project rule, allows your Fee Schedules to pivot on
employee classifications. Define specific or general classification rate rules in your Fee Schedules
and this new feature will auto populate the new rates based on the classification selected for the
time entry.

Advanced Report Filters
Create powerful reports based on advanced filtering that supports And, Or and Not
combinations. Also, Core reports now print the applied filters at the top of each report to add
more context to the report.

Filter preview
By popular demand, we have added aesthetically designed filters segments that provide a sneak
preview of the filters applied to any of the Core list views. Users can click on these segments to
see the full list of filters and also continue to add or remove the filters from the panel view.

‘Mark as Billed’ with Invoice number
This powerful enhancement in the Time and Expense reviewer allows billing managers to
associate unbilled entries to previous invoices, and handle it for multiple projects at the same
time.

Know your allocations
Added a brand new ‘Task Allocations’ widget that displays assigned tasks with complete details
including allocated, used and remaining hours and is easily filterable by Project, Employee and
date ranges. T&E users also have been allowed restricted access to Allocations screen to view
their tasks in a list view.

Other improvements:









Allocation & Forecasting> Employee manager filter has been added to allow managers
to easily view the tasks of all the employees they manage.
Allocation & Forecasting> More validation rules have been added in the '+Add' window
to help users make sure they add allocations correctly.
Batch Invoices> A new global setting (Master>Charge Item taxes in addition to Contract
Amount) now controls if the net bill algorithm should exclude item-level taxes when
processing an invoice using the percent complete option.
Batch Invoices> There have been several important enhancements in this screen
including automatically combining an unlimited number of phases, performance
optimization that makes the create batch Invoice process 50% faster and a better user
experience for Phased, Joint and Split Invoices.
Budgets, Estimates> Select multiple records to send together in one email instead of
individually emailing one at a time.
Budgets, Estimates, Fee Schedules, and Financial Budgets> The search bar in the 'Create
from Existing' window was relocated for scalability and clarifying what users can search.

























Cloud Feeds> The account setup experience has been updated to address the issue of
orphan accounts being created before the process was completed.
Cloud Feeds> We now append the institution account number to better identify the
third-party institution account when adding new accounts to Core.
Currency Manager> Added 'New Taiwan Dollar' as a new currency in Core.
Dashboard> Drill down into the details of the data displayed in the Account Balances
widget by opening the Account Registers report straight from the widget.
Dashboard> Drill down into the details of the data displayed in the Expense Performance
widget by opening the Billed time & Expenses report straight from the widget.
Dashboard> As part of the Trust accounting update, a new 'Trust Fund Balances' widget
has been added to the Dashboard to allow easy read-access to your trust fund balances.
ePayments> We have added more options to allow users to control the ePayment email
message including an override for the stock message.
ePayments> We have redesigned the 'Pay' button and also listed all supported credit
cards on the Client payment page.
ePayments> We have added a ‘View Invoice’ link on the Payment page to preview the
original invoice.
Expense Entry> A 'Classification' column has been added to the Expense Entry list view.
Financial Budgets> A tooltip was added to elaborate on the purpose of using a reference
year when creating a financial budget.
Financial Budgets> Easily expand or collapse all rows at once when editing a financial
budget.
Financial Budgets> In the batch update dialog, a field is auto-checked when a value is
entered.
Financial Budgets> The data displayed in the reference column now updates to show
actual numbers from specific time periods of the selected reference year based on the
column the user is currently editing.
General> Core has added a second confirmation step before batch actions are executed
to prevent unwanted changes to large record sets.
General> Core's customer services contact information can now be accessed within the
application from the Help menu.
General> We have made several enhancements to our column resizing feature to allow
for better user experience. Columns that have been resized already by the user are not
affected by modifying any of the other columns.
Invoice Collections> 'Retainer Available' column has been added to the Invoice
Collections list view.
Invoice Templates> As part of the Trust accounting update, Invoices for matters that
have an associated trust fund will have the option to select from invoices templates that
display a Trust Fund Summary.
Invoice Templates> We have enhanced our late fee invoice templates to show the
memos associated with the Invoice.


























Invoices> We have added the Batch Update menu that allows users to perform multiple
batch updates at the same time.
Manage Subscriptions> Subscriptions that have been purchased together and set to
auto renew at the same interval, will now also be renewed at the same time and a single,
consolidated invoice would be generated.
Manage Users> The filter panel has been added to better manage your users.
Payments> Accounting users can now directly add payments to their bank accounts
when entering a payment. The newly added 'Deposit Account' field will list all their bank
accounts as well as the traditional 'Undeposited Funds' account, allowing them to issue a
direct deposit to the bank.
Payments> Expense Account for Credit and Write-Off type payments has been renamed
as 'Posting Account' to convey the purpose of this field better.
Projects> Allow users to choose project attributes to inherit when adding a new phase
and also remember their choices for the next time.
Projects> As part of the Trust accounting update, trust fund activity will now be
accessible from within the Transactions tab in Matter details.
Reconciliations> Bank account reconciliation was further simplified by rolling up bill
payment checks to a single entry to match how it appears on the bank statement.
Registers> See check numbers for a bill payment in the register so you can associate it
with the bank statement when reconciling.
Reports> The Monthly Profit and Loss Accrual and Cash Basis reports now have an
added column to display a total for every month.
Reports> The 'Project List Report' now has the added option of grouping by Master
Project.
Reports> As part of the Trust accounting update, a new 3-way reconciliation report has
been added to provide information about reconciled bank balance, book balance and
client trust ledger balance.
Reports> As part of the Trust Fund feature, we have added the 'Trust Fund Account
Activity' report that will track Trust funds by client and matter.
Reports> Benefit Usage reports now round to the nearest quarter hour.
Reports> 'Client List' report can now be grouped by various options like Client Group
and Client Manager.
Reports> 'Requests for Information' report now allows users to specify if they want to
see the Contacts or the Creator of the RFI as a report column.
Reports> We have extended the drill down feature to all our Financial reports. This
update adds this functionality to financial reports that are based on Class and Project
accounting.
Reports> We now allow admin users to rename scheduled report group names.
Reports> We now print the applied filters on the top of each report but limit the list to
10 or less discrete filters.
Reviewer> We have added the Hours column to reveal the actual hours associated with
the Time entry.







Security> Access to Performance widget security now also controls access to the List
view Info bars in the relevant screens.
Security> Admin users can now control if Project Managers have access to the
'Forecasting' view and also a separate security to control access to the amount view
while forecasting.
Statements> The selected template in the Statements screen now defaults to the last
used template.
User Preferences> Users can now configure Core drop down searches to be based on
‘starts with’ or ‘wild card matching’ principle. Wild card matching is the default setting.

Other fixes:
















Activity> Activity screen did not warn against entering a duplicate Activity. This was fixed.
Bill Payments> After excluding a negative reimbursable amount from the details window
of a bill payment, the pay amount was not being updated accordingly. This was fixed.
Checks> After making changes to Alignment, Check Style dropdown selection would get
refreshed instead of persisting the selected value. This was fixed.
Client> Performance tab, Project drop down would only include active projects. This was
fixed.
Cloud Feeds> Core did not allow split transactions to be entered with a negative
amount. This was corrected.
Cloud Feeds> Core would allow users to specify multiple payees when adding a check
feed as check in split mode. This was corrected.
Compose email> Configuring global settings to include the client's and the logged in
user's email addresses in the CC field would automatically add them without including a
separator and this error would block an invoice email from being sent. This was fixed.
Dashboard> Employee Allocation & Staff Workload widgets did not work when applying
a project and employee group filter at the same time. This was fixed.
Dashboard> Vendors were included when trying to filter by Employees in the Employee
Allocation and Staff Workload widgets. This was fixed.
Employees> Clicking on the 'Added By' hyperlink in a note's details inconsistently
directed a user to the Documents tab when it should have directed the user to the
General tab of that employee. This was fixed.
Expenses> Users were unable to delete an Expense entry that was previously linked to a
Credit Card and then unlinked. This was fixed.
Financial Budgets> The % Changed values of the reference column would not display for
account category rows. This was corrected.
Financial Budgets> The amounts budgeted in each cell would split evenly among all
intervals throughout the entire fiscal year when switching between monthly, quarterly,
and annual instead of splitting these amounts only within the subsection of a fiscal year.
This was fixed.
























Financial Budgets> The current expanded/collapsed view format was not persisting when
switching the interval view between monthly, quarterly, and annual. This was fixed.
Financial Budgets> The reference column was not grouping the value and % changed
columns together so that they could be shown or hidden together. This was fixed.
Financial Budgets> The Save & Done button did not successfully save a financial budget
in the create and edit screens. This was fixed.
Financial Budgets> Updating the Class and Fiscal Year fields while editing a financial
budget caused the screen to load the changes indefinitely. This was fixed.
Financial Budgets> When switching the view between annual, quarterly, and monthly
while editing a financial budget, the budgeted amount was lost. This was fixed.
General> Groups counts have been updated to exclude Inactive Groups.
Integrations> Split billed invoices were not being properly synced for QBO integrations.
This was fixed.
Invoices> API error occurred when processing multiple phased invoices as final in one
batch action. This was fixed.
Invoices> In a certain scenario, multiple Joint invoices were created when clicking the
'More' button that loads more entries instead of only creating one invoice. This was
fixed.
Invoices> The loading spinner would disappear after the unapproved time/expenses
message appears even though the page was not done loading. This was corrected.
Invoices> Quick adding a project, budget, or estimate when creating an invoice would
open duplicate dialog windows. This was fixed.
Invoices> Invoice date sort would not correctly sort the invoices if they were created on
the same day. This was fixed.
Invoices> Email to Client would not default to Project Billing Contact if Client email was
blank. This was fixed.
Payments> When creating a new payment and selecting a Client but not a Project in the
'Add Payment' dialog, 'Accept as retainer' would fetch all retainer Invoices, including
those which did not belong to the selected Client. This was fixed.
Payments> Billing users were not able to select 'Completed' projects from the Project
drop down to record a new payment. This was fixed.
Payments> Core was not handling cash accounting correctly when a deposited check
was marked as bounced. This was fixed.
Projects> Entries disappeared in 'Add Team Member/Expense/Activity' window while
searching and sorting through the list. This was fixed.
Projects> Main project row in split billing section of Billing Options tab did not follow
the name convention set in global settings for labeling projects. This was fixed.
Projects> Running a Project Time & Expense with Accounts report from the Projects
screen did not apply the filters used in the list view. This was fixed.
Projects> Users who did not have access to add a Team Member, Activity, or Expense
were not prompted with this explanation when attempting to add one to a Project. This
was corrected.

























Projects> The structure tab would not gracefully handle a situation when the logged-in
user had no access to the Project contract amount. This was corrected.
Projects> Core would not hide the contract amount and cost rate related widget data if
the relevant security settings were turned off for the logged-in user. This was fixed.
QBO Integration> Errors were thrown when re-syncing already-synced Expenses from
Core to QBO. This was fixed.
Reports> Account Transactions report was showing Project and Client filters in the
custom field tab. This was fixed.
Reports> Activity Items filter options were not sorted alphabetically. This was corrected.
Reports> Any filters set when running a Client List report were not being applied. This
was fixed.
Reports> Bounced check transactions caused an error in the Profit and Loss Cash Basis
report calculations. This was fixed.
Reports> Custom Fields filter section header was missing in the customization widow.
This was corrected.
Reports> Filtering the Project Requests for Information report should only allow users to
select individual records and not a range of statuses. This was corrected.
Reports> The Net Billed amount in the summary section of the Account Register report
was not calculating the correct sum. This was fixed.
Reports> The Retainer Invoice report crashed when applying a Reference Num filter. This
was fixed.
Reports> In select scenarios, Statement report displayed an error instead of a date when
using 'As of' date filter. This was fixed.
Statements> Statement reports have been updated to properly apply 'As Of' date filters.
Subscriptions> The user interface was not responsive on smaller monitors and this would
cause design overlaps. This was fixed.
Time and Expense> When updating the Activity item and Cost rate of the Time entries
linked to a Vendor bill, the Vendor Bill Accounting details were not getting updated
accordingly. This was fixed.
Time and Expense Reviewer> Applying a single Class filter to the Reviewer list screen
would always retrieve a blank list. This was fixed.
Time Card> Allocated hours were not considered in the allocation summary section if a
start/end date was not specified in the A&F screen. This was fixed.
Time Entries> Time entries linked to Vendor Bills, Checks, and Credit Cards would not
update when changed for income and expense accounts when using Batch update. This
was fixed.
Time Entries and Vendor Bills> The Project dropdown list becomes empty when
reopening the dropdown after scrolling through the entire list the first time it was
opened. This was fixed.
Timers> Deleting a hyperlink document attached to a timer entry causes an error and
does not successfully delete the record. This was fixed.








Vendor Bills> The 'Amount' column in the account tab was incorrectly labeled 'Cost
Amount'. This was fixed.
Xero Integration> Core would throw an error when getting the same name Client or
Vendor from Xero. This was fixed.
Xero Integration> Duplicate records were being created when syncing same name
Projects from Xero to Core and vice versa. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes

VERSION 1.1.145 RELEASED ON MARCH 07, 2020
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:

Financial budgets
Create financial budgets to define cost and revenue benchmarks your company can follow in an
upcoming fiscal year. This feature comes with reference and input tools to help you make tough
budgeting decisions. As the year progresses, run a comparison report to see how the company
finances are holding up against what you've budgeted.

Split Billing
The introduction of split billing will allow an invoice to be divided among multiple matters
(projects). The invoice breakdown can be easily customized using percentages.

Multi-Tier Invoicing
Joint/Phased Invoices now have the option to roll up to any specified level in the project
hierarchy, rather than just rolling up to the root or Client level. Combination options include roll
up at Master Project, Phase, Sub phase or Client.

Automatic General Journals for accurate accounting
We now create automatic journal entries when an Invoice, Payment or Check is voided and also
allow users to specify the voided date. Automatic journal entries will now also allow billing users
to void Invoices, Payments and Checks that fall in previously closed periods without any risk of
impacting accounting.

Time Card enhancements
We have introduced Project, Client and Activity filters to the Time Card giving users more
control when they are entering time. Additionally, users now have the option to turn on billed
status for their time card entries.

Other improvements:










Budgets, Estimates and Fee Schedules> Added search function to assign projects dialog
to allow for quick and easy assignment process. Also, Projects that are already assigned a
budget (or estimate, fee schedule) are grayed out to avoid any assignments by mistake.
Budgets> We have added batch update action to Budget and Estimate lists to allow
users to change active status, Fee Schedule and date in one action.
Checks>This update allows accounting users to print Checks using custom templates
developed by BQE Consulting teams.
Cloud Feeds> Accounting users can now set connected accounts as inactive. This takes
away the need to disconnect certain accounts like expired credit cards and thus avoid
losing matched data.
Cloud Feeds>Users can override auto matching for feeds by using the "Find Match"
option.
Dashboard> "Project Allocation" widget now rolls up values to parent project level.



























Dashboard> Allocation widgets like Employee Allocation, Project Allocation now
compute spent for all allocation scenarios including Employee Group- Activity and
Employee Group-Activity Group.
Dashboard> Shared dashboard widgets now allow users other than the owner to also
apply their own filters.
Dashboard> We now handle employee and vendor groups in "Staff Work Load" and
"Employee Allocation Widget".
Dashboard>"Project Allocation by Activity" widget was enhanced to show allocation start
and end dates and also default to show allocations for the logged user only.
Expense Entry> We now support credits for reimbursable expenses by allowing users to
enter negative reimbursable expenses.
Fee Schedule> Added the ability to search when viewing the list of existing fee schedules
in “Create new Fee Schedule from existing” dialog.
Fee Schedule> Billing users can now enable the "Minimum Hours" column in services
tab.
HR Benefits> Added the 'Earned Unit' column to benefit list view.
HR Review Templates> The list view was further enhanced with new optional 'Status'
column. Also, added status as a filter.
HR Reviewer> We now create a To-do automatically for the reviewer as soon as the
performance review is set up.
Invoices> Automatically email Clients when sending out emails to Client contacts. This is
controlled by a new setting in Global Settings>Email.
Invoices> 'Last Emailed' now shows the time of the day along with date for last emailed.
Invoices> Phased and Joint Invoices now show up with an expansion caret and show
phases that were part of the combined invoices as separate rows when the caret is
expanded.
Invoices> Users can re-arrange the line numbers to match the current sort in Time and
expense entry detail in Invoice detail view.
Manage User and Subscriptions> Added Export to CSV action.
Notes > Added Quick add option for Client, Employee, Project and Vendor dropdowns.
Payments> An accounting enhancement now ensures that Core makes an automatic
journal entry to adjust tax liability accounts when a Write off or Credit payment is
entered.
Payments> Core now allows users to pick a contra asset account when entering a writeoff/credit payment.
Payments> Users can now view the deposit that is holding the payment by using the
'View Deposit' row action.
Project Structure> We now leave the hierarchy view expanded (or collapsed) when
moving phases up or down or when moving them across projects.
Project> User can now create a new client when cloning a Project.
Reports> 'Billable Work History' report now can be run for billed as well as un-billed time
and expenses.












Reports> Budget reports now allows users to run comparison based on Time and
Expense Dates.
Reports> Employee Missing Time report now uses weekly standard hours if the standard
day hours for the employee are not set.
Security> HR Salary history now allows admin users to control if they want employee
managers to view salary history of their employees.
Security> We have added new security settings called 'Show Performance Widgets' in
Project, Client, Employee and Vendor to allow an administrative control on who has
access to this information.
Security> We have added new 'Show Billing Options' security to allow admin users to
control who has access to project billing information.
Security> We have added the security profile as a filter option to make it easy for Core
admin users to filter for employees that have specific security profiles assigned.
Statements> Statement generation was simplified by limiting the date range drop-down
to just 'As of' date.
Time & Expense Reviewer> Managers can now view the actual hours of the time entry by
turning on the 'Actual Hours' column in Reviewer screen.
Time & Expense Reviewer> Users can locate entries by class by using the optional 'Class'
column.

Other fixes:












Calendar> Progressive scroll would not work for documents attached to a calendar
event. This was fixed
Checks> A scenario tied to Payee filter would cause the progressive scroll to stop
working after 25 records. This was fixed.
Checks> Class attribute specified for line items was not being automatically set for AR
side even though there was no default class set at the Project level. This was fixed.
Cloud Feeds> An issue with the third-party provider, Yodlee was preventing adding
accounts when the Company owner was missing the last name. This was fixed.
Cloud Feeds> Matching feeds to transactions in closed periods was being prevented.
This was corrected.
Cloud Feeds> When associating a new Core COA to an existing connected bank, existing
feeds would stop showing in the transaction view. This was fixed.
ePayments> ePayments related UI would appear in some instances even if ePayments is
not turned on for the company. This was corrected.
Expense Entry> Batch update to change expense entries for the expense code would not
automatically update the income and expense accounts to match the accounts set at
Expense code level. This was corrected.
General> Google maps integration for address section was not working. This was fixed.


















Integration> An issue was preventing Vendor sync for QBO Australia. This was fixed.
Integration> QBO record synced from Core would not show the correct payment type in
certain scenarios. This was fixed.
LEDES Export> Classification field was not getting abbreviated. This was fixed.
Project Assignment >Progressive scroll would break in a certain scenario. This was fixed.
Project Assignments> Inactive activity and expense codes would show up when
searching for items in “Add assignments”. This was fixed.
Projects> Changing the class attribute and selecting change all existing records would
cause discrepancies in class accounting reports. This was fixed.
Projects> Users were able to modify existing opening balance entries that had prior
payment information and this would cause a discrepancy. This was fixed.
Projects> Users would always get navigated to the details tab when using Project
hierarchical drop down to move between phases. This was corrected.
PTO> Approving a PTO by navigating from the notification area would cause the
approver to be not prompted to create a time entry. This was fixed.
Reports> "Employee Allocation Units Summary" would fail if "Show Active Only Rule"
was checked in Allocation and Forecasting. This was fixed.
Reports> "General Ledger Cash Basis" would take a long time to process for large
databases. This was fixed.
Reports> "Project Allocation Units" report would fail to process for large data. This was
fixed.
Time and Expense entry>Cash accounting was getting affected when an expense entry
was made part of an invoice with prior payments. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.144 RELEASED ON JANUARY 18, 2020
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:

Due Date Aging
This update adds a slick new option to base Aging reports off Invoice and Bill due dates.

New Contract Amount Calculator
We have added a contract amount calculator that allows users to express Project Contract as a
“Percentage of total amount’ or “Units x Cost Amount”. This cool new feature will remember the
provided values and allow recalculation at any stage of the project.

Improved, faster CSV Export
We re-wrote our CSV exporter to allow users to export unlimited records from any of Core’s list
views.

In-app Promotions
This update adds an intelligent, trigger driven in-app promotion messaging system to Core that
will allow BQE to engage with our customers more by informing about the new features and
upcoming BQE events.

Enhanced Xero Integration
We have added sync support for projects in Xero and Core. It does not matter where you
maintain your project list. These new sync improvements have you covered.

Budget Improvements
We have added Start and end dates to budget line items to allow for easy import to Allocations
and also improve Budget tracking and comparison.

Other improvements:







ePayments> Core Users can now pass the $.30 fixed processing fee charged by Stripe for
each transaction on to their Clients.
Gantt Chart> Users now copy allocations and create new tasks from the Gantt view also.
General> We made the column chooser scroll bar wider to make it more visible for users.
General>Users who open multiple tabs of different Core companies at the same time are
now prompted to close the other tabs before switching companies.
Integration>Implemented the latest version of authentication protocol for Xero
integration.
Notifications> Certain system generated emails like allocation assignment were
improved for content.











Reports> 1099 Reports now allow users to specify if they want to report on 1099 vendors
only.
Reports> Added Project start and due date filters to 'Contract Analysis' report.
Reports> All Time and Expense reports were enhanced with an 'Employee Manager'
filter.
Reports> 'Client Transactions' report was further enhanced to report accrual and cashbased revenue by Client or Project state.
Reports>Added 'Payment Date' filter to 'Taxes' report.
Reports>AR Payments of type 'Write-off' were not being reflected in Cash basis reports.
This was corrected.
Security> Admin users can now filter the list for active employees and vendors.
Subscriptions>Admin users can now purchase 4- and 5-year subscription plans right
from the Manage Subscriptions page.
Time & Expense Reviewer> Added the 'Paid' filter to this view.

Other fixes:











Allocations>Users were unable to copy allocations when the logged user had employee
control restrictions on allocation screen. This was fixed.
Calendar>Creating an event for 'Submittal' review date would cause the event to be a
day off. This was fixed.
Chart of Accounts> Users were not able to an account when 'As of' date was set blank.
This was fixed.
Checks>Users were able to create a recurring check without a payee. This was corrected.
Deposit Screen>Account drop down did not accept certain uppercase characters. This
was fixed.
Employee & Vendor>Masked fields like SSN, birth dates would show up complete value
when the page was still loading. This was fixed.
General> Users are now warned before navigating them to the detail view if they have
selected more than one item(s).
General>Some new screens were found to have issues with progressive scrolling. This
was fixed.
Integration>Credit and Write off payments would to sync over to QBO on Australia and
Canada region companies when tax code setting was turned on. This was fixed.
Invoices> Changing invoice date and memo for a paid invoice would cause the cashbased accounting to be thrown off. This was fixed.


















Invoices> Users were not able to process late fee invoices for a Joint Invoice which had
one of the projects with zero-dollar invoices. This was fixed.
Payments> A certain scenario could cause the 'Save' buttons to stay enabled even when
a payment was being applied causing some users to record duplicate payments. This was
corrected.
Projects> When creating a new project structure from a template, the project name was
being pre-filled from the name of the template and not the underlying parent project.
This was corrected.
Projects>Quick add Project was missing from Projects>Billing Contract drop-down. It
was added.
Reports> Allocation reports would refer to the descriptions of item codes instead of the
descriptions provided in the allocation entry. This was fixed.
Reports>Allocated Hours report did not match Allocation and Forecasting Screen when
allocation involved groups. This was fixed.
Reports>'Project Profitability' report would exclude invoices for main type projects. This
was fixed.
Security> Users with no access to client list would see the client list when hitting create
new project in project drop-down. This was corrected.
Time & Expense Reviewer> Recently added column 'Manager' was renamed 'Project
Manager' to avoid confusion.
Time Entry> Entries marked as non-billable by the system if they were over the contract
amount would change to billable if the user changed the activity. This was corrected.
Vendor Credits>Class inheritance would fail when selecting a project with assigned class
at item level. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.143 RELEASED ON DECEMBER 21, 2019
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:

Smart Timers

New and improved Timers list, auto populated with the most recently used Project and Activity
combinations, will now allow users to start timers with minimal effort and no input. A brandnew user preference allows users to limit the number of predicted entries to suit their typical
use.
Column re-sizing across the board
We have re-engineered the column re-sizing experience and made it available for all columns
throughout the app. Users also have the option to reset column widths to their default values.
Project assignments made easier
A brand new ‘Assignments’ tab in Project view will allow users to perform all assignments- rules,
contacts, team members, activity and expense codes from one convenient location.
Allocation Status in Time Card
This update adds the much-requested feature of allocation status in the Time Card and Time
Entry screens. The system will now highlight allocation status information, if an underlying
allocation is detected, when entering time and help users to stay within the allocated units.
Improved, efficient Gantt Charts
Users can now shift entire project time lines by using the new drag and drop feature for Projects
and resources. Moving the top-level project or any underlying phases automatically adjusts the
start and end dates for all underlying tasks. Other neat usability improvements include
magnifying small interval tasks on mouse hover to for easy linking and drag & drop.
Copy allocations
Allocating employees and Projects just got easier with the new copy and paste special feature in
Allocations. Existing allocations can be copied as is or modified for multiple attributes including
Employee, Project, Start and End Dates, dependences and notification settings.

Improved search techniques for dropdowns and Core Lists
A simplified search algorithm now returns results based on pattern matching without the need
of any explicit wild card specifiers. Also, text filter search in Core lists now applies the search
term to all visible columns of the list, making search-based filtering more efficient and intuitive.

Other improvements:


Allocation & Forecasting> Added a toggle to allow users to show tasks for active
projects or all projects in the task view.



























Allocation & Forecasting> Users can now filter forecasting views using Project custom
fields.
Cloud Feeds> This update adds an inbuilt mechanism to detect duplicate feeds from
third-party feeds sources and automatically mark them as ignored.
Allocation & Forecasting> Employee and approving managers are now notified that the
PTO request is in conflict with an already scheduled project allocation, if the employee
has been scheduled for a task in the same period.
Collections> Users can now choose to turn on the 'ePayment' column to visually know if
any of the open invoices are enabled for online payment.
Contacts> Users can view a contact's mobile phone number from the list view.
Dashboard> To-Do widget now automatically shows the items which are due sooner on
the top.
Documents> Users can now navigate to the underlying entry the document is attached
by clicking the 'View associated entry' row action.
Estimates> Users can now generate the 'Estimate Details' report for a specific client.
Gantt Chart> Users will be able to move smaller interval tasks much easily as the system
magnifies the task to ease drag/drop and linking actions.
General> Quick add function has been enhanced to also include lists like 'Classes', 'Cost
Pools' and 'Payment Terms'
General>Success notifications were made to fade away quicker than earlier.
Integration> Joint Invoices are now sent over as a single, unified invoice for the
Customer when syncing Core invoices to Xero.
Integration> QuickBooks Online integration now supports project currency. Customers
that have been designated a custom currency in QuickBooks will have their project
currency in Core mapped to the currency preference in QuickBooks. The setting
automatically flows to their invoice templates.
Invoices> Invoices that are automatically created to record client charges for bounced
checks will be appended with '-BC’ specifier for easy identification and management.
Items> 'Code' field now allows users to enter up to 100 characters.
Project Templates> Users can now edit Project template name and description from the
detail view.
Projects> Admin users can now set up project rules that control if non-billable time and
expense entries should show up on invoices. This was previously available only as global
setting but users can now selectively turn this setting on or off by Project.
Reports> Added important Project filters to 'Percentage Billed' report.
Reports> All budget reports were enhanced with important project filters like Project
Status, Contract Type, Group, Manager etc.
Reports> AP Aging reports now offer Vendor group as a filter.
Reports> Choosing the 'All Dates' filter would un-necessarily restrict the reports for
dates for a certain date range. This restriction was removed.
Reports> 'Collection Details' report was enhanced to show average delay information for
the Client.



















Reports> GL reports would not display the credit card refund entries correctly. This was
fixed.
Reports> Project reports that allow custom groups will now also include an option to
group by Project Principal or Originator.
Reports> Tax Registry report now allows users to filter for payment dates.
Reports> 'To-Do Tasks' report can now be filtered Type, Project, Client, Employee and
Vendor.
Reports>'AR Aging with Credit Payments’ now allows users to select the 'Show General
Journal' option without being forced to select 'show invoices' option.
Reports>Project time and expense reports now have an option to include or exclude
WUD while calculating the charge amount.
Reviewer> Added 'Project Manager' as an optional column.
Reviewer> Users can now check the paid status of time and expense entries in the
'Reviewer' by choosing to turn on the 'Paid' column.
Security> Admin users can now control which users have access to sensitive employee
information like SSN and Birthdates.
Time & Expense>Users can now indicate if they want to re-calculate Markup/ WUD when
assigning un-billed time and expense entries to existing invoices from the batch update
utility in Time Entries, Expense Entries and Reviewer.
Time Card> Added column chooser in the 'Day view'.
Timers> The enhanced list view for Timers can now be sorted by current recorded time.
Timers> Users can optionally turn on the 'Start' and 'Stop' times columns.
To-Do> Users can now choose which employee completed the To-Do. This works great
for To-Dos' assigned to a group of employees.
Vendor Credits> Vendor Credits now support 'Class' at the line item level. The system
will pre-fill the default vendor class automatically.
Vendors> Accounting users can update multiple vendors for '1099' attribute using batch
update.

Other fixes:






Account Reconciliation>Users would not receive a prompt advising users of the effects
of clicking the Undo All button. This was fixed.
Allocation & Forecasting> Users were experiencing a delay while saving an allocation
record when there were significant number of allocations for the selected resource or
project. This was corrected.
Budget>Outside Consultant vendor type records are missing from the Created By dropdown when creating a new budget. This was corrected.
Chart of Accounts>Users were not able to delete or merge ‘Payroll Expenses - 6560'
non-system expense account. This was corrected.

























Checks>Expense entries created in checks would not get imported again if you delete
the check but keep the expense entries. This was corrected.
Client>Performance project dropdown were not displaying correct project structure
order in certain scenarios. This was corrected.
Cloud Feeds> Users were not able to change the payee for a split transaction rule that
used both item as well as accounts. This was corrected.
Cloud Feeds>Split transactions would not save as an expense entry to a project that had
"memo required for expense entry" enabled even if memo was added. This was
corrected.
Create Batch Invoice> Net Bill Amount was not getting calculated correctly if the user
updated percent complete for 'Recurring Plus Hourly' contract type projects. This was
fixed.
Dashboard> The 'Money Owed' widget would incorrectly clubbed multiple clients when
an aging filter was applied. This was fixed.
Dashboard>Cash Flow widget would display incorrect cash amounts for payments on
joint invoices. This was corrected.
Dashboard>Project Gross Margin would not display correct data when using 'This
Month' Invoice Date filter. This was fixed.
Employee> Export to CSV would only export the first 25 records. This was corrected.
Estimates>Users could assign completed, cancelled and hold projects in the Estimate list
view. This was corrected.
Expense Entries > For some users, the view by option would always show 'Employee'
even they had previously changed it to 'Vendor' and selected a vendor from the given
list. This was fixed.
Expense Entries>A billable expense would not change to non-billable when updating the
project value to an overhead or marketing project type. This was corrected.
Expense Entries>Expense entry class values were not copied over when setting the class
value in Cloud Feeds, Vendor Bill, Check or Credit Card transactions. This was corrected.
General>URL fields would not accept values without the 'www' specifier. This was
corrected.
Invoices and Payments>Search was reported not working when applying the Void
Invoices or Void Payments filter. This was corrected.
Invoices> The system would allow reuse of voided invoice numbers. This was corrected.
Invoices>In certain billing scenarios, the Phased Invoice and Phased Invoice by Expense
did not display expense detail for all projects on a combined invoice. This was fixed.
LEDES>The 'LINE_ITEM_TAX_TOTAL' was displaying the line item total instead of the total
taxes applied to the item. This was corrected.
Manage Subscriptions> Quick Search was working in Assign Subscription Dialog. This
was fixed.
MYOB Integration>Core vendor bills using the Account tab would not sync to MYOB
AccountRight. This was corrected.

























MYOB Integration>MYOB Mapping module had certain sorting issues when mapping
unmapped MYOB records. This was corrected.
Payments>In certain scenarios, users were not able post or edit a payment entry. This
was corrected.
Print Checks>Hyphen in the Zip Code field was not included when printing checks. This
was corrected.
Project Template>The Duplicate row action option was reported not duplicating the
project template correctly. This was corrected.
Project>Adding or updating the project Class value and choosing to update existing
time and expense entries, would not update the Class value on existing expense entries
or invoices. This was corrected.
Purchase Order> Purchase Order received and selected while creating a Vendor Bill
would not reflect the correct value until the bill was saved. This was corrected.
Purchase Order>Using Quick Add to add a new client would not populate the new
record in the Client field. This was corrected.
Quick Add>Core would automatically change a Client record from a Company type to an
Individual type when quick adding a Client. This was corrected.
QuickBooks Integration>Core Client Record currency value would not be recorded when
getting a Client record having Payment Currency set in QuickBooks. This was corrected.
Recurring Invoice> The system would fail to warn users if an invoice number of an invalid
length was entered. This was corrected.
Recurring Invoice> Users on non-US time zones would face an issue with the invoice
date for the automatic invoice being ahead by a day. This was fixed.
Reports>Employee Utilization report did not match Employee>Performance>Utilization
widget in certain scenarios. This was corrected.
Reports>Profit and Loss by Class Cash Basis had an issue for negative credit card
transactions. This was corrected.
Reports>Balance Sheet Accrual by Project report would not obey the project filter and
display all projects. This was corrected.
Reports>'Budget Comparison by Employee' and 'Estimate Comparison' report would
throw an error when 'Client Group' filter was applied. This was fixed.
Reports>Invoice detail where appearing as negative amounts when using drilling down
feature in Profit & Loss reports. This was corrected.
Reports>Several Budget reports would not filter data when filtering by any Budget
custom field. This was corrected.
Security>Project contract amount would show up in the split panel even when the user
did not have security to view it. This was corrected.
Time and Expense Reviewer>Users could still see the cost amount grand total when their
security profile had Time Entry>Show cost rate disabled. This was corrected.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.142 RELEASED ON NOVEMBER 16, 2019
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:

Drill down for Financial reports
All Core financial reports like Balance Sheet, P&L, General Ledger and Trial Balance now support
deep level drill down to the underlying transactions. This much awaited feature not only saves
accounting users countless hours in getting to the root of any discrepancies but also gives them
an easy way to edit transactions right from the report.

Improved Account reconciliations
We made several enhancements to the Account reconciliation process including ajax driven auto
save, more forgiving integrity checks that guarantee no reconciliation progress is lost even when
conflicts are detected by the system. These changes make the reconciliation process simpler and
more intuitive and ensure accounting users never have to redo a reconciliation session even if
they forgot to save their progress or any of the entries were modified or deleted by other users
while reconciliation was being performed.

Enhanced ePayments
Users can now send out retainer invoices with ‘Pay Now’ online payment options. Also, we
added online payment options at the Client and Project level to allow users to control which of
their Clients or Projects can have invoices with ePayment enabled.

Automatic Allocations for approved PTO
The system can now create automatic allocations when an employee PTO is approved to avoid
scheduling issues. Admin users can now set up their company to take advantage of this feature
by turning on a new global setting and keep scheduling teams always aware of upcoming PTOs’.

To-Do group assignment
This update adds a much-requested feature that allows assignment of To-dos' to employee or
vendor groups. The assigned To Do will appear on To-do lists of all group members and allow
them to record progress on the To Do as well as mark it as completed.

New and Improved Widgets
We have added two new dashboard widgets- ‘Project Allocation’ and ‘Project Allocation by
Activity’. We have also improved our ‘Money Owed widget’ with a new Aging Days filter. Also,
users can now click on the ‘Client’ column to navigate them to a filtered view of the Invoice
Collections screen.

Other improvements:















Allocation & Forecasting> Added ‘Project Groups’ and ‘Contract Type’ as filters for the
Forecasting views.
Budgets & Estimates> Users can now assign a Project when creating a new budget or
estimate.
Client> Performance screen now rolls up all widgets to reflect cumulative values when
the selected project is a main project.
Dashboard> Added more ‘As of’ date filter options.
Dashboard> Filter options for a widget now sorted by name.
Gantt Chart> Users can now batch update multiple allocations by using the 'Select all'
checkbox.
General> Added ‘Quick Add’ function for account dropdown all over the app.
General> Added the 'Attachment' column for Client, Project, Employee and Vendor lists.
General> We made it very easy to enter dates manually using keyboard. The system not
only prefills that date format but predicts the date if the user entered a partial date.
HR Benefits> HR admin users can now batch assign benefit profiles to multiple
employees at the same time.
Invoice Templates> Added 'Employee and Description' option to allow users to display
time and expense entries grouped by employee and then by time entry description.
Invoice Templates> Phased Invoices template was enhanced to automatically show extra
expenses and services as separate sections.
Notifications & Reminders> Notification panel was redesigned to allow for better
separation of system generated notifications and reminders.
Payments> We now allow users to add payments by invoice number, client or project. A
new Payment dialog presents all three options for the user.















Reports> 'Balance Sheet' reports now allow summarized as a report preview option. This
option summarizes accounts by Asset, Liability or Equity sections.
Reports> Full access users can now delete schedule reports that were created by users
who no longer have access to the application.
Reports>Project reports can now be filtered by Project Principal and Originator.
Reports>The 'Employee Paid Time Off Comparison' report now has a Balance column to
let administrators know how much PTO is available for each employee.
Reports>The Statement by Client (Accountant) template has received several corrections
to enhance its usability.
Reviewer>Added 'Type' column to the item filter to help identify the type.
Time Card> The memo box received several usability fixes including auto focus on
keyboard shortcut, a new memo icon and re-organized memo box.
Time Entries> The 'Time Verification' report now groups by Project or employee
depending upon the view by option for the screen. Also, the same report allows to show
or hide the signature section when launched from the reports area.
To-Do> Users can now clone an existing To-do and be able to change any attribute
before saving it as a new To-Do.
HR Reviews> Security admin users can now control if the HR Users can only see reviews
that are assigned to them.
Reports> 'Workflow' report can now be filtered by employee.
Workflow>Users will now be able to see the name of the employee the entry was
submitted to in the detail view of the entry.

Other fixes:








Auto Complete> The system was not able to differentiate shortcuts that spelt the same
but used different cases. This was corrected.
Budgets & Estimates>End users could not make budgets and estimates inactive when
the create date had a date prior to the Company>Closing Date. This was corrected.
Budgets>Quick Add functionality was missing from the Resource drop-down. This was
corrected.
Client>Users could not delete a client contact assigned to deleted project. This was
corrected.
Credit Memo> This screen did not have the 'Amount' column as the last column in the
list view. This was corrected.
Custom Fields> Some users could not use their custom fields as screen filters in certain
scenarios. This was corrected.
Dashboard>In certain scenarios, the Utilization percentage found in the Staff Utilization
Widget was not matching the Utilization percentage found in the Employee Performance
screen. This was fixed.


























General Journal>Row level action 'Reverse' to reverse a journal entry was labeled as
Void. This was corrected.
General> Vendor Quick Add functionality was missing from the Checks, Credit Card and
General Journal screens. This was corrected.
Integration>Core invoice with pre-tax discount did not sync to QBO with correct amount.
This was fixed.
Invoice Templates>Extra expense entries were being included in the 'Previously Billed'
column on phased invoice templates. This was corrected.
Manage Users> Admin users were not able to add a Core user who had an apostrophe in
their email address. This was fixed.
Manual Invoice> This screen was missing the 'Save and Add Another' feature. This was
corrected.
Project>Project Rule 'Memo is required for time entry' was not allowing the update of
time details in the Create Batch Invoice screen. This was fixed.
Project>Project structures created from a project template would be duplicated and/or
display incorrect structure order when searching for these projects. This was fixed.
Project>Users were unable to change project manager on a project, if their assigned
security profile has the Project>Show Contract Amount option unchecked. This was
corrected.
Purchase Order> The project column in the PO list was getting truncated. This was fixed.
Reconciliations>Draft reconciliations would show up in the Manage reconciliation list.
This was corrected.
Reminders>Reminder notification for past due vendor bill was not ignoring zero amount
bills. This was fixed.
Reports>In certain instances, recurring bill transactions would not show up on the Profit
and Loss Cash Basis report. This was corrected.
Reports>In certain instances, recurring bill transactions would not show up on the
Transaction Details Cash Basis report. This was corrected.
Reports>In certain scenarios extra expenses were being included in contract amount in
the 'Work in Progress Details' report. This was fixed.
Reports>In certain scenarios the 'Statement by Accountant’, the client balance amount
would not match the same amount found in the Invoice screen and Aging reports. This
was fixed.
Reports>Negative invoices were not shown in all statements reports. This was fixed.
Statements>The Statement by Client report would page break by Project and reset Client
totals. This was fixed.
Time Entries>Incorrect Invoice Dates were being displayed in Time Entries>Batch
Update>Invoices compared to dates found in Project>Transactions screen. This was
fixed.
Vendor Bills> Users could not create vendor bills from imported time entries if the time
entries had dates prior to Company>Closing Date. This was corrected.
Workflow>Pure vendors would show up in ‘Submit to’ drop down. This was corrected.





Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.141 RELEASED ON OCTOBER 12, 2019
What’s new in this version?

This update addressed some critical issues and added a few enhancements. Most notable:

Quick Add New: Users can now create new Clients, Projects, Employees, Vendors, Activity and
Expense codes, Budgets and Estimates by using the create new action conveniently placed on
dropdowns.
Column resizing: This update adds a highly requested feature allowing users to resize columns
like Project, Client, Description etc. We have added it to a select list of screens including Time
and Expense entry, Reviewer, Project, Invoices, Payment among others.
Improved record editing: We have extended our implicit saving technique to Time entry,
Expense entry, Activity items and Expense Items screens allowing users to modify records
without requiring a page refresh.
Power to the Vendor: Core Vendors now have a default Expense account and Class. Also, a new
'Track payments for 1099' attribute allows admin users to flag vendors that need 1099 forms.
Improved Notifications: We have made several improvements to Core's notification system.
These include consolidated notifications, refined notification messages, include date and time of
the notification and the time since. These improvements were also extended to our mobile push
notifications.

Default Home screen: Users can now set up their own start up screen. User can choose from
options like Dashboard, a specific Core screen or the last visited screen as their preference and
Core will automatically open their selected screen when logging into Core.
Reusable Vendor Bills: Accounts Payable users can now copy existing Vendors Bills along with
the items and accounts. This huge time saver also allows them to tweak the new bill before
saving it.
Batch Invoice improvements: Batch Invoice list view was reworked to allow users to discover
the 'Time & Expense details' action more easily and the details pop-up dialog now has fullscreen capability.
Configurable dropdowns: Users can now configure filter and other types of drop-downs for
preferences like including in-active items, including vendors, including completed, cancelled or
other projects etc. We have added separate settings for the most common drop downs, and
these can be turned on or off anytime.
Automatic Project Notes: A brand new global setting allows admin users to choose one or
more project attributes that can be tracked by the system to create automatic project notes.
Project notes are created when any of the tracked attributes of a project are changed.
Xero Time Entry Sync: Integration users who rely on Xero payroll can now sync Time entries
with their Xero company file. A huge feature for some of our Australian users.
Support for LEDES 1998BI V2 format: This legal industry only feature is meant to add support
to the 1998BI V2 export format for invoices. This new format keeps all of the same information
as 1998B and adds additional fields for international billing and handling taxes.
New and improved Widgets: We have made significant improvements to our Dashboard
widgets including a brand new 'Project Gross Margin' widget, spent amount for EmployeeActivity group allocations in Allocation widgets and updated the 'Paid time off and Comp time
widget' to make it work off HR benefit usage among other improvements.
Save and Add Another: We extended this feature to all Core screens. This update added it to
Vendor Bills, Purchase Order and Payments.
Custom fields for Budgets and Estimates: Users can now define custom fields for their
Budgets and Estimates.
Retainer Reconciliation: This brand-new report lists all retainer requests, retainers received, and
retainers used and groups this information by Client. The perfect tool to reconcile your retainers.

Other enhancements:





























Allocation & Forecasting> Forecasting view now computes used value for allocations
that are based on Employee and Activity group combinations.
Budgets and Estimates> Users can now search for Budgets and Estimates that have been
assigned to projects, clients or not assigned at all.
Calendar> Calendar event invites can now be sent to Employee Groups.
Dashboard> ‘Paid Time off and Comp Hours’ widget can now report off HR module data
as well.
Dashboard> Allocation widgets now compute the used portion for allocations that are
based on Employee and Activity group combination.
Dashboard> 'Employee Allocation' widget now offers a custom date filter.
Dashboard> Added Project Manager filter to 'Cash Flow' widget.
Dashboard> ’Project Status' widget now shows grand totals for all projects shown in the
widget.
Documents> Users can now attach documents to Deposits and Journal entries.
ePayment> This feature was enhanced to allow users to control automatic association of
online payment accounts to new invoices.
Fee Schedules> Users can now also search for Fee Schedules that have not been
assigned yet.
Filters> Added new date shortcut filters (Bi-Weekly, Semi-Monthly and Last 2 Weeks)
Gantt Charts> Users can export Gantt Charts to PDF and Excel formats.
General> All Accounting screens will now default 'Amount' to be the last column.
General> Project dropdowns and other lists that show Projects in hierarchical manner
can now be sorted by other columns also.
Invoice Templates> Hourly Invoice by Employee now shows the details of the Time and
Expense and shows subtotals by each employee.
Invoice Templates> Vendors can now be displayed by name or company. This is
controlled by a setting in Invoice templates.
Invoices> Added the ability to filter by Class.
Notes> Notes view now includes an indicator for attachment count.
Notifications> Users will now get notified when an RFI or Submittal has been assigned to
them.
Project> Project description field can now accommodate up to 100 characters.
Registers> Account Registers screen has been enhanced so the summary row remains
fixed.
Reports> All Employee reports can now be filtered and grouped by Department,
Manager and Groups.
Reports> Time entry reports can now be filtered by the recently added 'Paid' field.
Reports> Added Project Manager filter to 'Cash Flow Monthly Statement'.
Reports> Added Project Manager filter to 'Cash Receipts'.
Reports> All Employee reports now offer an employee status filter.
Reports> Employee Status filter now available for all Employee reports.











Reports> Time Details, Time Verification and Time and Expenses reports can now be
filtered by Paid status
Reports> View your running totals on a Daily/Weekly/Monthly & Yearly basis in the Cash
Receipt report
Security> Employee Security list view can now be filtered by Employee, Employee
groups, title and departments.
Security> We added two new system defined profiles for HR administrator and HR User.
These profiles focus on the HR functions only.
Time and Expense Reviewer> Added 'Classification' as an optional column.
Time and Expense Reviewer> Users are now prompted with more options when issuing
an 'Update Rates' batch change.
Time and Expense> Users can now have an option to update classifications as well when
issuing a bulk update for rates.
Timers> Timers have been enhanced to help differentiate between active and other
timers.
Workflow> Added new global rule that requires approvers to enter a note when
rejecting entries.
Other fixes:















Batch update>Activity Items and Expense Items> The batch update function would not
respect the 'allow access to bill and cost rates' security. This was fixed.
Expense Entries> Core allowed paid reimbursable to be marked as non-reimbursable
using the batch update tool. This is now fixed.
Billing Schedules> Invoices processed from 'Billing Schedules' would not correctly
interpret the 'Billing amount includes extra time and expense' option and markdown
expenses to zero. This was fixed.
Create Batch Invoice> Disabling 'Allow Batch Change' security would not allow a biller to
exclude expense entries when billing. This was corrected.
Dashboard and Task Allocation and Forecasting> 'Staff Workload' and 'Employee
Allocation’ widgets fail to bring in ‘Used’ hours if the allocation includes activity group
and the time was recorded to one of the activities of the group. This was fixed.
ePayment> Users could not add documents to payments made via ePayment feature.
This is now fixed.
Expense Entries> Using Paste Special in certain entry scenarios would create entries with
a blank cost rate. This was corrected.
Gantt Chart and Task Allocation and Forecasting>Using Batch Update> Pushed Tasks By
Days option on the predecessor task of two linked tasks would not push the following
task as well. This is now fixed.
Integrations> QuickBooks GET customers operation would fail in certain scenarios. This
was fixed.
Invoice Templates> Certain combined invoice scenarios would not show expense line
items on a Phased Invoice. This was fixed.



























Invoices Templates> In certain scenarios, adjusting net bill amount displayed wrong
service amounts on a Phased Invoice. This is now fixed.
Invoices Templates> The 'Current Services' amount would be zero when changing the
net bill amount for certain Phased Invoices. This was fixed.
Invoices>Invoice Emailing> Certain scenarios would cause errors when emailing invoices
to clients.
Statements> Core would use the same client name to the statement file name when
sending multiple client statements without preview. This was corrected.
Manage Subscriptions> Adding a new credit card payment method would set this as
your default payment method when no payment method has been set. This was
corrected.
Manual Invoice> Updating an Activity Code on an existing 'Draft Manual' Invoice would
blank the amount when reprocessing as Draft or Final. This was corrected.
Print Checks> Blank check issue when previewing checks was reported by some of our
Chrome browser users. This was corrected.
Project Template> Creating a Project from a Project Template would not inherit the Fee
Schedule set at the Client> Billing Options screen. This is now fixed.
Project>Performance> The Contract Analysis widget was displaying double amount in
the limit column when previewing at the root/parent project level. This was corrected.
Reports> Memorizing reports with set filters would duplicate these filters for these
reports in all Report tabs.
Report Templates> Allocated Hours report was not reporting hours in the consumed
hours column for allocations done using employee groups. This is now fixed.
Report Templates> There were certain scenarios where Profit & Loss Cash Basis and
Profit & Loss Cash Basis By Class reports were not providing correct amounts. This was
corrected.
Report Templates> Time Verification report was not displaying the correct Project
Display As value set in Global Settings>User Interface. This was corrected.
Report Templates> Work in Progress Details report date column sort was not working.
This is now fixed.
Statements>Batch Email> Message on Statement' does not get displayed on report if
you email it without preview. This is now fixed.
Time and Expense Reviewer> The on-screen Time and Expense Details would not use the
set Employee filter when displaying results. This was corrected.
Time Card>Day View> There were certain scenarios where Core would display a memo
for a time entry when none was present. This was corrected.
Time Entries and Expense Entries>Paste Special> When using Paste Special to paste
entries to an employee group, Core would not paste to all in the group if the group had
inactive employee group members. This was fixed.
Time Entries> Batch Update and Invoices> Incorrect WUD calculations after adding time
entries to invoices in several batch updates. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.140 RELEASED ON SEPTEMBER 7, 2019
What’s new in this version?

This update addressed some critical issues and added a few enhancements. Most notable:

Introducing Core ePayments
Core has partnered with leading online payment platform, Stripe to offer users the ability to
accept online payments using Credit cards. In the first version of ePayments, Core users will
be able embed “Pay Now” links to invoices and emails that are sent to Clients. Clients will
have the option to pay using Credit and Debit cards by clicking the “Pay Now” button. Core
users also get to choose which of their invoices can be paid using ePayments and can also
set up multiple online payment accounts to control surcharges and other settings. Invoices
paid using ePayments are instantly recorded and reconciled as Payment and Deposits in
Core.

Send Core Expenses to QuickBooks
QuickBooks Online users can now send employee expenses from Core to QuickBooks as
bills. An intuitive, one-time mapping UI allows users to map Core employees to QBO
vendors.

Filter reports by Custom fields
A much-awaited feature that will allow users to apply custom fields as filters to reports has
been added in this update. Custom fields that have been set up for any Core module will
automatically appear as filter options for relevant reports. e.g. Project custom fields will
appear for Aging and other billing reports.

Faster, leaner Bill Payments

We have now made it easier to review a vendor bill or a batch of vendor bills and process bill
payments right from the Vendor Bill screen. This effective change allows you to drastically
reduce your bill payment process to just a few clicks.

Standalone budgets and estimates
Core now creates a copy of the budget or estimate when cloning a project from an existing
project with a budget or estimate assigned to it. The new budget or estimate is
automatically assigned to the new project and is given the same name as that of the project.

Date your budgets and estimates
Users can now track, filter and search their budgets and estimates by date. A brand-new
attribute in the budget and estimate screen allows user to define a date for the budget.

Project templates with phase level editing
Drastically reduce the time it takes to create and update your project setups using Project
Templates. Core now allows you update project options of all your phases found in your
project templates.

Send multiple Statements Instantly
A new “Show Preview” option in Statement screen allows users to send multiple statements
without the hassle of previewing and sending each email separately.

Paid flag for Time entries
Users now have ability to mark time entries as paid for AP purposes. This option that was
already available for expense entries and allows users to exclude entries from appearing as
payables in the Bill Payment screen. Users can also specify the date when the entry was paid.

Batch actions for Time Card
Time Card users now have more control over the entries that are suggested by the system
based on previous usage. The new batch action menu allows users to remove suggestions
and also submit time entries for approval.

Cross linking in Projects
Users can navigate to other screens right from the detail view of the project by just clicking
the label next to the assigned entity.

Quick Date filters
We have modified our screen date filters to allow users to quickly switch between the
various date ranges.

Other improvements:
Accounting>Core users can now specify separate default "Discount" accounts for AR and AP
accounting.
Allocation and Forecasting>Forecasting screen can now be filtered by Project Manager.
Batch Invoicing>Projects with rule "Always show in batch invoice" will now also be evaluated
for active status before being auto populated in the batch invoice screen. Projects with
status other than "active" would be not considered for billing even if they have the "Always
show in batch invoice" rule applied.
Batch Invoicing>Billers now are notified when the system detects un-approved time and
expense entries for projects that are being billed. This is done via in-line notification that
also provides an option to preview the “un-approved time and expenses report”.
Bill Payment>"Credits Available" column now shows up by default when entering bill
payments for vendors.
Budget and Estimate>Users can now see line item cost amounts and their respective grand
totals in the Budget and Estimate screens.
Clients>Core now requires users to enter a company if the Client is being marked of type
“Company”. Similarly, when a Client is marked as "Individual", Core will require the user to
enter name for the Client.
Cloud Feeds>Added quick search capabilities to our Cloud Feeds screen.
Collections>Several improvements were done to enhance the user experience including
adding a search feature, new batch actions and columns like Invoice terms etc.
Currency>Hong Kong Currency now available in Core

Dashboard> Dashboard widgets that support date filters now get the all date range
shortcuts as filter options.
Dashboard>Added the ability to filter for inactive projects in the Due Projects widget.
Dashboard>The To-Do Widget can now be filtered by Client, Employee, Invoices, Project and
Vendor To-Do Types.
Drop Down Lists>Core now saves sort preference on all our dropdown lists.
Filters>Core will now show all selected items in filters at the top of the drop-down list. This
has been added to lists and will be added to report filters soon.
General>Core now has a Save and Add new button for all Core "Create New" screens to
facilitate faster data entry.
Global Settings>Email Settings>Users now have ability to use Client first name and the last
name as smart fields.
HR Performance Review>You can now email performance reviews directly from the
Performance Review screen.
Manual Invoice>Core users now have "Draft & Preview" and "Final & Preview" options to
preview their draft or final manual invoice.
Payments>Users can now email payment receipts to Clients right from the payment list.
Projects>Core will now group all Joint and Phased invoices by Invoice number when in the
parent project's Detail>Transaction Tab and its project type is set to Main.
Project Structure>Adding a new phase now inherits Billing Options, Account and Class
assignments from its parent project.
Project Structure>Column Headings are now locked as you scroll down your project
structure list.
Project Structure>We have included a batch action menu to allow users to merge existing
phases or delete any phases.
Project>Added new "Settlement Calculator" feature that will allow users to recalculate
project contract amounts on "percentage of contract" projects and recalculate percentage of
total project and contract amounts for all phases of the entire project.
Projects> Project clone feature now adjusts allocation start and end dates according to the
new project start date.
Projects>Users can now indicate if they want to see the Project list view expanded to reveal
the hierarchical phases or as collapsed. The preference is available under the "More" menu in
Project list and is remembered for the logged user.

Projects>Users can now see the "Fee Schedule" associated to the project in the project list
view.
Projects>Users can now see the Purchase Order Number (PO#) in the project list view.
Purchase Order>Users now have the ability of specifying vendor as address option.
Reports>Core Users can now filter all vendor related screens and reports by Vendor,
Contract Employee and Outside Consultant vendor type.
Time & Expense Reviewer>Added "Extra" as an optional column in this screen.
Time and Expense Reviewer> Added "Cost" as an optional column in this screen. This
column also includes a grand total.
Time Card> Added the "Extra" check box in the memo box. Also, memo field now allows
formatted memos to be entered.
Time Card>Added an option to show the "Client" associated with selected Project.
Time and Expense entry>Added an option to show the "Client" associated with selected
Project. Users can also now filter by Client.
Time Card>Added keyboard shortcut (CTRL+M) to open the memo box in the Time Card
screen.
Time Entries> Core now prompts users when certain time entries are locked for client
invoicing and provides the name of the biller locking these time entries.
Time Entry, Expense Entry and Reviewer>Core can now filter time and expense entries by
Employee Manager
Time Entry>Users can now Batch Update income/expense account assignment for all
unbilled time entries.
To-Do> Core users can now streamline their To-Do search by filtering the To-dos by the
Created By field.
To-Do> Users can now see the status of their To-dos in the list view.
To-Do>We streamlined the process of cloning To-dos by allowing to change the To-Do ID
and type.
To-dos> Core will now automatically update the Percent complete field to 100% when a ToDo is marked completed.
Vendor Bills> Add the "Attachment" column to indicate if there are attachments and the
number of attachments tied to the vendor bill.

Vendor Bills> Add the "Paid" and "Balance" to indicate the paid status of vendor bills.

Other fixes:
Accounting>Checks with expense items assigned to an expense account where being
displayed under the default income account when running the "General Ledger" and
“General Ledger Extended" reports. This was fixed.
Allocation & Forecasting>Forecasting columns we reported to be no longer visible when
scrolling down to the next page of allocations. This was fixed.
Allocation & Forecasting>Using the Batch Update>” Delay and Push Task by Days” options
would not update allocation start and end dates. This was fixed.
Bill Payment>When trying to pay a Vendor Bill with both a credit and payment that added
up to the sum of the Vendor Bill, the system in-correctly prompts about the payment being
greater than the bill amount. This was fixed.
Bill Payments and Expense Log>Partially paid employee reimbursable expenses would cause
discrepancies on which expense entries were paid and which were not. This was fixed.
Billing>Core would use the wrong email address in the “To” and “Cc” fields when emailing
invoice to the Client and to the project billing contact in certain scenarios. This was fixed.
Dashboard>Widgets> Users with “Full Access” security with "Account Receivable' module
view disabled were not able to see the income portion of ‘Income vs Expense' Widget. This
was fixed.
Documents>Core users reported that they could not download .msg files. This was fixed.
Expense Entries>It was reported that the on-screen Employee Expense Report would double
the Grand Total amount. This was fixed.
Expense Entries>There was an issue with viewing expense entry attachments using the
Microsoft Edge browser. This was fixed.
Expense Entries>Updating an expense entry from non-billable to billable on a project having
the "Include billable expenses in contract amount" project rule enabled would mark the
expense as Extra and not part of the contract.
Expense Entry> Batch update of the reimbursable flag was not creating the necessary behind
the scene accounting entries. This was corrected.
Expense Entry>Fixed inconsistent Copy behavior when using Select All and mouse scroll
wheel.

Human Resources>Updating an Employee Performance review would cause the Score to be
updated with an incorrect value. This was fixed.
Invoices>Extra expenses were being included in the recurring amount in a Recurring +
Hourly contract type. This was fixed.
Invoices>Joint invoices that had project/phases with more than one project manager would
not show in the Invoices list when filtering by only one of the project managers. This was
fixed.
Invoices>Users reported issues choosing a different invoice template in the Invoices screen
when using their iPad tablet. This was fixed.
Progressive scroll>Our automatic selecting of next page records when choosing the "Select
All" option and using the mouse scroll button would not allow users to unselect records. This
was fixed.
Project Assignments>Copy Assignments>Performing a wild card search in this screen would
display unrelated search results when scrolling past page 1 of results. This was fixed.
Project>End users would sometimes receive an error when trying to create a project from a
project template containing more than 100 phases and sub-phases in its project structure.
This was fixed.
Project>Our Australian customers reported that when creating a project, the start date
would display in MM/DD/YYYY instead of DD/MM/YYYY format. This was fixed.
Project>When updating client for the project, Core would still update invoice and payments
when end user clicked 'NO' to the “Do you want to update all previous/Existing invoices and
payments to the new client?” prompt. This was fixed.
Project>When using the Project Clone feature, Core would not get the next available autoincrement project number set up in Global Settings>Master Information>Project. This was
fixed.
Projects>Australian customers would export project list to csv and all dates were in
MM/DD/YYYY format. This was fixed.
Projects>When creating new projects, it was reported that the project would not inherit
options set up in Global Settings>Billing>Accounts Receivable>Options>Interest % per
month, Payment term and Charge Interest after (Days).
Purchase Order>Long Project “Display As” names would get truncated in the Purchase Order
screen. This was fixed.
Report Templates> "Vendor Bills", "Vendor Bill Status" and "Vendor Bills Paid" reports now
display the “reference number” and can be filtered by this field.

Reports>”Paid time and expense disbursements” report was missing the payment filter. This
was fixed.
Report>Project Time & Expenses report would filter its Account Summary when using dates.
This was fixed.
Reports> Financial> Core users reported that vendor bill item transactions would not show
up in the General Ledger and General Ledger Extended reports. This was fixed.
Reports> Payment Details report shows a dollar sign instead of British Pound sign in the
Grand Total for our UK customers. This was fixed.
Reports> Some Core users have reported performance time out issues when running
General Ledger reports. This was fixed.
Reports> The Client Retainer Summary report would not display correct retainer balance
when refunding unused retainers. This was fixed.
Reports>AR Aging with Credit Payments would report incorrect Credit column values when
the All Dates filter. This was fixed.
Reports>Australian users would report that Core would use and display incorrect date
ranges when using the "Last Month" and "This Month" date filters. This was fixed.
Reports>Employee Performance report is incorrectly including unbilled times that are on
overhead projects, vacation, sick, or holiday time in some of its calculations. This was fixed.
Reports>Employee Time Detail report would not display any vendor expense entries when
using the vendor in the Resource filter. This was fixed.
Reports>It was reported that the contract amounts of Parent Projects with project status of
Main were being included in the Contract Analysis report totals. This was fixed.
Reports>Project Account Details report displays Client Hours instead of Hours data in the
Hours/units Column. This was fixed.
Reports>Running the "Employee Daily Time Card" Report would display no data when using
the Time Entry Date "This Year to Date" filter.
Reports>The Check Details report would not sort by check date then by check number. This
was fixed.
Reports>The “Contract Analysis” report would double the project contract amount when the
report option "Hide Phases" was set to 'YES'. This was fixed.
Reports>” Time Verification” report received many improvements to enhance report
usability.
Reports>” Work in Hand” report received many improvements to enhance report usability.

Reports>” Work in Progress” Details report now has an option to show/hide Account
Information if the user needs to reduce the number of pages produced.
Reviewer>Core would not clear system filters when ending the approver navigated to
another screen. This was fixed.
Security>Time Entry>Employee Managers could not see employees they manage in ‘Staff
Utilization’ widget unless “Allow Access to Entries of All Employees" security is enabled. This
was fixed.
Security>Certain security profiles would not allow users to see Cloud Feed accounts. This
was fixed.
Time and Expense Reviewer> Memo field would not display properly after scrolling to the
next page and having the Reimbursable Flag column shown. This was fixed.
Time Entries>Adding time entries to an invoice with no time entries via the Batch Update
tool would not update accounting tables. This was fixed.
Time Entries>Comp time would get calculated with a weekly frequency when the frequency
was set to Bi-weekly. This was fixed.
Vendor Bill>Importing time entries into a Vendor Bill would recalculate Bill Rate and Cost
Rate already set in the Time Entries screen. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.139 RELEASED ON JULY 12, 2019
What’s new in this version?

This update addressed some critical issues and added a few enhancements. Most notable:

Core HR release to market:
Human resources management modules are now available as paid subscriptions. This
update adds numerous new features and improvements to the Human Resource
Management functions after successfully completing series of beta releases. This release to
market version for Core HR adds:
HR Administrator subscription: Full access admin level subscriptions meant for HR managers.
Users get access to all HR screens, reports and widgets.
HR Standard subscription: Limited access subscription meant for regular users that allows
them to view their Benefits, Salary history, Incidents, Journals and Reviews.

Reimagined Progressive scrolling:
In this update, we rewrote our list scrolling algorithms to achieve more responsive and lightweight page scrolling experience. The new approach keeps the page sizes at an optimum
resulting in a responsive and fast paced user experience. Users are presented with the total
number of records in the list and column totals thereby minimizing the need to scroll. This
update makes it available in all master lists, Time and Expense entry screens, Reviewer and
Allocations screen.

Faster, leaner Batch Updates:
This update replaces our batch update feature with the a more efficient and robust
algorithm. The new technique not only processes batch update operations in a fraction of
the time it took previously but also allows users to select all records at once. Users have the
option to select all records that are in view or select all records that are present for the given
list and filters.

More to Batch update:
This update adds batch update functions to some of the most requested areas of the
application. Batch update function has been added to
o
o
o

Time and Expense Reviewer
Allocations
Gantt Chart

Custom captions and new design for Dashboard widgets:

Users can now rename widgets to suit their needs. This update also showcases the new
design improvements that were made to Dashboard widgets to address accessibility and
other concerns which included displaying long project, employee and other names, fixed
column headers and handling multiple name columns.

Cloud Feeds for Time and Expense Subscription users:
This update opens the Cloud Feeds module to the Time and Expense users. Administrators
can now designate an employee to Connected credit card and other accounts giving the
employee access to all incoming feeds for that account. Time and Expense users are free to
add these feeds as expenses to Core or take other actions like ignore or match to existing
Core transactions.

Cloud Feed improvements:
This update adds the ability to batch add cloud feeds as well as split incoming feeds as
multiple line items. These splits can also be memorized as rules by indicating a percentage
or amount based preference.

Standard Invoice templates redesign:
All our standard invoice templates have been updated with a new design. The design
changes focused on providing a higher contrast and improved other design aesthetics as
well.

Security updates
This update also adds important security features to prevent and mitigate security
vulnerabilities like Cross site scripting (XSS), Cross site request forgery (CSRF) and Cross
origin resource sharing (CORS).

Other improvements:



Batch Invoicing> A new global rule allows users to specify if they want to group joint
invoices by root projects.
Cloud Feeds> Users can now edit the connected bank's nick name and associated
employee.



























Cloud Feeds> Added a new security setting that controls if managers have access to
all accounts or accounts assigned to them only.
Cloud Feeds> Users can now indicate if a line item is billable while adding a cloud
feed.
Expense Entry> Users can now specify zero cost rate for an expense and keep the
charge amount unchanged.
Forecasting view> Added filters to all forecasting views.
Forecasting View>Added the ability to sort by Project or Resource column.
General> Users can now specify email addresses up to 254 characters.
HR Reviews> Added the ability to clone existing reviews to a new review.
HR Reviews> Reviewers are now being notified via email when they are assigned a
review.
HR Reviews> Review templates list has sample data for admin users to get started on
creating their own review templates.
Integration> Users can now choose if expense details should be sent over to
AccountRight depending upon project contract or invoice type.
Integration> Users can now specify project level item accounts and Tax codes for
summarized invoices when syncing invoices from Core to Xero.
Integration> Users can now specify tax code settings for Invoices, Bills and Purchase
Orders for Core-AccountRight syncing.
Integration> Users can now specify tax rates at the item level when sending over
invoices to Xero.
Integration> We allow users to specify tax rates at item level for Xero>Sync Settings.
Invoice Templates> All system invoice templates now default to hide units by default.
Invoice Templates> All system invoice templates now group expenses by date by
default.
Invoice Templates> Client address was repositioned to show up correctly when
mailed in an envelope.
Project Performance> Added "Cost" KPI to reveal the true cost metric for the project.
Projects> Users can choose from new Client Id based options for Project display. The
new options combine the Client ID with other Project attributes.
Purchase Order> Added status as a filter for PO list view.
Report Templates> "Project Time and Expense" report received several
enhancements to increase the report's utility and readability.
Report Templates> Added a brand-new report that showcases HR review templates.
Report Templates> Added the "Billable Work History" report that provides a history
of billable work done in a company. Organized by project or client, the report
displays historical billable hours and amount for services and expenses for the last 12
months.
Report Templates> Added the "Historical Billing" report that provides information
about past billing of a company, thus indicating a billing pattern. Organized by client
or project, the report displays historical invoice amounts for the last 12 months.













Report Templates> Employee reviews report was redesigned to match industry
accepted designs for performance and other reviews.
Report Templates> RFI report now provides links to reveal a report that lists all
documents that were attached to the RFI.
Reports Screen> Added "Project Manager" filter to overdue invoices report.
Reports> Added the "Active during" filter to Allocation reports. This filters the report
for tasks that the resource will be working on for a given period regardless of the
task start and end dates.
Reports> Report descriptions of several templates were updated to describe the
report more accurately.
Security Profiles> Users can now update the name of custom Security profiles.
Security> Added “HR Administrator” and “HR User” security profiles to allow
administrators to easily assign HR functions to managers and Time & Expense
employees.
Security> Several security captions were modified to describe the setting more
appropriately.
Usability> All list views now memorize the sort order specified by the user.

Other fixes:











Time entries> Companies that widely use custom fields for time entries were
experiencing performance issues. This was fixed.
Allocations> Users were not able to add multiple notification recipients to a task. This
was fixed.
Calendar> "All Day" events would be assigned to the wrong day when the user was
in certain non-US time zones. This was fixed.
Calendar> Clients and other entities would show up in the attendee list dropdown.
This was fixed.
Credit Card>Purchase tax associated to expense entry line items was being ignored
in accounting. This was fixed.
Currency Manager> A recent update had caused the list view to show duplicate
records for some countries. This was corrected.
Custom Labels> User defined labels for Vacation, Sick and Holiday were not being
followed in PTO Dashboard widget and other places. This was fixed.
Dashboard>"Due Projects" widget would only look at the due date of parent projects
and ignore phase due dates. This was corrected.
Employee> Termination details would be reset if a terminated employee was set as
active. This was fixed.
Employee> Users were able to add To-do’s to employees that were marked as
terminated. This was fixed.
























Expense Entry> The system would incorrectly reset the cost rate to zero if an existing
entry was modified for the expense code. This was fixed.
Forecasting View> Forecasting views had a performance issue related to a large
number of allocation entries being present in the system. This was fixed.
Integration> Sending over the time entries to QuickBooks Online would in-correctly
throw an exception if the user had synced the time entries earlier. This was fixed.
Invoice Templates> Hourly and Fixed Invoice -Accountants version and Cost Plus
were missing the retainer summary. This was fixed.
Invoice> Emailing an invoice to the client in un-attended mode would not mark the
invoice as posted. This was fixed.
Invoices>Auto invoice numbering would ignore leading zeros. This was corrected.
Payment> The "Close" button for "Bounced check" dialog was not working. This was
corrected.
Print Checks> This list would show un-printed checks for inactive bank accounts. This
was fixed.
Project> Billing contact would remain assigned even when the client was updated to
a different client. This was fixed.
Recurring Checks> The system would not allow users to modify recurring checks if
the start date of the recurring entry was older than the Company closing date. This
was fixed.
Report Templates> "Collection Notes" would ignore the project manager filter and
show data for all PMs'. This was fixed.
Report Templates> Contract Analysis report would produce erroneous results when
grouping by parent projects. This was fixed.
Report Templates> Document reports would incorrectly group all documents under
one estimate record when filtering for a certain date range and estimate documents
only. This was fixed.
Report Templates>'Employee Missing Time week view' report would incorrectly
include employees who had entered more than the required hours for a given week.
This was fixed.
Report Templates>Fully paid invoice would show on AR Aging/AR Aging 8 Steps
reports when grouped by "Master project". This was corrected.
Reports Screen> Users were not able to schedule reports that had an apostrophe in
the memorized name of the report. This was fixed.
Updated report templates.
Updated help and other documentation.
Numerous other medium and minor level fixes.

VERSION 1.1.138 RELEASED ON MAY 11, 2019
What’s new in this version?

This update addressed some critical issues and added a few enhancements. Most notable:





















Report Scheduling> Custom reports can now be scheduled for automatic delivery.
Bill Payments> Users can now view the details of the vendor bills/reimbursable expenses
that were paid using Bill Payment module.
Reconciliation> Added Beginning Balance column to the "Manage Reconciliations" list.
Time Card> Time card now maintains the order of entries when changing weeks after
updating the time card.
Time Card> Time card now allows users to sort by project even if there is no time
recorded for the week.
Cloud Feeds> Added "Created By" and "Last Updated By" fields to connected banks list
view to display the user who added and last refreshed the cloud feed.
Navigation> Added quick add option for Credit Card entry in the left navigation.
Dashboard> Added review name column to "HR upcoming reviews" widget.
Dashboard> Users can now open the specific employee review record when they click on
the review name in “HR Upcoming Reviews” widget.
Documents> Added "Provider" column to all document lists to reveal the cloud provider
associated with the document.
Globalization> Added 57 new countries to the Country and currency lists.
Batch Billing> Users are now prompted if they want to mark time or expense as billed in
Batch billing>Time or expense details,
Integration> Added "Payroll setting" to AccountRight sync settings to allow users to
specify custom Payroll categories when sending over time entries to AccountRight.
Integration> Core now allows AccountRight and Xero users to choose if they want to
send MST and MET associated with invoices as line items.
Invoices> Added new invoice templates and settings that support custom ordered time
and expense entry line items in a detailed format.
Projects> Added important columns like phone, email and contact type to Project
contacts tab view.
Projects> Changing a project type from marketing to other contract types now prompts
users if they want to mark the existing time and expense for the marketing project as
billable. The user gets multiple options to choose from.
Projects> Users are now prompted if want to assign the budget, estimate or fee schedule
to the phases of a project when any of these entities is assigned at the parent project
level.










Purchase Order> Users are now prompted to confirm if they want to receive more than
the ordered number of units when receiving items against purchase orders, in case they
enter a quantity that is greater than the number of units ordered.
Report Templates> Added "Taxable Amount" column to Tax registry report to correctly
indicate the value of entries that were taxed.
Report Templates> Added new group by options to "Invoice Register" report.
Security> Context driven reports for this screen now allows the user to filter the reports
for selected employees only.
Security> It is no longer allowed to change the security profile of the owner account to
anything else than "full access".
Security> Added a security feature that invalidates user access token on sign out.
Infrastructure> Added route extension capability that will allow us to redirect requests
from apps like public API, Core AI etc. to dedicated servers.

Fixes:
















Accounting> Some accounting screens like Checks, Credit Card and Vendor Credit would
show the un-deposited funds in the account dropdown. This was corrected.
Allocations> Users were not able to select an employee or vendor group in the filter list.
This was corrected.
Allocations> Users were wrongly being notified that the task has been completed while
setting up notifications for the task. This was fixed.
Batch Billing> Project and Client Manager Dropdowns did not differentiate an employee
from a vendor. This was fixed.
Billing Schedule >Progressive scrolling not working in billing schedule when sorting
billing schedule in descending order on 'priority number' column. This was fixed.
Check> Check details report was not respecting Print status filter. This was fixed.
Checks> General Journal entry created when voiding a check was being incorrectly dated
for today's date. This was fixed to reflect the check date.
Cloud Feeds> "Manage Rule's” screen did not remember column sorting. This was fixed.
Cloud Feeds> Users were able to select main type projects as project for the time or
expense entry when adding feeds to Core. This was fixed.
Cloud Feeds> Users were not able to add an accounts based cloud feeds without
specifying a payee. This was corrected.
Cloud Feeds> When creating a transfer transaction from a bank feed, users were able to
select income and expense accounts also. This was fixed.
Create Batch Invoice> A side effect of a recent enhancement would cause the time
entries to stay locked even after the biller had exited the batch invoices screen. This was
fixed.
Credit Memo> Users were being allowed to pay more than credit memo amount when
paying off the credit memos in the pay bills screen. This was fixed.
























Deposits> Users were able to edit deposits created from cloud feeds without a warning
prompt letting them that the entry is connected to a feed. This was fixed.
Documents> File upload would occasionally fail for “Box” and “One Drive” users. This was
corrected.
Employee> Performance screen widget was using the Client hours instead of the actual
hours to calculate the Utilization. This was fixed.
Employee> Terminate employee function would check for HR subscription. This was
fixed.
Fee Schedule> Employee Control was not working when an existing service or expense
entry was being updated. This was corrected.
Fee Schedule> Users were not being prompted to enter all required fields when saving a
service or expense line item. This was corrected.
General Journal> Cloning a general journal was using the date of the original entry. This
was corrected to use today's date.
General Journal> Users were being restricted to pick only bank and credit card accounts
when creating cash General Journal entries. This restriction was removed.
General Journal> Inactive employees and vendors were showing up in the linked field
column dropdown. This was fixed.
General> Core address fields would fail to show the address in Google maps. This was
fixed.
Global Search> some characters like '#' would throw off the search and result in an error.
This was fixed.
Global Setting> Updating project "display as" settings for a company with a very large
project list would fail to complete. This was fixed.
Groups> Assign groups list view was un-necessarily showing already assigned items. This
was fixed.
Groups> Quick search for unassigned entities would take too long to retrieve results for
user with large data. This was fixed.
Integration> Sending over an invoice to Xero was incorrectly looking for Core COA
security. This was fixed.
Integration> Core employees that were synced to QuickBooks would not appear as
synced when they were converted to Vendors. This was fixed.
Integration> Invoices with line item taxes were not being synced to Xero. This was
corrected.
Integration> Users with no access to invoices and payments were not able to send these
entities to QuickBooks. This was fixed.
Integrations> "Show inactive only" would not work in QuickBooks project record
mapping. This was fixed
Integrations> Last sync date would be set to empty if the user disconnected from the
integrating software. This was fixed.
Invoice Templates> some templates would not show correct custom label for the fax
field. This was fixed.
Invoices Templates> Joint invoices would not show the retainer summary even after the
global setting rule for this setting was set to true. This was fixed.

























Invoices> “Un-post” is now restricted to only those invoices that have no payments.
Invoices> Account Summary would not include the current invoices in the “Billed to
Date” summary for draft invoices. This was fixed.
Invoices> CSV export would not respect all screen filters. This was fixed.
Invoices> the overdue column would not be calculated correctly for users other than US
time zones. This was corrected.
Invoices> Users with no access to apply discount feature were being allowed to update
invoices for discounts using the batch update feature. This was fixed.
Manage Subscriptions> Users were not able to sort records in Inactive subscription list.
This was fixed.
Manual Invoice> "Link approved TE/EE" would fail to bring up any entry in edit draft
invoice mode. This was fixed.
Manual Invoice> Filters in the approved Time expense view were not working. This was
fixed.
Performance Reviews> Review templates would incorrectly add the “additional remarks”
for free flowing text type questions. This was corrected.
Project> Project category notes created in invoice or collections screen were not
showing up in the Project>Notes view. This was fixed.
Project> Users typed text for "Message on Invoice" was incorrectly being changed to
sentence case. This was fixed.
Projects> A recent change would not allow fee schedule, budget and estimate to be
assigned at the parent project level. This was fixed.
Projects> Batch update would ignore phases and only update parent projects. This was
fixed.
Projects> Un-deposited funds account would show up in the income and expense
account dropdowns. This was fixed.
Projects> Users were not able to assign multiple projects to groups using batch update.
This was fixed.
PTO> Documents for this screen would only show the first 25 records. This was
corrected.
Purchase Order> Users were not able to select projects of type main while entering line
items for the PO. This was fixed.
QuickBooks> A certain scenario would cause the QBO time entry to be synced to the
wrong Project in Core. This was corrected.
QuickBooks> Unmapped lists would behave erratically if the user would search for
records in both the lists. This was corrected.
Manage Reconciliation > Column headers for this screen would not be persisted on
scroll. This was fixed.
Manage Reconciliation> List would only displays 25 records. This was fixed.
Recurring Invoices> Next billing date would show an incorrect next billing date when the
recurring invoice was set to process automatically. This was fixed.
Registers> Users were being allowed to pick both AP and AR accounts in the splits. This
was corrected.



























Report Templates> several financial and payments reports received a makeover and new
options and filters.
Report Templates> “Time and Expense by Parent Project” was enhanced with new filters
and options.
Report Templates> "1099/1096-MISC (US)" report’s “Show Check details" parameter fails
in a user scenario. This was fixed.
Report Templates> "Employee Performance" report would not show correct data when
the Last fiscal year filter was applied. This was fixed.
Report Templates> "Employee Utilization" report would consider comp time for
calculating employee utilization. This was fixed.
Report Templates> "Employee Utilization" report would include billable sick, vacation
and holiday hours. This was fixed.
Report Templates> "HR Benefit Usage" report was including vendors. This was corrected.
Report Templates> "Project Profitability" report did not display expense cost on the
report. This was fixed.
Report Templates> "Work in Progress details" report would ignore cost rate and cost
security. This was fixed.
Report Templates> 1099/1096 report would incorrectly double the amounts if the
vendor had more than one address specified. This was fixed
Report Templates> Added "Provider" column to the documents reports.
Report Templates> “AP Aging” reports had a performance bottleneck and would fail on
large user data. This was fixed.
Report Templates> “AP Aging with Credits” would not match with General Ledger Report
for some users. This was fixed.
Report Templates> Benefit Usage report now provides sub totals for each employee.
Report Templates> Employees exceeding the required hours would show up on the
"Missing Time" report. This was fixed.
Report Templates> some reports would use the legacy term A-Hours instead of Hours.
This was fixed.
Reports> “HR Benefit Usage” would not filter the report for the provided period date
when viewed through the Benefit usage screen. This was fixed.
Reviewer> Export as CSV would ignore the expense entries. This was fixed.
RFI> Filter by status would not work. This was fixed.
Security> "Allow Access to Custom Reports" security was being bypassed if the report
was marked as favorite. This was fixed.
Security> Profile name with an apostrophe in the name would be titled incorrectly. This
was fixed.
Submit-Approve> Approving a reimbursable expense would clear the income and
expense accounts from the expense entry in a certain security scenario. This was fixed.
Time Card> the next and previous week buttons would not work correctly for some
countries. This was corrected.
Time Entry> Fee schedules rates were not being applied when an existing time entry was
set to overtime. This was fixed.
Timer> Deleting a timer was not deleting the documents attached to it. This was fixed.








Timers> Users were able to save timers with no description. This was fixed.
Vendor> A user data scenario would cause the transaction tab to not show vendor
payments. This was fixed.
Vendor>Transactions would not be sorted correctly when sorted by descending date.
This was fixed.
Updated report templates.
Updated help and other documentation
Numerous other medium and minor level fixes.

VERSION 1.1.137 RELEASED ON APRIL 6, 2019
What’s new in this version?

This update addressed some critical issues and added a few enhancements. Most notable:



Core HR Beta improvements: As promised, this installment offers powerful new
features as well as major improvements to the existing HR offering, including:
 Employee Performance reviews
 Employee Incident management
 Employee Journal management
 HR Forms
 Enhanced Benefit management
 Time Card based benefit
 PTO-Benefit association
 Brand new HR widgets and reports
 HR specific security profiles
 In Beta and free till June 30th



Push Notification for Mobile: This update marks an important milestones for our
mobile first design philosophy. Core iOS and Android apps now support instant workflow
and other notifications that are pushed to mobile devices of users that have enabled this
feature in their Core mobile apps.



Integrated Tooltips: All Core lists and screens will now have tooltips. They offer a quick
help option that explains certain data fields, Info Bars and Widgets. Users can use this
on-demand option to get simple and effective explanations.



In-app Sample company access for paid Users: Paid users will now be able to use the
switch to “Sample” option inside their company file. They can use this option to try any
of our five sample company files. We have also placed a convenient “Exit Sample” option
to sign them back in their original company file.



Benefit InfoBar for PTO: PTO Users will now get a full snap shot of their benefit
information when requesting PTO. Non-Core HR users that use Employee permissible
hours and PTO can use this as well.



Send Time entries to MYOB AccountRight: Core - MYOB AccountRight integration
now supports sending time entries to MYOB AccountRight.



Combine Security Profiles: Admin users can now create new security profiles by
combining one or more security profiles! The new profile will contain all security settings
from all security profiles chosen.



Enhanced Global Search: Global search was enhanced for ease of use and better
handling of search results.



Custom Labels for Time off categories: Admin users can now customize time off
category labels like Vacation and Sick to a term that they use.

Other Improvements:








Create Batch Invoice> Filters and parameters defined by the biller will now be
remembered for the next billing cycle.
Create Batch Invoice>Added a new "Active Records only" switch that processes only
active records for billing.
Check Printing>Voucher details option received several enhancements that improved
the tear off section of the check to show more useful information and also handle
several scenarios.
Invoices>Added a new "Un-post" batch action to allow billers to un-post invoices.
General>Added Client Column to all Project dropdowns in the application.
Statements>Users can now specify a personalized message for each Client before
sending out statements.











Statements>Users can specify an "Aging Days" filter to narrow down clients with
pending payments.
Report Templates>General Ledger reports now provide an easy option to show the
report without details.
Report Templates>Statement reports now display the Statement date on the top of
the report.
Report Templates>"AR Aging with Credit Payments" report now includes an option
to show General Journal entries.
PTO>Time entries tied to a PTO entry are automatically updated when the
underlying PTO is modified.
MYOB AccountRight Integration>Users can now specify a Tax code for activities that
are sent over to AccountRight. This is important to handle taxes correctly when
sending over invoices.
Subscription>Billing subscription has access to all three income and expense widgets
now.
Subscription>Manager Subscription has access to "Work In Progress" report now.

Fixes:

















Activity and Expense> Item filter dropdown would include inactive items. This was fixed.
Allocation and Forecasting>Allocations that were reset to zero units in the manual view
would still show in the Allocation view instead of being removed completely. This was
fixed.
Allocation and Forecasting>In the Manual View, the spacing of columns would not
adjust based on number of columns shown or hid. This was fixed.
Auto Complete>An issue with the feature would cause it to work erratically for a large
list of similarly spelt Autocomplete shortcuts. This was fixed.
Batch Update>It was not possible to remove assigned fields like Budget, Estimate etc.
using batch update. This was fixed.
Client>Retainer Balance and Margins widget were not working on last month/custom
date filter. This was corrected.
Create Batch Invoice>Apply discount amount in percentage would cause the system to
ignore the 'Apply discount to pre-tax’ Global rule. This was fixed.
Create Batch Invoice>Invoice Memos were not getting updated via batch update. This
was corrected.
Create Batch Invoice>WUD Amount on an Extra Time Only Invoices was getting recorded
as part of contract when changing the net bill amount. This was fixed.
Custom Fields>Users were not being allowed to delete custom fields when the view
option was set to "All". This was fixed.
Dashboard>"Active Accounts" widget would include balance sheet accounts by default.
This was fixed and the widget now defaults to income and expense type accounts only
that are active in the current fiscal year.
Dashboard>Client Performance widget would incorrectly include debit payments. This
was fixed.
























Dashboard>Retainer balance widget was showing an unnecessary long list by including
Clients with no retainer activity. This was corrected.
Dashboard>Some of the widgets would show entities like Accounts in all caps. This was
fixed.
Dashboard>Staff workload widget would not handle the project filter correctly and fail
to retrieve any data. This was fixed.
Documents>User defined attachments that had the same file name were being
overwritten for Amazon storage users. This was corrected.
Expense Entry>Users with sufficient permissions to change the expense currency were
not able to change it. This was fixed.
Fee Schedule>Bill rate multiplier would not work as expected for details that specified
Employee groups. This was corrected.
Fee Schedule>Fee Schedule update would not work if the Fee schedule Cost rate was
empty and the user has no access to Cost rate. This was fixed.
Gantt chart>Month names were not being localized as per user region. This was fixed.
Globalization>Fixed a bunch of issues related to decimal character for some countries
like Belgium.
Invoice Templates>Invoice memo and TE memo setting specified for the template in GS
were not being applied. This was fixed.
Invoice Templates>Phased Invoice template was not respecting the "Show GST" rule.
This was fixed.
Invoice Templates>There were several instances when an invoice would not use the
Employee display as field. This was corrected.
Manual Invoice>"Approved Time and Expense" option would fail to show approved
entries for most manual invoice create options. This was fixed.
Payment>Add new alert that would inform the user if the required fields were not filed
by the user.
Project Assignments>An issue in the project assignments for item groups would cause
the time entries to be marked as non-billable by default. This was fixed.
Project> Users were not able to assign contract employee and outside consultants as
Project managers. This was fixed.
Project>Users with country profile different than that of the Company were not able to
save any projects. This was fixed.
Reconcile>Users were not able to reconcile system defined accounts that are eligible for
reconciliation otherwise. This was fixed.
Recurring Invoice>Back dated period invoices when processed would have all the
approved time and expense be associated with the first invoice being created. This was
fixed.
Recurring Invoices>Invoices created for recurring type contract type projects would
sometimes be created a day earlier than expected. This was fixed.
Report Template> Project Principal and Project Originator filter and group by option was
added to multiple reports including "Work in Hand", "Contract Analysis", "Gross Margin"
and "Project Profitability"























Report Templates> "Employee Utilization" report and "Staff Utilization" Dashboard
widget would show different results in some cases. This was fixed.
Report Templates>"AR Aging" reports when memorized would leave the "Show GJ"
option enabled even if the "Show Invoices" option was disabled. This was fixed.
Report Templates>All performance reports were enhanced with transaction date filters.
Report Templates>General Ledger reports now present a legend explaining the balance
column.
Report Templates>Some reports would use project ID or Name instead of relying on the
Display as attribute of the Project. This was corrected.
Report Templates>Taxes report would only show data if there were taxes collected. This
was fixed so that other information like Service and Expense amounts shows up for the
benefit of the user.
Reports Templates> Refunded retainer would not show up on the Cash Receipts report.
This was corrected.
Report Templates>Added important grouping options like Project Manager, Originator,
Contract Type etc. to many reports like 'Time and Expense by Parent Project'
Report Templates> “Trial Balance YTD” report was not respecting the fiscal year defined
for the company. This was fixed.
Report Templates>”Project Performance” report was not using the correct formula for
Earned value and Earned Value percentage fields. This was fixed.
Report Templates>Most financial reports were not respecting the fiscal year when
filtering as of a certain date. This was corrected.
Scheduled Reports>When creating a scheduled report, the schedule time would be off
by a minute for some specific time zone users. This was corrected.
Reviewer>A user with "Update" security was not able to update memo or description
unless the user was also provided "Update Rates" security. This was corrected.
Time Card>The screen would allow users to input double decimals and not warn the
users causing data loss. This was fixed.
Timer List>Newly created timers would not be displayed at the top of the list. This was
fixed.
Vendor>Performance screen would not respect the cost rate security. This was corrected.
Xero Integration>Vendor address details would get duplicated if the vendor was
updated in Xero. This was fixed.
Updated report templates.
Updated help and other documentation
Other minor fixes.

----------------------------------------------------------

VERSION 1.1.136 RELEASED ON FEBURARY 23, 2019
What’s new in this version?

This update addressed some critical issues and added a few enhancements. Most notable:


Demo video for new users: New signups are now presented with an in-app "Getting
Started" video during sign up. Trial users can also access this video by clicking the
"demo" link located conveniently in the top menu.



Know your account and reconciled balances from the Dashboard: Added a brand
new "Account Balances" widget that lists account and reconciliation balances in a bar
chart graph.



Updated Accounting widgets: Recently added accounting widgets received a face lift
and other optimizations.



Guaranteed Reconciliations: Account Reconciliation process now verifies integrity of
the reconciled transactions before saving the reconciliation.



Account Reconciliation now supports date periods: Account Reconciliation screen
now allows users control the transactions list by providing a date range filter.



Beginning balance in General Ledger reports: All General ledger reports were updated
to include beginning balance for each account. This is very useful when running reports
for date ranges.



Batch Merge Projects: Project list view now offers "Merge" as a batch action to combine
multiple projects in a single click.



Configurable project dropdowns for report filtering: Reports view now allows user
to specify if they want inactive and other projects to appear in filter drop downs.



Choose your preview format: Report preview now allows users to specify the preferred
output format. Users can choose "Viewer" or "PDF" and the choice will be remembered
for the specific report.



Print Core Subscription Invoices: Users can print/preview Core subscription invoices
from 'Billing History', Manage Subscriptions.



Xero integration now supports "Tracking Category": Core classes can now be sent to
Xero as "Tracking Category" and also imported as Classes. These two entities can
mapped as well.



Project Accounting got stronger: General Journal now allow users to associate a
Project to the line items.



Project multiplier report: Added "Project Cost Multiplier" report that calculates the cost
multiplier based on project costs and billing amounts.



Report security made easy: Report template security has now been moved to a
separate tab in Security module.

Other Improvements:














Added Over time (OT) filter to all Time entry reports.
Added "Allow access to custom fields" to Invoice security.
Added Comp Time column to the Employee Paid Time off Hours report.
Some columns like "Cost Amount' were re-positioned in Expense entry for better UX.
Added "Assigned Project(s)" column to Purchase Order list view.
Users are now warned when modifying transactions that were imported from cloud
feeds.
All AR Aging reports now provide uses an option to include General Journal entries.
Dashboard totals are now anchored to the bottom of the widget. Previously, they would
move away on scrolling.
Most list views in Core would incorrectly capitalize the first letter of Display as/ID fields.
This was fixed.
Added grand totals to forecasting range columns in Forecasting tab of A&F.
Documents list would not show any contextual reports when viewing documents related
to 'Budgets' and 'Estimates'. This was fixed.
Implemented "Add New" security to memorized and scheduled reports.
Added "Export Sales tax as a separate line item" setting to LEDES export.

Fixes:


Billing schedule reminder date would not generate a reminder for the user. This was
fixed.


























Phased and Joint invoices were not displaying Cost Plus information. This was fixed.
Project Assignments report was not displaying the billable status for activity assignments.
This was corrected.
DCAA compliance settings would not allow users to save vendor bills that were created
from scratch. This was fixed.
AP Aging with Credits report was not able handle situations where a vendor bill was
completely marked as paid using credits. This was fixed.
LEDES export would not handle “Send Item Level Sales Tax" correctly. This was fixed.
Updating an expense entry that is tied to a credit card would throw off the credit card
amount. This was fixed.
Bill and Cost rates of existing employees would be reset to 1 when invited as users. This
was fixed.
Deposit entries created from existing payments were not inheriting the class field
specified for the project. This was fixed.
An issue with the Project manager drop down would cause employees other than the
logged user to now show up. This would happen if the user had no access to the
employee screen. This was fixed.
An issue in the AP Aging report would cause it show a balance different than the Balance
Sheet. This was corrected.
Batch invoice, Export to CSV would only export the first 25 records in view. This was
corrected.
Transaction details on Cash basis report would not respect the date filters. This was fixed.
An issue in Groups assignment would cause records outside the search results to be
added to the group. This was fixed.
Auto increment invoice number feature would leave out leading zeros from the next
invoice number. This was fixed.
Batch invoice would leave out some projects when using project groups. This was
corrected.
Auto increment project Id feature would leave out leading zeros from the next project ID.
This was fixed.
An issue in Invoice Collections>Payment history would add debit type payments causing
wrong grand total. This was corrected.
Some validation errors would cause user frustration as they would not know which
specific field is failing validation. This was overcome by bringing the specific tab into
focus and red lining the field.
Several reports under Company, Employee and Project categories were enhanced for
options, look and feel and other attributes.
"Group Assignment" report would fail to preview if group filters were applied. This was
fixed.
Invoice template would fail to show the Tax ID if the masking for Tax ID was set to none
in Global Settings. This was fixed.
Several users had complained about instances where their clients had received empty
Cash receipts. This was fixed.




























Merge Vendor function would cause some of the Bill Payments associated to the original
vendor to not show up in Vendor>Transactions. This was fixed.
An issue in the "Employee Allocation" and "Staff workload" widgets would cause them to
ignore tasks with activity groups. This was fixed.
Clicking on the notifications areas was not refreshing the badge number. This was fixed
The sum of item level taxes was not being included in the INVOICE_TOTAL field of the
LEDES 1998B export. This was fixed.
Users with no access to any of the reports under one or more report categories would
still these categories. This was fixed.
Users were unable to update the retainer amount in draft manual invoice. This was fixed.
Global setting rule "Zip email attachments" would cause payment receipts to be sent as
zipped files. This was fixed.
Document tabs in Time and Expense entry view would only show the first 25 documents.
This was fixed.
User defined custom field now appear at the bottom of the filter list to facilitate ease of
use.
Subscriptions, Billing History did not show more than 25 records. This was fixed.
Users were not being prompted with a proper message if the underlying cloud
connection has been disconnected and the user was accessing a document connected to
the account. This was fixed.
Merge Activity function was not copying the documents over to the merged record. This
was fixed.
Profit and Loss widget would drop the profit line if the company has no expense entries
for last 12 months. This was fixed.
Performing a sort in Time entry would cause certain column headers to use ellipsis
instead of showing the full text. This was fixed.
Certain list view like Deposits, Fund Transfers and Credit Card screens would lose the sort
caret after filers were applied. This was fixed.
Users were able to delete bill payments even if it failed the company closing date test.
This was fixed.
Users were able to delete vendor credits even if it failed the company closing date test.
This was fixed.
Client contact e-mail tag in LEDES XML file would display the client contact's fax details
instead of e-mail. This was fixed.
GS > Auto apply retainer to invoices. The retainer was not being applied automatically to
the invoices of projects that had an active billing schedule. This was corrected.
Void Invoice template would not display PO number. This was fixed.
“Estimate Comparison by Client” report would not group by Client. This was fixed.
An issue in the event detail view would prevent users from deleting attendees. This was
fixed.
Updated report templates.
Updated help and other documentation
Numerous other fixes and optimizations.

VERSION 1.1.135 RELEASED ON JANUARY 12, 2019

What’s new in this version?
This update addressed various issues and added a few enhancements. Most notable ones
include:










Added brand new financial accounting widgets for comparative analysis of Balance Sheet
and Profit and Loss statements.
Added ‘Account Balances’ widget that allows users to see monthly and YTD balances for
active accounts.
Added the Vendor Group filter to all vendor-specific reports like 1099, Vendor Bills,
Expenses by Vendor, etc.
Enhanced the ‘Expense by Vendor’ report to include all vendor transactions along with
important details of the transaction.
Added an option to hide phases and roll up totals by parent project for few reports like
‘Project Profitability’ and ‘Contract Analysis’.
Added an option to hide late fee invoice transactions from A/R reports.
Added a new option to group Statement reports by client and then by project.
Added an option to edit the associated purchase order when receiving items for that PO.
Added the ability to specify individual vendor filters for getting vendors in Sync Settings
section of Xero integration.

Other fixes:





Checks and credit card transactions that were used to pay bills would not appear in
the Cloud Feeds, ‘Find Match’ list for the specified Core bank or credit card account.
This was corrected.
An issue in rounding for MST and MET would cause the invoice total to be off by a
penny. This was corrected.
Applying an adjustment for a credit card reconciliation account would show incorrect
journal. This was corrected.

























Bill Payments would not adjust the payment amount correctly if one or more existing
entries were excluded. This would happen for non-US companies and was corrected.
An issue in the A/P reconciliation report would not display all un-cleared
transactions. This was corrected and the un-cleared entries are now shown as a
summarized item with an option to drill down.
Income vs. Expense widget had issues for the 12 weeks filter. This was corrected.
Google Drive users were reporting multiple issues regarding connection and
accessing existing documents. These were fixed.
QB Online expenses would not come over to Core if the payment method was not
specified there. This was fixed.
Client statements emailed from the Statements screen would not respect the date
filters. This was corrected.
Cloud Feeds screen had UI issues if the company had more than 25 connected
accounts. This was fixed.
Bill Payments would not automatically reflect the correct balance for default payment
account. This was fixed.
A recent update had caused the sort caret to disappear in multiple screens after the
user had progressively scrolled the list. This was fixed.
Users were not able to delete the time and expense entries linked to a credit card,
check or vendor, and marked as billed. This was corrected.
Bill Payments detail would not show the reference number for associated bills, credit
memos or reimbursable expenses. This was fixed.
Users were able to apply payments for invoices prior to the company’s closing date.
This was fixed.
The Change Invoice Date feature in Invoices would allow users to change the invoice
date to dates prior to company’s closing date. This was fixed.
Emails sent by the Schedule Reports feature would add a system defined footer to
the email. This was removed.
Phased Invoice with Expenses would incorrectly club the tax amount for extra
expenses with non-extra expense amount. This was fixed.
The system would fail to prompt the user when deleting a reconciled bill payment.
This was corrected.
An employee with default group ‘All’ was not being assigned a default group when
converted to a vendor. This was fixed.
RFI screen based report would not respect the screen filters. This was fixed.
Info Bar in Vendor credits would not show correct summaries for some of the date
filter ranges. This was fixed.
An issue in time and expense reports would only bring in expenses when date filter
was specified. This was corrected.
A user specified credit card would not appear in the existing Credit Cards list when it
was used at least once to purchase subscriptions. This was corrected.
Users were able to delete billed time and expense entries in the Credit Cards detail
screen. This was fixed.







Credit card transactions would show the ‘Purchased From’ field as empty if the
original vendor was merged to another vendor.
Billing reports were upgraded for cosmetic changes.
Updated report templates
Updated help and other documentation
Other minor fixes

VERSION 1.1.134 RELEASED ON DECEMBER 15, 2018
What’s new in this version?
This update addressed various issues and added a few enhancements. Most notable ones
include:







‘Compose Email’ screen was enhanced to allow users to remove existing and new
attachments. A new column was added as well to show the size of attachments, allowing
them to make an informed decision before sending emails with attachments.
‘Notes’ list under productivity tools now has an option to show all notes.
Users can now specify a free flowing mask for zip codes, phone numbers and other
attributes that support masking.
Transactions like invoices can now be previewed using an in-line ‘Preview’ action in the
transactions tab of Project detail view.
Users can now update invoice memos from the detail view of an invoice.

Other fixes:







Notifications icon would not update the badge number to indicate recurring invoices
that are ready to be processed. This was corrected.
The document hyperlink column in the document list view would navigate the user to
the detail view of the document, instead of previewing the document. This was fixed.
Invoice list in payment detail view was not sorting correctly for project and invoice
numbers columns. This was corrected.
Upon applying a new payment, users were incorrectly being navigated to the payment
list even when the payment was initiated from ‘Invoices’ or ‘Invoice Collections’. This was
fixed.
Contract Analysis report would not show non-active projects even when the report was
filtered for the same. This was fixed.


























Statement reports did not print the current date. This was corrected.
Added the ‘Show Tax’ parameter to ‘Billing Forecast’ report to specify if the computed
amounts should include taxes.
Users were being allowed to void a check prior to the closing date. This was corrected.
Parent Project rules were not being copied to the underlying phases if the hierarchy was
more than one level deep. This was fixed.
An issue in the Project template logic would prevent users to create template based
projects, if one or more of the phases had the same phase description and the project
‘display as’ setting included ‘Phase Description’. This was corrected.
An issue in the Estimate detail screen would prevent users to update line item
descriptions. This was fixed.
An issue in the Project structure tab would prevent users from updating contract
amounts. This was fixed.
Invoices belonging to a project that used a custom invoice template would fail to
preview when opened from the project detail view. This was corrected.
Creating a new budget with an apostrophe character in the budget name would throw
an error. This was fixed.
‘AP Aging with Credits’ report would show a balance even though credit memo
transactions had been paid. This was fixed.
Client and Budget reports were refreshed with cosmetic updates.
An issue with ‘Fee Schedules’ report would make the report not hide the cost rate even if
the security specified otherwise. This was fixed.
‘Fund transfers’ list would not remember the last used date filter. This was fixed.
An issue in code would mark a reimbursable expense as non-reimbursable after the paid
flag was updated to false. This was fixed.
The module column in ‘Document’ list view under productivity tools would show up as
empty in certain scenarios. This was fixed.
Statement report would add a blank page between invoices that were associated with
the same project but billed to different contact addresses. This was fixed.
‘Bill Payment’ transactions that were already reconciled would appear as ‘not reconciled’
in the Credit Card register. This was fixed.
Few restricted account types such as ‘Accounts Payable’ were appearing in the income
and expense account dropdown in Project view. This was fixed.
Time entry memo created out of text that was pre-formatted and copied to the memo
box would appear garbled in the Invoice detail view. This was fixed.
The system was allowing users to create recurring invoices for projects that had already
been completed. This was corrected.
Updated report templates.
Updated help and other documentation
Other minor fixes.

VERSION 1.1.133 RELEASED ON DECEMBER 1, 2018
What’s new in this version?
This update addressed various issues and added a few enhancements. Most notable ones
include:









Added the ability to update the ‘Principal’ and ‘Originator’ fields for multiple projects
using the batch change action in Projects list.
Added default sort order to Clients, Employees, and Vendors, Classes, RFIs, To-Dos and
Notes screens.
When changing Project Account in Projects > Billing Options, users can now decide if
existing time and expense should be updated with the option to choose from ‘All’,
‘Billed’, ‘Un-Billed’ or ‘None’.
Added the Payee column to ‘Accounts Reconciliation’ screen.
Invoice register report now provides an option to view draft invoices also.
Added the ‘Name’ column to ‘General Ledger-Extended’ report for vendor bill and other
transactions.
Core will now remember the search text in the any of the list views when the user
navigates to the detail view and then navigate back to the list view.
Other fixes:




Grouping the ‘Billing Forecast’ report by ‘Master Project’ would sometimes show
incorrect billed amount for project phases on joint/combined invoices. This was fixed.
Overtime calculations were not consistent when using the Automatic Overtime feature
versus the Overtime calculator. This was fixed.

























When paying reimbursable expenses, users would get a "You cannot apply payments
more than the pay amount" error. This was handled.
Added default sort to the Project column in the ‘Manual’ view of Allocation &
Forecasting.
Project rule "Use rates from Activity Items screen" was re-labeled to clarify that it
includes both cost and bill rates.
‘Billing’ and ‘Manager’ Package users could see certain standard and custom financial
accounting reports. This was prevented.
Using the Cloud Feeds > Find Match option would display a list of duplicate credit card
payments entered in Core. This was corrected.
Enabling the “Mark projects completed when 100% billed” in Global Setting would
incorrectly update project phases on joint/combined invoices that were not billed 100%
of the contract amount. This was fixed.
Files added directly from the Documents or Purchase Orders screen would not get
attached when a PO was emailed from the Email > Compose Mail screen. This was fixed.
When previewing a combined invoice, Core would sometimes display incorrect PO
number for projects with different PO numbers. This was corrected.
The Class assignment at the Project level would not be inherited by the project in the
Edit Checks screen. This was fixed.
Employee Control ‘Billable’ flag setting was not being applied when creating transactions
in the Checks, Credit Cards, Vendor Bills and Cloud Feeds screen. This was implemented.
Sort order was not remembered when refreshing some screens. This was fixed.
The Project Allocation and Employee Allocation Units reports would not show accurate
data for allocation entries with no end date. This was fixed.
Memo added to a retainer invoice did not show up on previewing that invoice. This was
corrected.
Employee Control was not being obeyed when using the Cloud Feeds > Find Match
option. This was fixed.
Users were able to create purchase orders for ‘completed’ projects using Budgets >
Create Purchase Orders option. This was fixed.
Updating the date of a check with linked time or expenses would also update the time
and expense entry date. This was fixed.
Un-posted entries of accounts linked in Cloud Feeds were being included in the Cloud
Feeds > Pending Transactions total. This was corrected.
Phased Invoice template would not display column headers on its second page. This was
fixed.
When using the ‘As Of’ period filter in the Purchase Orders list screen, Core would
display duplicate POs when scrolling down to the next page of the list. This was fixed.
The on-screen Vendor Bill List report was applying the screen filters. This was fixed.
Help file was updated.
Several other minor general and report fixes were made.

VERSION 1.1.132 RELEASED ON NOVEMBER 17, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable ones
include:





Added the ‘Mailing Labels’ report with options to generate mailing labels from the client,
project, employee and vendor address records.
Added the ‘Group Assignment’ report that displays assigned groups. This report can be
run for projects, clients, employees, vendors, activity and expense codes.
A memorized report marked as public can now be customized by users other than the
original author.
Scheduled reports can now be marked as public to make them available for other users.

Other fixes:
 Excluding a reimbursable expense in the Bill Payments screen would clear its
‘Reimbursable’ flag.
 There was no sort feature on the Memorized, Scheduled, Custom and Favorite tabs in the
Reports screen. Also, the Group/Report grid list had an unnecessary Description field.
That was removed.
 Added the "Allow access to Custom Reports" security permission in the Security >
Reports screen.
 The Employee Control security permissions were not being implemented in the Checks
and Credit Cards screen.
 Employee Control was not being implemented in the Cloud Feeds screen.
 Item level taxes on manual invoices would not show up in the Taxes report in some
cases.
 Credit-type, write-offs and debit payments were not being excluded from the Cash Flow
widget calculations on the Dashboard.
 The Expense Entries Multiplier field was editable for entries that were already paid or
linked to vendor bills.
 The Phased Invoice template did not include billable negative entries in its Grand Total
calculations.
 In the Project Assignments screen, the Project drop-down did not obey the Global
Settings > User Interface > Display As settings.
 Sometimes assigning an invoice template to the corresponding project from the Invoices
> Preview > Choose Template screen would not save the new template setting. This
happened to regular invoices as well as joint/combined invoices.
 In the Account Reconciliation History screen, the Reconciled On date would not reflect
the correct date when users actually did the reconciliation.
 Notes in the Invoice Collections screen would not display in chronological order or
sometimes would display blank values.
 The ‘Retainer Details by Project’ report would not obey the "Payment Date As Of" filter.

















In certain cases, HTML data would show up in the Time Detail memos while looking at
the invoice details.
Purchase order reports would display duplicate or triplicate line items in case the
vendors had two or three address records.
When adding attachments to an expense entry with filters on in the Expense Entries
screen, it would remove the filters.
When changing the project Due Date label to a different value, the new label would not
show up in the report filters.
At times, the Profit and Loss Accrual Basis report did not match the General Ledger
report.
MYOB Record Mappings screen would display duplicate vendor bill entries in certain
cases.
Column header did not remain fixed when scrolling down in the Cloud Feeds screen on
both the Ignored and Included tab.
When combining invoices in the Create Batch Invoice screen, the % complete field would
report a value above 100% in certain scenarios.
When exporting data using the More > Export to CSV option in Estimates, incorrect
values were being exported.
The delay value set in the Allocation & Forecasting screen was not followed when the
current task was a milestone and dependent on another task.
Errors would occur when making payments on a long list of invoices belonging to a
single client.
When selecting a parent project to make a payment, a user was unable to see all the
open invoices in the Payments screen.
Updated report templates.
Updated help file and documentation.
Several other enhancements and fixes were made.

VERSION 1.1.131 RELEASED ON NOVEMBER 03, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:










Added the much requested “Tax Tracking” report. This report lists taxes paid, collected
and owed for each project.
Added search feature in “Create from existing budget” dialog in Budget screen.
Users now have the ability to clone a To-Do from the To-Do list under productivity tools.
Aging reports can now be grouped by originator, principal and project manager
attributes of a project.
Added Time-off column to benefit usage list view in Employee.
Company Tax ID now uses a default mask of ‘XX-XXXXXXX’ for US companies.
Added enable/disable ‘Conflict checking’ option in Gantt Chart screen.
Users can now add multiple deposits and fund transfers using the ‘Save & Add New’
button.
Users can now preview attachments directly from the reviewer screen.

Other fixes:













Allocation and Forecasting screen would incorrectly consider the accounting “Closing
Date” of the company while making and updating task allocations. This was corrected.
Cloud Feeds balance column was not updating the balance column upon refresh. This
was fixed.
Cloud feeds refresh would fail in scenarios where the user had connected non-monetary
accounts like rewards. This was corrected.
AP aging report would not reflect the credits used to pay vendor bills and show them as
unpaid. This was fixed.
When using currency “Smart Fields”, currency fields were not properly formatted. This
was fixed
‘Retainer Invoice’ would show incorrect client contact details under some scenarios. This
was fixed.
The ‘Time Card Week View’ report would display data in incorrect week order for some
users. This was fixed.
Phased Invoices for recurring contract type projects would incorrectly include time and
expense details along with the recurring amount. This was corrected.
‘Percentage Billed’ report would show a different contract balance when compared to
the project structure screen. This was corrected.
Chart of Accounts screen would fail to retrieve all the sub-accounts upon list scroll. This
was corrected.
Notifications related to Invoices submittal or approval would at times fail to generate.
This was fixed.
Duplicate Vendor bills would appear in ‘Bill Payments’ screen under some rare scenarios.
It was fixed.












Journal report would not consider purchase tax against a credit card entry. This was
corrected.
Added the ability to sort ‘find match’ list of ‘Cloud Feeds’ screen.
Added new security setting ‘Show Salary Amount’ to control access to salary amount
field in Employee screen.
Users with time and expense only subscription would fail to access the ‘Employee Half
Monthly Time Card ‘report. This was fixed.
Items automatically reconciled by bank feed were not being flagged as cleared. This was
corrected.
Statement of Cash Flows report would incorrectly include General Journal entry. This was
corrected.
When selecting all invoices to show up on Statement reports, fully paid invoices would
not show up. This was fixed
Updated reports for performance and bug fixes.
Updated documentation.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.130 RELEASED ON OCTOBER 20, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:









Added the much requested, “Statement by Client (Accountant)” report that can be
shared with clients with a listing of unpaid invoices and tear off section to remit
payments.
Added the ability to show or hide the Invoice Number column in the Time and Expense
Entry screens.
Added grand total to the amount column in the Payment screen.
The default duration for a new calendar event has been changed to one hour.
Added Date, Submittal Type and Project "Group By" report options to the Workflow
Detail report.
The connection history list in integrations area can now be sorted by date.
The integrations area was refreshed with new design to comply with third party
integration guidelines.

Other fixes:


Sending tax invoices to Xero would create double tax invoices in Xero in certain
scenarios. This was fixed.

























The ID column in the Create from Existing Estimate screen would not accommodate long
estimate names. This was corrected.
In certain scenarios, exporting an invoice to PDF would add an extra item, unit and
amount column headers. This was fixed.
Manual invoices would create duplicate values in the Activity Performance Widget in
some scenarios. This was fixed.
Projects with the "Prevent time entry for the project" project rule enabled, would not
show up in the Add Checks>Project column dropdown list. This was fixed.
Exporting invoice records from the Invoices screen to CSV now includes Client column
data.
Top N Expenses report would show incorrect report title in certain situations.
Used Percentage column would incorrectly round below .5% usage to 0%. This was
fixed.
In certain scenarios, the Auto Apply feature in the Payment screen would not work when
editing a payment for 2 or more invoices.
When creating a Retainer Invoice with no due date, it did not display 'due upon receipt'
under terms. This was fixed.
Deleting or voiding a NSF payment would create a negative invoice balance in certain
scenarios. This was fixed.
Vendor screen filters were not being obeyed when previewing on-screen reports. This
was fixed.
Summary total failed to update when adding a new allocation value in Allocation &
Forecasting-Forecasting>Manual View. This was fixed.
Purchase Order screen filtered by vendor did not get applied to the "Purchase Order
Time and Expense Details" report. This was fixed.
Column headers would not display as you scroll down the Security Profiles screen. This
was fixed.
Group filters applied to Client, Employee and Project screens were not applied when
running on-screen reports. This was fixed.
Journal report would show General Journal detail as negative debit value instead of a
credit value in some scenarios. This was fixed.
Clicking yes to "Invoice includes vendor bill(s) would you like to review" Payment screen
message would redirect to the Bill Payment screen. This was fixed.
In a scenario where ‘Project ID - Name' or 'Name-Project ID' value was more than 15
characters, the forecasting screen was unable to display all of its columns. This was fixed.
The Status filter in the Submittal and Drawing screens was not being applied when
running their respective on-screen reports.
Start and end date filters in the Benefit List screen were not being applied when running
HR Benefit List on-screen report. This was fixed.
Time and Expense on-screen report did not use Vendor group filter in the Reviewer
screen. This was fixed.
Spent column of Project contract status incorrectly included unapproved time and
expense. This was fixed.
Line item total in LEDES 1998B file did not include expense entry markup. This was fixed.















Incorrect data issue when using a Client date type custom field when mapping the LEDES
1998B CLIENT_MATTER_ID. This was fixed.
Journal report would show incorrect debits and credits for Credit card refunds and
credits. This was fixed.
Journal report was not correctly handling an invoice that had negative expense. This was
corrected.
An unintended “[]” line terminator would show on every invoice line item when exporting
a LEDES 1998B file. This was fixed.
“To Do” widget did not display vendor records in the “Assigned to” filter drop-down list.
This was fixed.
Getting QuickBooks Online “Projects” to Core and sending phases created under these
projects to QuickBooks Online would error out. This was fixed.
Statement reports would incorrectly show all invoices instead of open invoices only. This
was fixed.
Work In Hand report now sorts the Group by option alphabetically.
Getting MYOB AccountRight Project that had "Project Manager" Display As values that
were not linked with a Core employee record, would create additional employee records.
This was fixed.
Updated reports for performance and bug fixes.
Updated documentation.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.129 RELEASED ON OCTOBER 06, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable ones
are:






















Added a new report to track benefit usage. The report calculates earned, used and
remaining benefits for employees.
The ‘AP Reconciliation’ report would not include un-cleared transactions. This was fixed.
An issue in the project structure view would in-correctly set the project contract amount
to 0. This was fixed.
Certain Canadian customers would receive errors when scheduling a report. This was
fixed.
Project List screen would not remember sort order when refreshing the screen. This was
fixed.
Creating a new project structure using templates would not copy project assignments for
the new structure. This was fixed.
‘Overdue Invoices’ report was updated to display the name of projects on when showing
a joint invoice records.
The statement report would not obey the name that was set in the Global Setting screen
using smart fields. This was fixed.
Fixed certain scenarios when Time Entry, Expense Entry and PTO Request Records would
have a default to yesterday’s date instead of current date. This was corrected.
Resolved accounting mismatch on the Journal report for checks having positive and
negative check line entries.
LEDES export now allows to associate either Client Id or Matter ID to client matter.
‘Monthly Billing Statement’ report was fixed to not include retainer amounts applied
during invoice creation.
‘Statement of Cash Flows’ report would not obey the period 'Last week' filter. This was
fixed.
Fixed an issue where cancelling a ‘create project from template’ action would still create
the project structure.
Fixed issue where batch updating the invoice date would not update the underlying
transaction date. This was fixed.
A certain bug would not allow statements to preview. This was fixed.
The ‘Budget Comparison by Employee’ report would incorrectly show 'Employee Name'
instead of 'Employee Title' when viewed by title. This was corrected.
Updated Allocation and Forecasting report to display non-allocation 'Other Tasks' as a
positive number instead of a negative one.
Custom Invoice template would not preview in Invoice Collections screen. This was fixed
Under some certain scenarios, un-cleared unreconciled transactions would show as
cleared in Accounts Reconciliation screen.
A user with billing subscription but missing Manager Subscription was not able to filter
invoices for projects. This was corrected.





Creating a report scheduling record would require at least one filter. This was corrected
Updated reports for performance and bug fixes.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.128.0 RELEASED ON SEPTEMBER 14, 2018
What’s new in this version?
Introducing Core HR beta! Core now offers powerful HR management features such as:
 Benefits assignment and usage
 Salary change and history
Core's HR feature gives managers the ability to track and regulate employee benefits, salary
reviews and much more.
We value your feedback, so if you have something to share then email us at
corehr.feedback@bqe.com
This update also addressed some critical issues and added a few enhancements. Most notable
ones are:


Project Managers can now preview an invoice from the Project Transactions tab.



The pending transaction state of cloud feeds would cause the feeds to duplicate in Core.
It was corrected.



The ‘Law Firm ID’ and ‘Invoice Description’ fields were not getting populated on the
LEDES export file. This was corrected.



‘Law Firm Matter ID’ field was incorrectly considering the Global Settings >LEDES->Client
ID and Project ID mapping settings. This is now mapped to the Project ID field.



'Info Bar' of the Personal Time Off Requests screen would not default to the current YTD
range. This was corrected.



Added various 'Transaction Type' filters to the 'General Ledger' report.



There was a data mismatch between 'General Ledger' and 'General Ledger Extended'
reports in certain user company scenarios



Added period filter ‘Last Two Weeks’ in the Reports screen.



The initial load performance for ‘'Time and Expense'’ report was optimized for large data
files.



In certain scenarios, the user preference setting ‘Auto-fill Time Card with the last x
projects/activities' would not display all time entries an end user entered in the Time
Card. This was fixed.



The 'Contract Employee’ filter is now added to the 'Project Performance' report.



Core would incorrectly change Workflow Status from 'Submitted' to 'Forward' or
'Forward' to 'Submitted' when submitting a time entry multiple times.



The 'Client Transaction' report displayed no data when using 'All Dates' or 'As Of' date
filters.



The 'Trial Balance Accrual' report would create duplicate entries when exporting to CSV
file.



Formatting issues occurred when emailing or printing certain statement reports using
reports options. These issues were found in the 'Reports' and 'Statements' screens.



Invoice Date would not default to the current date for our Australian region users. This
would happen when creating invoices in both Create Batch Invoice and Manual Invoice
screens. This was fixed.



The 'Percentage Billed' report showed incorrect 'Contract Bal' and '% Billed' column data
in certain scenarios. This was corrected.



'Credit' and 'Write off' payment types were not being sent to Xero during data
integration. This was fixed.



When creating a new budget from an existing budget, the 'Create from Existing Budget'
screen would not allow sorting. This was fixed.



Renamed 'Project Allocation Units Spent Forecast' report to 'Project Allocation Units
Spent Distributive Forecast' and 'Project Allocation Earned Revenue Distributive Forecast'
report added.



Added ‘Manager’ field to the Batch Update screen in ‘Projects’.



Updated reports for performance and bug fixes.



Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.127 RELEASED ON SEPTEMBER 01, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable ones
are:



‘General Ledger’ report load performance optimized for large data files.
Joint invoices would sometimes incorrectly round tax amounts.




























Scheduled ‘Time Card Week View’ report would not obey filters.
‘Bill Payment Credits Available’ and ‘Total Credits Used’ columns would not update when
using the credits in the ‘Create Bill Payments’ screen.
Performing any actions in ‘Expense Details’ tab and then undoing these actions would
cause the ‘Invoices’ screen to freeze. This was fixed.
‘Fixed Fee – Accounting’ invoice templates would display HTML markup text instead of
actual text on the Invoice field.
Certain ArchiOffice migrated company files would get duplicate invoices.
Core project names with colons sent to MYOB projects would have incorrect project
name values.
Core would not remember ‘Show Entry Details’ setting when enabled for the end user in
the Time Card screen.
In certain cases, having the Time Entries and Invoices screens open in two separate
browser tabs would incorrectly show time entries as billed (status). This would happen
when deleting an invoice and updating “billed” time entries in the Time Entries screen.
Parent project name having apostrophe would sometimes not show its phases in the
‘Create Batch Invoice’ screen when using the Filter by > Project > Individual Items.
‘Project Contract Status’ report would not obey Project Status filter.
‘Work in Progress Details’ report did not show the correct project manager in the Project
field.
‘Automatically assign this template to corresponding project’ option in Choose Template
dialog in Invoices screen was not working.
In the Allocated Hours report, the ‘Assigned Hours’ and ‘Consumed Hours’ columns
would show incorrect data in some cases.
Added tool-tip to the Class field in the Edit Check screen.
In the ‘Statement of Cash Flows’ report, the ‘Net Income’ field did not reconcile with the
Profit & Loss report.
Added search capability to the ‘Email Recipients’ drop-down list when scheduling
reports.
‘AP Reconciliation Discrepancies’ report would not obey the ‘Accounts’ filter.
Invoices would disappear in the ‘Invoice Collections’ screen when showing ‘Closed’
invoices and changing the ‘Period’ filter.
‘Vendor Bill List’ report would incorrectly show client hours instead of actual hours.
Batch Update would cause billing contacts to be removed in some cases in project
screen. This was fixed.
Xero duplicate invoices were being created in certain scenarios when sending joint
invoices and then sending payments on joint invoices to Xero.
When the user had a lot of bills to pay in the ‘Create Bill Payment’ screen, sorting by
Payee caused ‘Page Unresponsive’ errors. Also, the ‘Print Checks’ screen became
unusable. This was optimized.
‘General Ledger’, ‘General Ledger Extended’ & ‘Trial Balance’ reports did not display
‘Cash Type’ journal entries.
Projects with type ‘main’ look visually distinct now (greyed out and bold) in the
‘Payments’, ‘Invoices’ and ‘Create Batch Invoice’ screens.












‘Firm Reconciliation’ report would not show data when using the ‘Invoice Date’ filter.
Billing a ‘Fixed’ contract type project to 100% that also has extra time entry amount did
not add the extra amount to the invoice created. Only the 100% contract amount got
billed. This was fixed.
‘Personal Time Off Requests’ screen ‘Info Bar’ would not obey the ‘Submitted’, ’Rejected’
and ‘Approved’ filters.
Applying an ‘Interest Charge’ in the Account Reconciliations screen would not let user
reconcile the account.
Users could not delete project structures because certain phases with ‘Hold’ project
status would not show up in the Project list. This was fixed.
Allocation reports now obey the ‘First day of the week’ global setting.
Removed duplicate ‘Is Active’ filter for the ‘Purchase Order Invoice’ report.
Few customers were not able to add Google Drive as cloud storage destination. This was
fixed
Bug fixes and stability improvements.
_____________________________________________________

VERSION 1.1.126 RELEASED ON AUGUST 18, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable ones
are:













Added new security setting to control access to bill and cost rate column in Fee Schedule
screen.
The Invoice Collections screen now allows you to view the ‘Workflow History’ along with
other transaction details.
Sending Vendor Bills to QuickBooks would skip if there were no project associations. We
have improved sync error handling and logging; the log file now says which projects
failed during the sync.
Added ‘Contract Type’ filter to all time and expense reports.
The period filter ‘Last Month’ would incorrectly display dates on the reports. This was
corrected.
For Check Details report, the ‘Check Number’ filter drop-down would incorrectly show
‘To Be Printed’. This was corrected.
‘Message on Invoice’ field with long text would not display properly on Clients screen.
Creating a new project from a template with phases would not copy the phase structure
project name from the template to the new project structure. This was fixed.
Revised Name and Description of many Core invoice templates.
Users were unable to apply any filter in the Statements screen. This was fixed.
Added ‘Check Number’ filter to the ‘Expense Details’ report.



























Adding a new allocation in the ‘Allocation & Forecasting’ screen using the keyboard
would throw an error. This was fixed.
Client contact details like ‘Email’ and ‘Phone’ would not show up in the ‘Invoice
Collections’ list view. This was fixed.
Core® would fail to import a large number of invoices from Xero®. This was fixed.
‘Company YTD Comparison’ report would not respect the Fiscal Year dates for both
previous and current year. This was fixed.
‘Project Performance’ widget on the Dashboard would allow everyone to see the projects
even though their security setting ‘Allow Access to other Managers Data’ prevented it.
This was fixed.
Under some rare conditions, editing a Purchase Order line item would sometimes
duplicate the ‘Line Number’ of the entry. This was fixed.
The text under ‘Class’ dropdown list would appear truncated in ‘Edit Check’ screen. This
was fixed.
‘Balance Due’ field in Invoices would sometimes display the incorrect amount due to
rounding issue. It is corrected now.
Using the From-To range filters would not send records to QuickBooks. This is fixed now.
Sending retainer payments created in Core to MYOB would fail. This was fixed.
Syncing joint invoices from Core to Xero would remain unlinked in Core and get
duplicated in Xero. This was fixed.
After getting MYOB Vendor Bills of Service and Professional types into Core, if you resync them to MYOB, instead of overwriting, it would create duplicates in MYOB. This was
fixed.
Accounts Payable report in the Registers screen would not respect Net Terms set in
Vendor Bills. It would always show Term Net 30. This was fixed.
‘Purchase Order Time and Expense Details’ report would not respect the screen filter
‘Due Date’ and ‘Workflow Status’ filters. This was fixed.
Duplicate entries showed up when there were more than 25 checks in the Recurring
Checks screen. This was fixed.
‘Client Retainer Summary’ report would not display correct Retainer Used totals when
using client and project retainers. This was fixed.
‘General Ledger’ report did not display corresponding transactions when using the Time
Entry Date filter. This was fixed.
When trying to update the Payee of a check through the Bank Account register, it did
not update. This could be seen when editing the same check in the Edit Check screen.
This was fixed.
With the LEDES setting ‘Send item level sales tax as a separate line item’, tax amount was
displayed twice on the export file. This was fixed.
Changing the ‘State’ custom label would incorrectly apply the change to the screens and
reports. This was fixed.
Project Retainer Available would not get displayed when creating payment via the
Project drop-down option. This was fixed.
Selecting multiple draft invoices and exporting to LEDES 1998B format would display the
same invoice number for all the records in the export file. Also, there was no way to







differentiate between finalized and draft invoices when using LEDES 1998B format. This
was fixed.
Changing project’s A/R account including existing invoices and payments did not change
the Payment’s A/R account. This was fixed.
‘Send attachments as single file’ setting would incorrectly include the invoice PDF file
inside the zipped folder. Invoice pdf file should be separate from the zip file. This was
fixed.
Updated reports for performance and bug fixes.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.125 RELEASED ON AUGUST 04, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:















Users with privileged access can now manage timers for all users in the timer list view.
Added new security setting to control access to bill and cost rate column in budgets and
estimates.
Employee missing time report was improved to only show employees that have not met
the required daily hours specified for them in the Employee screen. The report also looks
at the work days specified in the global settings to determine which employees are
missing time for the specified week.
Export to Excel feature for reports received a major overhaul to handle numeric and
currency fields. Users can now use the excel output to create summary columns or add
their own formulae. This update applies this fix to selected reports like Contract Analysis,
Account Transactions and all PL reports.
This update adds a critical fix to a persistent issue which forced some of the users to
clear their local cache immediately after an update.
Project structure tab in Project detail view was not able to correctly roll up spent and
other amounts for a project structure that had main projects at a hierarchical level other
than the top. This was fixed.
Scheduled tab in the reports area was not respecting custom labels. This was fixed.
Time expense reviewer would show duplicate rows after a sort was performed and the
user would scroll to retrieve another page of results. This was corrected.
Memorizing a vendor bill with multiple accounts line items would duplicate the line
items when processed. This was fixed.
A rare scenario in the time card would cause duplicate time entries being saved. This was
fixed.
PTO InfoBar would incorrectly show zero values when submittal filters were applied to
the list. This was fixed.









Overtime calculator would repeat time entries on progressive scroll of the list if no sort
option was provide by the user. This was fixed.
Time and expense by parent project reports would not respect any filters provided by
the user. This was fixed.
Screen reports in the reviewer screen did not respect the class filters. This was corrected.
Screen reports in the Credit memo screen did not respect any filters. This was corrected.
“Run Schedule” option for schedule reports would incorrectly zip the report pdf if the
global setting, “Automatically zip multiple attachments” was checked. This was fixed.
Updated reports for performance and bug fixes.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.124 RELEASED ON JULY 20, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:
















Dashboard widgets now allow users to specify custom date ranges.
Time and expense entry screens now prefill the date field with the today’s date while
creating a new entry.
This update implements an API engine enhancement that mitigates most issues related
to concurrent record update scenarios.
Workflow accordion was added to Invoices, Vendor bills and Purchase orders.
Added Project Manager Column to Invoice list view.
Added the much requested “Missing Time” report to allow managers to actively monitor
time card completion.
Funds transfer screen would limit the user to 25 records only. This was corrected.
Batch update of “Automatic overtime” field in Employee list view now allows to turn off
this setting for one or more users.
Implemented wild card based search in assign screen of groups.
Account reconciliation screen would omit transactions of type “credit card credit”. This
was corrected.
Work flow details report was enhanced to provide users with detailed log of
submit/approve history.
Implemented a real time progress indicator for Xero sync.
Xero integration sync settings would not obey the filters specified by the user. This was
fixed.
Xero integration would fail to retrieve all the records from the corresponding Xero
module and restrict the sync to just 100 records. This was fixed
Project template edit view would not allow users to choose a custom invoice template.
This was corrected.













Time entries send to QuickBooks were not being correctly calculated into hours in
HH:MM format. This was corrected.
Payment list view would not load all historical payments when the list was filtered by a
custom date range. This was corrected.
Batch update of “Message on Invoice” for selected projects would restrict users to
message of certain length. This was fixed.
Activity list view would fail to retrieve all records if a batch update was performed. This
was fixed.
An issue in the invited user on-boarding was preventing users from signing in after
accepting the invite. This was fixed.
Completed projects were appearing in create new recurring invoice screen. This was
fixed.
Top 10 revenue report would display duplicate filters. This was corrected.
Classification dropdown was missing the ability to sort. This was fixed.
Updating a project for an existing entry in Time card would not use the correct rates and
classification, if the project had a fee schedule or an assignment. This was fixed.
Updated reports for performance and bug fixes.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.123 RELEASED ON JULY 6, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:










Time card screen now allows users to view submittal status of an entry using specific
icons.
Record mapping section added to Core-Xero Account integration module.
Added two new Manual invoice templates:
 With tax and percent complete
 With Contract Summary
Added the ability to quick search, apply filters and sort the various columns in Deposit
detail view.
Added descriptive legends in some specific reports that elaborate on the formulae used
to calculate certain amount fields. e.g. Billing Analysis, Earned Value etc.
Certain project rules were not being applied to the parent project when using batch
change. This was corrected.
Exporting a large list of vendor bills for CSV export would fail for certain users. This
feature was optimized for performance,
Project detail view would show the Project name in the bread crumb instead of the
display as. This was corrected.


















Creating a new fee schedule from an existing schedule would not show the fee schedule
list in any order. This was corrected.
Core transactions shown in the vendor, transactions tab were being limited to 25 records.
This was corrected.
Retainer transaction shown in the Client, transactions tab were being limited to 25
records. This was corrected.
Certain invoice templates did not respect the Project display as settings specified in the
global settings. This was corrected.
Added the ability to attach multiple documents in the report viewer.
Added Project Performance and Firm reconciliation report to billing and manager
subscriptions.
Security permission screen would also show inactive employees. This was corrected.
A certain scenario involving mid-way rounding was causing issues in the charge amount
field of expense log. This was corrected.
Filter dropdowns would not follow the recently introduced sort order feature in
memorized, favorite and scheduled reports tab. This was fixed.
Timer icons in the utility bar would indicate an incorrect badge number in certain
scenarios. This was corrected.
Creating a new project or projects based on project template with hierarchy would not
inherit the correct project or phase name. This was corrected.
A certain scenario would cause the cloud feeds, find match to not function as expected.
This was fixed
Added a switch to control if details should show up for group reports.
Updated reports for performance and bug fixes.
Updated help content.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.122 RELEASED ON JUNE 14, 2018
What’s new in this version?
This update addressed some critical issues and added a few enhancements. Most notable:







Record mapping section added to Core-MYOB Account Right integration.
Added a new global setting that enables users to send multiples attachments as a single
file in zip file format.
Ability to preview invoices and other reports from the transaction tab in Projects.
Added a new OT filter in Reviewer.
Added “Phase Id-Phase Name” as a Project display option.
Group detail views had performance issues and did not implement progressive scrolling.
This was fixed.














Statement module was not part of the Billing package. This was corrected.
Report and screen filters are now sorted alphabetically.
Added Google captcha validation at specific places in the application to enhance
security.
Simplified the way application handles decimal precision for the amount fields. Now all
amounts in Core would follow a fixed precision of 2 places of decimal.
Cloud feeds reports are now accessible from the Cloud feeds screen.
Custom fields would not appear on the concerned reports. This was corrected.
Bill payment screen was optimized for performance.
Retainer balances widget would not take retainer refunds into consideration. This was
fixed.
Existing tasks when copied from a project would not inherit the task follows attribute.
This was corrected.
Updated reports for performance and bug fixes.
Updated help content.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.121 RELEASED ON JUNE 1, 2018
What’s new in this version?
This update addressed some critical issues esp. related to performance. Most notable:











Faster, leaner Time Card: Core Time Card has been re-designed from scratch to allow for
faster performance and Ajax based save. The app no longer imposes any limit on the
number of time entries that can be shown per week and uses a combination of Ajax and
progressive scroll to provide the best user experience.
Optimized batch change feature for Project, Client and Time and expense entry for
performance. Also, Update rates and Project clone features were tweaked to improve
performance.
Creating a time entry from a timer would take longer than expected. This was fixed.
Adding a new activity would take a long time if the activity list had over 200 entries. This
was fixed.
Deleting existing deposit entries would take a long time if the action was performed for
a batch of entries. This was fixed.
Added a new batch action to download documents.
Project structure tab in Project detail view was not calculating some parent level
numbers correctly. This was corrected.
Paid filter in vendor bills would not work as expected and would fail to reflect bills that
were fully or partially settled using vendor credits. This was fixed.






















An issue with un-assign feature in budgets and estimates was causing the affected
projects to also get reset for the assigned fee schedule. This was fixed.
Core now remembers the show info bar setting in project, client and other lists.
Core would send subscription notifications to all owner and admin accounts set for the
company. This was changed to only send notification to the owner account.
Certain scheduled reports would fail to run if processed directly from Core. This was
fixed.
Budget details would sort the line items erratically after a new line item was added. This
was corrected.
Fee schedules rates for expense codes were not being respected when update rates
action was performed from the time and expense reviewer. This was corrected.
Users with billing subscription were not able to access purchase order module. This was
fixed.
Time and expense entries that were approved for Payroll only were being un-necessarily
locked when the project was processed in batch invoicing. This was fixed.
Invoice number filter would show repeat the numbers for joint invoices. This was fixed.
Retainer list would not show the list if a client or a project was selected in the filter
dropdown. This was fixed.
A recent change had caused the payment disbursement feature to fail. This was
corrected.
Some users were facing issues with creating batch invoices for projects that had entries
with multiple workflow types. This was fixed.
QBO sync would incorrectly create retainer payments for payments that were brought
over and did not have the underlying invoice in Core. This was fixed.
Documents widget would not allow users to download the documents and would fail.
This was fixed.
Users with restricted security for approving invoices were able to approve invoices. This
was fixed.
Parent entry in General Journal would not be shown as the first entry in the General
Journal detail view after a sort was performed. This was corrected.
Users were able to email Purchase order and vendor bill reports even if they did not have
the appropriate security. This was fixed.
Expense entry cost was being reset to zero if the user changed the project or expense id.
This was fixed.
A recent change had caused the custom fields to fail update. This was fixed.
Numerous other bug fixes and optimizations.
_____________________________________________________

VERSION 1.1.120 RELEASED ON MAY 25, 2018 (HOT FIX)
What’s new in this version?








Project, Transaction tab would fail to show more than 25 records. This was fixed.
Project structure, Balance column was not excluding the extra amount. This was
corrected.
Get invoices from QuickBooks was not able to handle a very large list of invoices and
would time out. This was fixed.
Existing time entries could not be assigned to a Joint invoice from the Time Entry, batch
change screen. This was fixed.
Automatic billing would fail to inherit the billing memo when the invoice was processed.
This was corrected.
Expense by vendor report would not work with account filters. This was fixed.
_____________________________________________________

VERSION 1.1.119 RELEASED ON MAY 23, 2018 (HOT FIX)
What’s new in this version?





Amount applied field in Create new payment was being auto filled with a value when a
user scrolled the list of invoices while creating a new AR payment. This was fixed.
Time card reports would show data outside the designated filters when launched from
the Time card screen. This was fixed.
Create new payment screen would un-necessarily show paid invoices along with the unpaid invoices. This was corrected.
Create new payment screen was missing certain column headers. This was corrected.
_____________________________________________________

VERSION 1.1.118 RELEASED ON MAY 21, 2018
What’s new in this version?
This update addressed some performance and other issues. Most notable:















Manage priority screen in fee schedules, service and expense detail view would only
allow users to manage the first 25 rows. This was fixed.
Employee control, add project would fail to show all the phases if they exceeded a
certain number. This was corrected.
Assigning fee schedule to projects would restrict the list to top 25 records. This was fixed.
Bill number dropdown in create new bill payment was not optimized to handle a large
list of vendor bills. This was fixed.
Create new bill payment was optimized to handle a large set of payments.
Create new check would get un-responsive if a large list of existing reimbursable charges
was imported. This was fixed.
Process automatic/memorized billing on user login was optimized for performance.
Recipient dialog in report scheduling would not show the associated email address. Also,
contacts that did not have a valid email address associated to them would also show up.
Both these issues were fixed.
Users were not allowed to add payments to projects that were marked as completed.
This was fixed.
Emailing a joint invoice to a client would un-necessarily add the client email address
multiple times in the “To” field of the email compose screen. This was fixed.
Global search had stopped working due to a recent code change. This was fixed.
QuickBooks record mapping would not work as expected if one or more synced records
were deleted in QuickBooks. This was fixed.
Update rates in Reviewer would in-correctly set expense rates to zero if the associated
expense record did not have a valid cost rate. This was fixed.







Users were able to modify existing entries in vendor credit even if their date would fall
before the closing date of the company. This was corrected.
Time or expense entries that were excluded from billing in “create new batch invoice”
screen would stay locked even after billing was completed. This was fixed.
Users were able to modify their Core login (email address) in User profile screen. This
was fixed.
Users were not able to create allocations from a budget if the budget did not have at
least one service line. This was corrected.
Numerous other bug fixes and performance improvements.
_____________________________________________________

VERSION 1.1.117 RELEASED ON MAY 4, 2018
What’s new in this version?
Introducing integration with popular cloud storage services- Box and OneDrive: Core users can
now integrate with the popular cloud storage providers, Box and OneDrive to store and manage
documents.
This update also offered few other enhancements and fixes. Most notable:







Core users who use QuickBooks integration can now set up account and tax codes at the
project and Project group level.
Core now aggregates help content from multiple sources, to provide quick and easy to
find help topics.
A brand new Cost plus Contract rates report that calculates indirect rates based on cost
pools for Cost plus contract type.
Added Parent project column to QBO project mappings.
Several users had reported issues related to filters across many Core lists. This was fixed.
Numerous other bug fixes and performance improvements.
_____________________________________________________

VERSION 1.1.116 RELEASED ON APRIL 27, 2018
What’s new in this version?







o
o










Core reports can now be filtered by groups.
Core invoice templates can now be set up to show client retainer summary information.
Added Project manager/Parent Project filter to all project reports.
Report performance optimizations across numerous reports. The most notable are
Balance sheet, Profit and loss, Trial balance and Check details reports.
The country field on account sign up and create company now defaults to United States.
Added few important reports:
Cloud feeds
Connected banks.
Ability to sort General Journal details view by any visible column.
The overdue column in invoices would not show the correct value. This was corrected.
Time and expense details in Create new vendor bill can now be sorted by all visible
columns.
Some users had issues with filters in Dashboard widgets. This was fixed.
Profit profitability widget in project performance view had an issue and would not show
any data. This was corrected.
Scheduled reports were missing filter information. This was corrected.
Project groups filter was not working as expected in the create batch invoices screen.
This was fixed.
COA info bar would not refresh when a quick search was issued. This was fixed.
Numerous other bug fixes and performance optimizations.
_____________________________________________________

VERSION 1.1.115 RELEASED ON APRIL 14, 2018
What’s new in this version?








Create batch invoices screen now supports discrete filters. Users can choose individual
projects, managers, clients or groups to generate invoices based on approved WIP,
recurring frequency or billing schedules. Previously, the filter options were limited to
ranges only.
Added line number re-ordering in create manual invoice screen.
Added the ability for invoices to show Tax Id the in invoice header section. Australia/NZ
would see this field appear as ABN #.
Allow users to specify times of the day in military format. This applies to start and stop
times in time entry and calendar events and this option is provided as user preference.
Added a brand new global setting to specify the default discount account
Cost pool list now supports re-ordering of existing cost pools.












Users can now specify the class field while creating a new deposit.
Manual invoices line items that are inherited from budgets and estimates are now sorted
by activity/expense code.
Core was not able email invoices that had attachments over a certain size. This was fixed.
A period character in the invoice number was causing the invoice list to not load
properly. This was fixed.
Check printing screen would use the employee “display as” instead of the employee
name (or company name for vendor). This was fixed.
Vendor transaction history would just show checks that were used to pay bills for the
vendor and skip checks that were directly cut for the vendor. This was fixed.
Project dropdown in create checks and credit cards would bring all items and not respect
the project assignments. This was fixed.
Project performance widget now rolls up by parent project.
Users were not able enter employee birth dates for any date before 1970. This was
corrected.
Bug fixing and stability.

_____________________________________________________

VERSION 1.1.114 RELEASED ON APRIL 6, 2018
What’s new in this version?












Implemented Get all and Send all for AccountRight integration.
Invoice list in create new payments is now sortable by all columns.
Added the following new reports
 Payment Receipt
 Credit Payment Receipt
 Refund Retainer Receipt
 Project Account Details
Added new filters to few important Core reports.
Expense entries marked as paid would still appear in create new vendor bill screen if the
user chose to select from existing time and expense for the vendor. This was fixed.
Draft invoices were being incorrectly marked as posted when emailed. This was
corrected.
COA screen info bar was not looking at provided filters. This was fixed.
Quick payment for an existing invoice would open the payment screen even though the
user was not permitted to create a new payment. This was fixed.
COA screen had issues when sorting by the account number field when the account
numbers was pure numeric. This was fixed.
A user scenario was causing the print checks module to repeat check numbers. This was
corrected.





A manual invoice being created out of an estimate would lose the sort ordering if it was
saved as draft. This was corrected.
Descriptive text for some reminder and notification settings were re-phrased to describe
the settings correctly.
Bug fixing and stability.
_____________________________________________________

VERSION 1.1.113 RELEASED ON APRIL 2, 2018 (HOT FIX)
What’s new in this version?
This update addressed some urgent issues reported by Core customers. Most notably:
 Time and expense details view in billing screens were being restricted to users that had a
time and expense subscription and not just the required billing subscription. This was
fixed and now a billing subscription automatically allows users to view and edit specific
attributes of entries linked to invoices.
 Check printing screen would skip the trailing zeros in the amount field of a check. This
was fixed.
 Users were being restricted to reconcile only 25 items at a time. This was fixed.
 Timer list would show timers belonging to other users even though the logged user had
not initiated them. This was fixed.
 Custom fields and lists were not available to time and expense users in time and expense
entry. This was fixed.
 Users were not able delete invoices for certain projects that had custom invoice
numbering turned on but the optional fields, suffix or prefix, were not provided any
value. This was corrected.
_____________________________________________________

VERSION 1.1.112 RELEASED ON MARCH 21, 2018
What’s new in this version?
Introducing Xero Integration: Core now integrates with the popular accounting software, Xero.
Core users can sync employees, clients, vendors. Invoices, payments, purchase orders, vendor
bills, accounts, activity and expense items between the two applications.
This update also added over 40 notable enhancements to the application apart from fixing
numerous known issues. Some enhancements and fixes that are worth mentioning are:






















An improved algorithm to process projects that are due for billing in the batch invoice
screen. Core now imposes no restrictions on the number of projects that can show up in
this list and projects are progressively retrieved upon list scroll.
Users can now create automatic time entries for approved PTO requests.
Core now allows users with the appropriate permissions to create timers for employees
other than logged user.
A brand new info bar was added to the Invoice Collection screen.
Invoice module now supports Custom fields.
Users can now specify the class field while creating a bank feed rule.
Added several security enhancements including temporary account lockout for several
login attempts with an incorrect password.
Updated Invoice templates options in Global Settings. Added show hours/amount,
separate grouping field for expenses and other options under Layout section.
Core now allows users to clone a project across multiple clients in one go when using the
clone function from project list view.
Core now automatically persists the order in which the General Journal line items were
entered. This order is also maintained for GJ entries that are cloned from an original
entry.
We added two more important columns to the Project structure tab, “contract billed”
and “extra billed” to give managers insights into the breakup of billing for the project or
its phases.
Batch invoice users can now separate individual phases that have been combined for
Joint invoice purpose in the batch invoice screen.
Core now allows users to set up customized file names for invoice, statement and reports
that are sent as email attachments.
Added the popular ‘Due upon Receipt’ payment term.
Implemented a refined algorithm to prevent unnecessary time and expense entry locks
during batch invoice processing.
Employee control list now provides a tristate checkbox to indicate if control is partially
turned on, turned on or completely off for an employee.
Users can now sort on date and amount columns in the Accounts Reconciliations screen
to save time when reconciling accounts
A brand new action in user preference section to clear out all screen filters for the logged
user.


























We had incorrectly tied the “Message on Invoice” field to an unrelated project rule and
this field would not show up on invoices unless that rule was checked. This was fixed.
Vendor screen KPIs’ would exclude checks that included the vendor AP account as a
detail item. This was corrected.
Added “Charge Amount” as an optional column in the time entries and reviewer screen.
Added “Comp” field as a batch update field for time entries.
Core users with high resolution display would at times face scrolling issues for Core lists
to retrieve additional records. This was fixed was providing a “More” button at the end of
list.
Core now allows users to change security templates from the Employee detail view.
Users can now enter currency amounts for some percentage fields and Core would
automatically calculate the corresponding percentage. This feature was added in Expense
entry and create batch invoice screen.
Core transactions created from cloud feeds now inherit ref. field from the bank/credit
card feed.
Custom label and mask management screen under Global settings now provides
elaborative tooltips by exampling how these settings work.
There was no detail view in Core for retainer invoices. Users can now view the detail of an
existing retainer by clicking on the “detail” row action.
Added “Core account balance” as a column in the Cloud Feeds list.
Popular date shortcuts like This Week, This Month, etc. were missing in the reports
screen. These were added.
Admin users can now set up security to control which users has access to check printing
function.
There was no option to assign a group of attendees to an event. This new option was
added in the Calendar screen.
Custom fields’ management screen now allows user to create a new custom field from an
existing custom field.
Added Classification column as an optional column to Time Entries screen.
A main project with no phases available for time or expense entry for the contextual user
would show up in the drop down. This was corrected.
Added the following brand new reports
 Top Ten in Revenue
 Employee Time Card Half Monthly
 Enhanced the 1099-MISC report to also show 1096 form
 Fixed Invoice (% Complete) invoice template
 Trial Balance YTD Accrual/Cash
 Tax Registry
 Credit Memo Receipt
‘Show GST separately on invoices’ rule in Global Settings was renamed to ‘Show
combined GST on invoices’ and is checked automatically for AU, NZ and Canadian
companies.
Time and expense entry lists “submitted by” column was renamed to “last action by” to
reflect the correct behavior of this field.





















The Balance filter in Statement screen was made more usable by including options like <,
>, = to give users more flexibility to enter approximate values and not necessarily exact
values for filtering data.
Searching for phases in projects list would cause the project list to repeat phases. This
was fixed.
Report scheduling would fail to deliver reports on scheduled intervals if the schedule or
any of its underlying reports were updated for filters or any options. This was fixed.
There was a problem with accented characters display in Core. This was fixed.
Global Settings > Accounting: Income Account for Services/Expenses was renamed to
Income Account for Services/Expenses without Line Item.
Account reconciliation screen would list “CreatedOn” date as the transaction date for
some accounting entries. This was corrected.
Time recorded against vendors in vendor bills would show up in the Hours widget. This
was fixed.
The application allowed users to enable the auto-renew option for multi-year plans. This
was corrected.
Removed the redundant date filter in filters panel in Invoice list and General Journal list.
Tasks assigned to an employee were not automatically removed when the employee was
deleted. This was fixed.
Users were not able to update existing time entries for a project with ‘Prevent Time Entry’
rule set. This was fixed to allow users to update existing entries.
Core would incorrectly set all existing time entries as non- billable when a project
contract type was changed to Marketing or overhead. This was corrected and all
contextual rules are respected while making this change.
Payments were not auto-posting the invoices. Applying a payment to an invoice is
supposed to flag the paid invoice as posted. This was fixed.
Project structure spent column (and other places) did not reflect the correct value for
spent time and expense until these entries were billed. This was fixed.
Core would not automatically recycle an Invoice number if the associated invoice was
deleted. This was fixed.
Core invoice template would refer to activity description instead to time entry
description. This was corrected.
Changing the charge amount of a time entry didn’t apply the corresponding WUD to the
time entry. This was fixed.
_____________________________________________________

VERSION 1.1.84 RELEASED ON MARCH 11, 2018 (HOT FIX)
What’s new in this version?
Introducing Gantt Charts: Core now offers a fully featured Gantt chart that makes
project/resource scheduling all the more powerful yet intuitive and easy to use.
This update also addressed some urgent issues reported by Core customers.










Creating a new estimate from an existing estimate did not copy the custom fields
associated with the service and expense line items. This was fixed.
An issue in the code would reset user company logo on application updates. This was
fixed
An issue in the memorized reports module would prevent users from accessing certain
reports. This was corrected.
Updating a custom label would cause custom reports to disappear from the reports
screen. This was fixed.
An issue in assign fee schedule dialog would falsely indicate a project was selected and
confuse the user. This was fixed.
Batch invoice screen would fail to process an invoice if invoice percent complete was
modified. This happened for companies on euro currency. This was fixed.
Invoice collection screen would not allow users to add quick notes to invoices that
appeared after the first scroll. This was fixed.
Account filter in reports was not working as expected. This was fixed.
_____________________________________________________

VERSION 1.1.82 RELEASED ON MARCH 2, 2018 (HOT FIX)
What’s new in this version?
This update addressed some urgent issues reported by Core customers.











Users were not able to update an employee record, if the default group associated to the
employee had been deleted. This was fixed.
Memorized reports were being incorrectly marked as private, if a user other the original
owner of the report, customized any filters or any other options. This was fixed.
A report marked as favorite would disappear from the favorite tab upon preview. This
was fixed.
In certain scenarios, payment date for a new payment would default to the previous day.
This was fixed.
Core payment screen would not restrict users from applying a retainer payment when
the net retainer balance was in negative. This was fixed.
Project batch update would clear any billing contacts for projects. This was fixed.
Core would incorrectly set the payment date to current date instead of the user specified
date when creating a project balance brought forward invoice. This was fixed.
Merge project would fail in scenarios where the source project Id exceeded a certain
length. This was fixed.
Users were not able to enter reimbursable expenses if they did not have permissions for
the vendor bill module. This was fixed.
Project template detail view would not open and cause a UI crash. This was fixed.













Users were not able to associate a cloud feed to multiple Core transactions even though
the amounts would exactly match. This was fixed.
Users without the necessary permission were able to delete submitted/ approved time
entries. This was fixed.
Fee schedule list would not show more than 25 records. This was corrected.
Core would incorrectly update time entry bill rates to zero if the associated project fee
schedule had zero rate defined for cost rates. This was fixed.
A filter issue in payments was preventing some users from viewing all payments. This was
corrected.
QBO sync would not work for time entry sync if the setting “skip vendor time” was
checked. This was corrected.
QBO mapping module would show Core retainer invoices in unmapped invoices section.
This was fixed.
Invoices that were emailed from the invoice list would not respect settings related to
hide non-billable charges. This was fixed.
Voided checks would appear on the AP aging report. This was fixed.
Phased invoice templates were not showing the correct phase description. This was
corrected.
Aging report was not excluding vendor bills that were fully paid. This was corrected.
_____________________________________________________

VERSION 1.1.81 RELEASED ON FEBRUARY 16, 2018 (HOT FIX)
What’s new in this version?
This update aimed to address some urgent issues reported by Core customers.










Create batch invoices screen would fail to retrieve all projects that were due for billing.
This was fixed.
Time and expense entries associated to a vendor were being incorrectly updated to the
current date when they were auto-imported in create vendor bill screen. This was
corrected.
Spent column in project status widget and project structure tab was using an incorrect
formula. This was fixed.
Users on accounting subscription were not able to assign groups to a vendor or an
employee. This was fixed.
Email message defined in global settings/user preferences would incorrectly display
HTML tags while composing an email for retainer invoice. This was fixed.
Time and expense entry memos that were originally copied from MS Excel/MS Word
would cause issues in Time entry, Expense entry, and Reviewer and Time card screens.
This was corrected.
Added “reimbursable” column to Reviewer.

















Check printing would misspell amounts with decimals. This was fixed.
Some Core users had reported that certain parent projects were incorrectly showing up
at the end of the hierarchy when selecting projects in time and expense entry project
dropdowns. This was fixed.
QBO jobs with malformed geo-location information would not import to Core. This was
fixed.
A General Journal entry would fail to save if it took the user longer than 20 minutes to
save it. This was fixed.
Payment screen would not allow users to create a credit type payment and mark it as a
retainer. This was fixed.
A time entry that had a trailing space in the memo field would transfer to QBO with unnecessary HTML tags. This was corrected.
Users were having issues with updating custom LEDES mappings. This was fixed.
Certain bill payments would not show up in bill payments list as the void flag was
incorrectly set to null. This was corrected.
There was a severe performance issue while updating a vendor bill that had over 50 line
items. This was fixed.
Active status filters in Group details view were not working as expected. This was fixed.
Bill payment list would not show the correct Reference (ref) field value. This was fixed.
Added default values to all Boolean and small integer fields in the Core user database.
Other fixes including reports.
(internal) Admin portal would fail to download large database backups. This was
corrected.
_____________________________________________________

VERSION 1.1.79 RELEASED ON JANUARY 19, 2018 (HOT FIX)
What’s new in this version?
This update addressed some urgent issues reported by Core customers.








Project assignments based on activity groups would not work as intended when the
logged user had security rule, “Use Project assignment on top of Employee control”
checked. This was fixed.
Bill payment screen now implements progressive scrolling to handle large bill payment
lists.
Modifying % complete for phases of a project in batch invoices was writing up one of the
time entries linked to a random phase that is part of the invoice. This would happen if the
one or more phases had no time or expense. This was fixed.
QBO invoices for inactive clients were being associated with incorrect projects in Core.
This was fixed.
Core would wrongly create employees with the same name as QBO customers when
getting vendor bills from QBO. This was fixed.

























Sync setting for QBO would save the previous day’s date for Invoice GET section. This
was fixed.
Un-mapped records in QBO list would not show up in a certain scenario. This was fixed.
User with full permission to fee schedule module was not able to delete schedules. This
was fixed.
A certain filter scenario would prevent time or expense to show up for a user with full
permissions to the reviewer screen. This was fixed.
Forecasting screen would keep showing the loading indicator if there were no records in
the forecasting range. This was fixed.
Some employee reimbursable would not show up in check screen. This was an issue in
the sample files and is fixed now.
Check alignment screen background would appear distorted on Safari on Mac. This was
fixed.
Recently added custom fields filter feature would not work as expected if the custom
filter name matched any of the system filters. This was fixed.
Allocation would not show up correctly, if an employee was part of more than one
allocation and was allocated as an employee group and as an individual employee. This
was fixed.
Creating new project would fail if the company had turned on auto-increment project id
and the next project id had a specific number of characters. This was fixed.
Merge project function would reset the project sort order. This was fixed.
Phase sort order was not being followed in budget, estimate and fee schedule. This was
fixed.
A project with existing assignments could not be deleted. This was fixed.
Some core reports were not respecting hide cost rates security. This was fixed.
Core invoices would incorrectly show activity description instead of time entry
description. This was fixed.
Manual invoice would repeat the item description. This was fixed.
Bill number filter would not work for bill payments report. This was fixed.
Report, Misc1099 did not obey Company profile fed-id masking. This was fixed.
Vendor tax id number and company phone no - masking was not being implemented on
MISC-1099 Report. This was fixed.
Manual invoice had an issue related to summary total. This was fixed.
The Hourly recurring invoice would not show the expenses if they were part of an
invoice. This was fixed.
Joint invoice template was leaving a blank line between entries. This was fixed.
______________________________________________________

VERSION 1.1.78 RELEASED ON JANUARY 13, 2018
What’s new in this version?






Check alignment for precise check printing: Core now allows users to customize system
check templates to meet their precise check printing needs. Users can align all data
driven fields for standard, wallet and voucher check styles as per the check stationary
available to them.
Filter by Custom fields: Users can now filter Core lists by custom fields. This useful feature
further augments the power of custom fields in Core.
In-line editing for Task allocation forecasting: Users would now be able to edit the
allocation distributions in the Manual view forecasting screen. This brand new view not
only allows user to provide distributions for existing tasks but users can create new tasks
by simply providing units for any calendar day.

Other fixes:






















Users can associate reimbursable expenses to a check if the payee is an employee and
has expenses that have not been paid yet.
Users can now initiate an invoice payment directly from the invoice list.
Parent project Documents, To-dos and Notes tab now show all entries rolled up to
display all items linked to their phases.
Invoice list now displays all phases that are part of the invoice as a tooltip.
Budgets and estimates can now be emailed right from the list screens.
All Core invoices now handle project level currency multipliers.
Record mapping views in QBO integration can now be sorted by all available columns.
Added new filters to Statements screen.
Invoice list now allow batch change for invoice dates.
Users are now prompted if they want to update phases of a project, if any tax or currency
information is changed for the parent project.
Added bill number column to expense entry and time entry.
Added new date shortcut filters in the reports area.
Added balance as a grand total for all Core registers.
Implemented GST for Australia subscriptions.
Time card would now handle up to 100 project/activity combinations. This was increased
from the earlier limit of 50.
While cloning a project or when a project was created from a template, assignment tied
to the project/template were being dropped. This was fixed.
Employee control would not work as expected and would associate a group to all
employees even though it was intended for one employee. This was fixed.
Time and expense users were not able to view or edit a To-do that was assigned to them.
This was fixed.
Editing time entry hours would not work as expected in batch invoicing if the rule
“memo is required” was turned on for the project. This was fixed.
Project status widget red flag tooltip would show incorrect information in certain
scenarios. This was fixed.
Projects are now shown as a tooltip in Time and expense entry.


























An un-necessary security restriction was preventing users from accessing Client and
Project screens even though they had full access to these modules. This was fixed.
Retainer lists screen would only reflect the total for the first 25 entries. This was fixed.
Core phased invoice would incorrectly drop some phases on preview. This was fixed.
Core phased invoice would show incorrect invoice summary. This was fixed.
If a bill payment was voided, bills associated to the voided payment would fail to appear
in the bill payment module. This was fixed.
A scenario caused the project ‘display as’ to be reset if the project record was modified.
This was fixed.
A scenario would cause the time card to show no data on column sort. This was fixed.
Previewing retainer Invoice shows company label instead of actual company name when
creating a Client or Project retainer invoice in Billing>Retainers module. This was fixed.
When saving a record, formatting for some fields would be reset. This was fixed.
Invoice totals were incorrect when using the "Hourly Invoice by Title" template. This was
fixed.
Payment screen would not update the available amount when disbursing retainers. This
was fixed.
PTO InfoBar did not respect user permissions. This was fixed.
Core account registers now sort chronologically.
Core would allow users to delete Income and expense accounts that were linked with
time entries. This was fixed.
User entered statement balance would not get reflected in Accounting reconciliation
screen. This was fixed.
Work in hand report would show up draft Invoices as well. This was fixed.
Project Retainer method payment was not reflected in Client transaction screen. This was
fixed.
Expense entry memo would not display and time entry memo did not follow "Show
memo on Invoices" rule. This was fixed.
Ajax was not working on the Accounts payable field of the Add Vendor bill screen. This
was fixed.
Core item based transaction created from a bank feed would not prompt the user to
enter a memo even if memo was required for the project. This was fixed.
Core email screen would not accept multiple emails in the CC field. This was fixed.
Allocation and forecasting screen would display a blank page if a user clicked on
allocated hours/units notification item.
Updating % complete in Estimate, service and expense detail would error out. This was
fixed.
Purchase order line ordering would not be persisted after updating a detail item. This
was fixed.
______________________________________________________

VERSION 1.1.61 RELEASED ON DECEMBER 15, 2017
What’s new in this version?








Introducing Core-QBO Record Mapping: QuickBooks integration just got stronger with a
comprehensive record mappings module. Users can view all matched and un-matched
records and create or delete associations on the fly.
Sample Invoice Preview: Core now offers users an instant preview of the invoice template
while they are assigning project invoice templates or setting up them up in global
settings. This feature has also been made available in the invoice template management
area.
Introducing LEDES Export: Core now offers legal industry users, the ability to export
invoices to the popular LEDES format. Users can set up simple and advanced global rules
to support their choice of export.
The power of custom reports: Core now supports custom designed report templates for
customers who wish to use our report customization services. Please contact BQE
Support to get started.

Other fixes:
















A new action in invoices list allows users to change the preview template on the fly. User
can also mark this change permanent and update the project template setting.
There was a performance issue in Project dropdowns for Core users with large project
lists. This was fixed
Processing batch invoices using Project group filter would create duplicate invoices if the
project was part of multiple groups and group filters were used during invoice
processing. This was fixed
Fixed progressive scrolling issues for the following screens: To-do, Statements, Credit
Card, Documents, Purchase Order, Notes, Deposits, Checks, Timer, Vendor time and
expense,
Added memo field to Time and Expense reviewer.
Added more filters to Project status and other dashboard widgets
Optimized QuickBooks sync to avoid any time outs during the sync process
Users where having trouble ascertaining if a menu had more items below the fold. This
was fixed by increasing the width of the scroll bar.
Rebuild accounting received a performance boost and the process completes
significantly faster than earlier.
An enhancement in assignments area will now allow users to copy project assignments
or employee control to other projects/employees or a group.
Core users will now be able to preview allocation and spent reports from the Allocation
module.
Company admin users can upgrade subscription plans at any time.
Users are now shown the custom date range that is being applied in Core transaction
lists like invoices, payment, time entry etc.




























An issue in the subscriptions module was creating incorrect invoice totals and line items
on purchase/renewal of Core subscriptions. This was corrected
Core would compute client hours to zero if the minimum time increment was set to 1
minute. This was corrected
Moving Calendar events around would not add them to the intended date for Australia
region companies. This was fixed.
Creating two reimbursable expenses for the same employee on same dates would
incorrectly display "duplicate bill number" prompt. This has been corrected.
Assign Project in Fee schedules now allows user to select from a hierarchical project list.
Project structure sort order was not being followed in project list and drop downs. This
was fixed
QuickBooks sync progress bars would show incorrect progress at times. This was
corrected.
Added a memo field for time and expense details in Batch invoicing.
Project active status filter would not fetch phases that were set to inactive. This was fixed.
Added entity (Id) field to To-dos', Notes and documents list.
Users can now initiate a renewal for subscriptions that have expired in the past and were
not renewed.
Core now prompts users for size recommendations on specific Dashboard widgets.
Added the ability to sort in Project and Client transactions list.
There was no way to go back to the main report unless you close and re-run the report
once user drill down the report. It is fixed now.
Importing "Items Received" from a Purchase Order in the Add Vendor Bill Screen would
not fetch the memo. This was corrected.
All Core report templates now honor company country specific settings.
Time Card screen would sometimes incorrectly apply period filter. It is corrected now
Users are now allowed to set negative minimum amount as minimum bill amount during
processing of batch invoices.
There were instances when creating new group would prompt the user with a "duplicate
group" error. This was fixed.
Vendor and Outside Consultant type Vendors were showing up in the Staff Utilization
Widget. These were fixed.
There was an issue related to Fee schedule screen when using Safari browser. This was
fixed.
An existing Credit Card entry would disappear in Credit Card Register when we change
the project account for expense account. It is fixed now
Under some scenarios, Service amount would be stored as zero in Estimate screen. It is
fixed now.
Contract Analysis report would incorrectly exclude totals for phased projects. It has been
resolved now.
Added cover sheet option for Hourly invoice templates.
Fixed an issue with some report templates that would show un-necessary header
information on .csv export.









"Restrict Time/ Expense entry to Budgeted activities/expense or Employees" rule was
being applied in Allocations tasks module. This was corrected.
Custom fields would show up for limited access users in Time and expense entry. This
was fixed.
Implemented report security in context driven reports.
Removing a project contact would incorrectly delete from the Client contacts also. This
was fixed.
"Show Ignored" dropdown would not display all transactions when "Last Quarter" filter
was applied in Bank feed
There were issues related to sorting in COA list. These were fixed.
Processing draft invoices to final would not update the last invoice number. This was
fixed.
______________________________________________________

VERSION 1.1.37 RELEASED ON OCTOBER 22, 2017
What’s new in this version?
This update delivers over 150 improvements and fixes. The most notable are listed below.














Project Ajax drop-downs will now support parent-phase hierarchy and display results
accordingly. Users can now search for main projects and all underlying phases would be
available for selection. Conversely, searching for phase would display all matching phases
and the complete hierarchy.
Batch change screens were not able to handle fields with a Yes or No value. This problem
is now solved by providing indeterminate checkboxes
Project status dashboard widget now allows for view by contract or budget amounts.
Core now makes a nomenclature distinction between a subscription and a package. All
button and column heading now reflect the appropriate term.
Core would now prompt the user if they wanted auto-assignment of subscriptions when
purchasing the first subscriptions for the Company.
Project template module would not display the structure of a template in a hierarchical
manner. This was fixed.
Projects created from project templates would not reflect the phase id of the underling
template. This was fixed
Added WUD columns to Time entries and Time & Expense reviewer.
An issue in the batch invoicing module would reset the billing from and to dates if any
time or expense entries were excluded. This was fixed.
QBO sync module in Core was not providing detailed logs during the sync process. This
was fixed.
Core accounts that had expired were still able to access the Sample companies. This was
fixed
Users were able to update Company and profile information for Sample companies. This
was fixed.










The Custom fields’ management screen was missing the Company module. This was
fixed.
Time entry and Reviewer would fail to show up all entries even though there was no
visible filter. This was fixed
Project Status widget now provides an option to view Contract or Budget amount.
Project Status widget now rolls up spent, billed and other amounts for all phases and
shows them against the main project
Added new reports Contract Analysis, Project Profitability(Comprehensive), Billing
Schedule-Tab
Info bars in all master screens did not adjust to the filters provided to the list view. This is
fixed.
Expense entries marked as reimbursable were not picked up by the Check detail screen.
This was fixed.
Several security recommendations were implemented to mitigate any risks from attacks.
______________________________________________________

VERSION 1.1.28 RELEASED ON OCTOBER 8, 2017
What’s new in this version?








Introducing Bank Feed Rules: Core now allows bank feed users to set up rules that
automatically import bank feeds into Core. This brand new feature is complimented by
powerful rule definition and management UI to completely automate the import feed
process.
Introducing Report Scheduling: Core now offers powerful report scheduling that users
can set up for any interval and frequency. Users can add unlimited number of email
recipients or simply specify employee or client groups as email recipients.
Project Status and Due Dates Dashboard widgets: These widgets provide a clear picture
of the project/phase performance regarding billed, spent, WIP, open AR and other
important metrics. This powerful, standalone widget now empowers project managers to
make more informed decision while estimating project percent complete. The brand new
project due dates widget provides an informative list of all projects that are approaching
due dates.
The power of custom invoices: Core now supports custom designed invoice templates
for customers who use our invoice customization services. Please contact BQE Support to
get started on this.

Other fixes:






























Core users can now setup "Message on Invoice" in the global settings and all new
projects would automatically inherit this setting. Also, users have the ability to issue a
batch change for existing projects.
Core Project transactions now offer the drill-down feature. Click on the transaction and
view it in its own window.
Project Batch change interface now supports PO#.
Bank feed users now have the ability to view the type of transaction that would be
created when adding a new feed to Core.
Project rule that controls display of MST/MET on invoices is automatically set to true if
values are entered for Project MST or MET fields.
Pay when paid features was enhanced to auto-launch a report that provides detail for
the all vendor bills that are part of the invoice that is getting paid.
Added the much requested Project filter in Payment list
Added Project type filter to Project list and all project reports
Added the much requested Last Emailed column to Invoice List
Added Charge Amount field in Expense details in Batch Invoice Details.
Added the Cost field in the adjust reconciliation discrepancy interface.
Core now allows users to specify a memo while adding a bank feed as time or expense
line item
Account register for Opening balance equity account now provides a Journal report.
Time and Expense entry screens did not allow update of entries that were linked to
projects that were either cancelled or put on hold. This was fixed.
Vendor bill list can now be filtered by time or expense entry status also.
Project drop-downs on Create Event interface now support ajax type ahead
Payment screen would not remember the columns that had been turned on by the user
Somme users would lose subscription permissions temporarily if they accessed the
package drop-down in Manage Users. This was fixed.
There was an issue in the time verification report causing it to double the time entries. It
was fixed.
An invited user was able to log in to the invited company if they had existing account in
Core without accepting the invitation. The desired behavior is to get the user click on the
invite link and do the necessary on-boarding. This was fixed.
Sending Core employees to QBO would fail if a SSN had been specified for the
employee. This was fixed.
Some filters for dashboard widgets would not function in the desired manner and not
show up any data. This was fixed.
Some filters in the Reports area would not provide the correct UI for range filters. This
was fixed.
Invoice template would double the hours for a manual invoice that had both amount
paid and retainer. This was fixed.
Time and expense memo was getting ignored for vendor bills that were created from
existing vendor entries. This was fixed.
Employee based report control would apply the control to all users and not just the
intended employee. This was fixed.


















Manual invoices created from existing estimate would not obey the date from and to
that were specified in the Create Invoice dialog. This was fixed.
There was an issue related to entering memos when using Safari browser in the Time
card. This was fixed.
Payment date would in-correctly be set yesterday's date although the user would specify
today's date for the payment. This was fixed.
Bank feeds “find matches” algorithm would fail to retrieve credit card refund entries. This
was fixed.
Dashboard group filters would not show the default "ALL" group as one the options. This
was fixed.
Reversing the inclusion of bank feed would cause the underlying entry to be also
deleted. This was fixed.
Create new account of any balance sheet type would error out on certain company
country settings like Finnish. This was fixed.
Project time and expense report would not honor the "Show memo" setting. This was
fixed.
Payment disbursement screen was not correctly calculating the disbursements if the
invoice being paid had a discount or retainer. This was fixed.
PTO reports would fail to show the approver's note. This was fixed.
Bank feeds transaction would reset date filters to default after a transaction was marked
as ignored by the user. This was fixed.
Employee allocations were not correctly getting forecasted in the Forecasting screen if
the employee had non-standard day or week hours. This was fixed
Forecasting screen would ignore tasks that were linked to projects with the rule "Rates
from Activity table" set to true. This was fixed.
Subscriptions created in Core would show an expiry date which was a day short than the
expected date. This was fixed. Also, the Manage user interface would not allow admin
users to remove expired subscriptions from a Core user. This was also fixed
Core would not properly handle a scenario that involved a user selecting a mix of late fee
and regular invoices for preview in the Invoice list screen. This was fixed.
______________________________________________________

VERSION 1.1.13 RELEASED ON SEPTEMBER 3, 2017
What’s new in this version?




Smart fields for Email Settings: Users can now set up company or user level email subject
and message fields to use smart placeholders that are replaced with actual values while
emailing invoice, reports, statements and payment receipts.
Pay when paid feature: Core now prompts users to settle their payables as soon as they
receive a client payment for an invoice that has time or expense entries linked to an
unpaid vendor bill.

 Time and Expense line item support for Bank Feeds: Bank feeds can now be imported
into Core as Time or Expense entries. These entries are imported into Core as line items
for check or credit card transactions.
 CSV export for Report Viewer: Users now have option to export reports to an Excel CSV
format. This format gives users the power to use report data for aggregation and
charting in Excel.
Other fixes:






















Compose Email was not able to handle multiple email addresses. This was fixed.
Project opening balance feature would accept not a combination of opening balance
fields whose sum was equal to zero. This was fixed.
General Journal, Credit Card and Custom Label quick text based filter feature was not
working as expected. This was fixed
Core would not allow vendors to be added as Core users. This restriction was removed.
Vendors would not appear in the Security permissions list. This was fixed.
Users of type vendor were not able to fill in their time card. This was fixed.
Expense entry detail view was missing the paid status and paid date fields. These were
added.
Company chooser screen that shows up for users with multiple Core companies did not
provide any information about the Company status. This was fixed.
There were issues if a user tried to delete a Vendor credit line item. This was fixed.
Some of the reports would not show correct Company name in the header when emailed
from the reports area. This was fixed.
Reset Custom labels in Custom Labels section under Global Settings would incorrectly
introduce masks for all custom labels. This was fixed.
Documents added in Core would not show the correct date and time for the created on
field. This was fixed.
QuickBooks and AccountRight set up page would open in the same window as Core. This
was fixed.
A duplicate General Journal warning would make the interface unresponsive to user
input. This was fixed.
Invoices with hyperlinks as documents would fail to be emailed. This was fixed.
Project parent level rules were not getting coped to the project phases. This was fixed.
Many financial reports would incorrectly show non-posting accounts and types as filters.
This was corrected.
Core would not automatically update the Display As field while creating a new company
if the value was first entered in the Company field. This was fixed.
Added Pay rate multiplier and OT multiplier to Fee Schedule, Service based line items.
An expense entry would not be submitted to the correct PM if the entry had been
submitted earlier and the PM had changed since then.
A recurring check processed notification would not reflect the correct name of the user.
This was fixed.










PTO screen and widgets would not show the correct data if the default codes for
vacation, comp and sick were changed in global settings. This was fixed.
PTO screen, new entry would not default to the current day. This was fixed.
Credit card, checks and Vendor bill screen would also include inactive accounts in the
account drop-downs. This was fixed.
Time and Expense reviewer would not show any records if a submitted time or expense
was approved or rejected by a user via notifications area. This was fixed.
Phases that were being created by using templates would not respect the Project display
as setting. This was fixed.
Add licenses feature was calculating an incorrect amount for the new subscriptions. This
was fixed.
Core would through up an error if a user clicked the detail view action for an “added in
core” bank feed if the underlying core transactions were deleted. This was fixed.
More than 270 other fixes that improve application’s usability, reliability and
performance.
______________________________________________________

VERSION 1.1.6 RELEASED ON AUGUST 20, 2017
This update fixes more than 150 known issues and adds few new critical features to the
application.












Project structure tab in Project detail view now offers additional column options to allow
Project managers’ to make a more informed decision while updating the percent
complete.
Added a legacy feature that allows users to import existing vendor time and expense
that is not part of a previous vendor bill. This feature is available from the Create Vendor
bill screen.
Core now offers users the ability to create vendor bills from received Purchase order line
items that were not made part of a vendor bill during the items receipt process.
Core now offers intuitive color coding for Forecasting screens to alert users for
allocations that are over the assigned values.
Core now allows QuickBooks integration users to initiate a ‘Get all’ and ‘Send all’ sync.
Manage companies module would not appear for Core users that were marked as
standard. This is fixed.
Notifications related to time and expense submittal or approval would occasionally omit
the sender name. This was fixed.
Time entry client hours (formerly known as B-Hours) would not get updated when an
entry was updated in the Time card screen. This was fixed.
Some fields in batch invoicing screen would not reset to original values when the batch
invoicing screen was refreshed. This was fixed.













Late fee invoices generated from the invoice screen would occasionally not have the
correct next sequential invoice number. This was fixed.
Allocation screen would allow user to allocate units for projects of type ‘Main’. This was
corrected.
Time entries would get duplicated if a user navigated to the next/previous week while
the saving the time card. This was corrected.
On certain occasions, time or expense submit notification would not display the
underlying entries when a user clicked on the submit notification. This was corrected.
Core would not stop users from entering time for projects that were not active. This was
corrected.
Invoices that were over paid or had a negative amount were appearing in the create
payment screen. This was fixed.
Subscription purchase shopping cart would display the wrong total amount if user
navigated back to the subscription list and added a new subscription. This was corrected.
Owner account for a company was not able to login if the linked user was changed for
owner account. This was corrected.
Email without preview was not available as an option in the Collections screen. This was
fixed.
PTO info bar would show incorrect numbers for vacation and sick time if the employee
had multiple PTO requests. This was corrected.
There was instances of modal dialogs overflowing the browser boundary and not display
correctly. This was corrected for Dashboard and Batch invoices.
______________________________________________________

VERSION 1.0.211 RELEASED ON JULY 30, 2017
What’s new in this version?











Core now offers trial users an easy way to switch between sample companies even when
they are already signed in their company file. Users will also have the option to exit the
sample file experience without logging out.
Core was not able to accept fresh signup requests from users who had aborted the
signup process midway or the company creation had not successfully completed in a
previous attempt. This was fixed.
Register screen will now offer the ability to view and enter memo for each transaction.
Register screen, View by “Account” drop down now supports type ahead search.
Core was incorrectly prompting users to enter a check number while creating a new
check in the Register. This was fixed.
Added Client column to Invoice list view.
The “Trial expiring in …” indicator would animate away for trial companies. This was fixed.
Users are now warned to not close the browser while a company file is being created.




General UI/UX improvements.
Other minor fixes related to Core business logic.

______________________________________________________

RTM VERSION 1.0.207 RELEASED ON JULY 19, 2017
Dashboards

Get a snapshot of your whole business every time you log in





See how your entire business is doing in an easy-to-understand graphical interface
Create unlimited, customizable dashboards to suit your needs
Display your business key performance indicators (KPIs) exactly how you want to see
them
Easily change the size, shape, and color of pie charts, bar graphs, and interactive lists

Time & Expense Tracking

Know exactly where you stand
Flexible time entry – track time how you want to with simple timecards and timers
Easily start and switch between multiple timers
Record expenses in multiple currencies and attach receipts
Auto-populate your timesheet with previous week’s activities and projects
Track time and expenses on-the-go via free native iPhone and Android apps
Project Management






Make the best use of your resources for the greatest profitability






Watch the status of tasks by phase
Powerful multi-level submittal and approval process for time and expenses, budgets,
estimates, vendor bills and invoices
Efficiently manage people with smart tools for resource scheduling, allocation and
utilization
Track budget vs. actual hours and costs in real time
Track submittal-approval, drawing and RFI workflows

Billing

Cut your billing time in half and improve cash flow






Tailor your communications with dozens of professional and customizable invoice
templates
Create different invoice types: percent complete, retainer, recurring, fixed, hourly,
phased, joint and more
Send multiple invoices in a single email
Choose from convenient billing methods: Automatic, Progress, Manual and more

Accounting

Manage all your transactions in one place






Easily manage vendor bills and purchase orders
Write checks and reconcile bank accounts
Connect to bank feeds anywhere in the world
Quickly access General Journal Entries, Registers and General Ledger
Generate accrual and cash-based balance sheets, as well as profit & loss reports

Reports

Get actionable insights at your fingertips





Access hundreds of standard reports that are fully customizable
Create memorized reports and tag any report as your favorite
Customize reports and share them as PDFs, Word documents, or Excel files.
View breakdowns of utilization, realization and billable work for employees as well as
consultants

Mobile

Manage your business on the go







Monitor to-dos and submit/approve workflows via dashboard
Enter and review time and expenses from any device
Use multiple timers to track every billable minute
Convert your project visits into time entries with visit tracking
Quickly create invoices and apply payments
Stay up-to-date with real-time notifications

Integration

Seamless integration with other products








QuickBooks®
When you integrate Core and QuickBooks®, you gain a lot more than elimination of
duplicate data entry. You get a powerhouse that will that will save you time, money and
resources.
MYOB AccountRight® (Australia)
Whether you’re a one-person office or a large, network-based organization, Core offers
MYOB users a dramatically streamlined method for invoicing, tracking time and
expenses, and much more.
Dropbox, Google Drive, and Amazon Web Services (AWS)
With Core, you can work from anywhere in the cloud. Plus, you can simplify how your
team works and share files through your favorite apps. Core works with Dropbox, Google
Drive, and Amazon Web

